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Welcome . . .

Microsoft R Word for the Apple R

Macintosh TM is a uniquely powerful
writing tool. With Word you can
create all kinds of documents-
memos, letters, reports, bro-
chures, or books. And you can

design printed documents that
look polished and professional .

If you are new to word process-
ing, you will be surprised at how
easy Word is to learn and use . If
you've used other word proces-
sors, you'll be impressed at how
Word handles complicated tasks
in an uncomplicated fashion .



Word has all the features you'd
expect from a first-rate word pro-
cessing program . You can create
long documents . There are no
odd-looking codes or commands .
You can correct errors and copy,
replace, move, or format text
quickly and easily . And you can
edit or reformat as many times as
you want .
And Word has more. You can
create "glossaries" for frequently
used text, create footnotes au-
tomatically, and merge informa-
tion into a document to create
form letters . You can change the
layout of a page or several pages
within a printed document. What
you see on the screen is what
you will get when you print your
documents .

You can also copy material into
Word from other application pro-
grams for your Apple
Macintosh-graphics from Micro-
soft Chart, worksheets from Mi-
crosoft MultiplancRR, formatted
documents from MacWrite'M, and
pictures from MacPaintTM, to men-
tion a few .

Feel free to experiment with
Word. You will find that Word
adapts easily to your writing and
formatting requirements, so you
can concentrate on what is im-
portant to you-writing and
designing your documents .





About This Manual

The explanations, examples, and illustrations in this manual will help you
take full advantage of Microsoft Word's many features . This manual is
divided into three parts : "Learning Word," "Using Word," and "Word
Reference ."
Learning Word will teach you how to create, edit, format, and print a
short document . When you're finished, you'll understand how to use
Word, and you can build more complex documents to fit your needs .

Using Word is a guide to word processing with Microsoft Word . This
part is organized into five general categories : Editing With Word, Format-
ting Your Work, Working With Complex Documents, Printing Documents,
and Handling Documents . The bold heads in the margin show you where
to find the step-by-step instructions for each task. "Using Word" also
describes how you can use document windows to simplify complicated
editing tasks, such as moving text between documents ; and how you can
use the glossary window for inserting frequently used text into documents
automatically.

Word Reference contains a directory of Word commands, a list of terms
used in this manual, and appendices that cover key sequences, preset page
options, disk and memory management, the use of other Macintosh appli-
cations with Word, and daisywheel printers .
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Are new to the Macintosh

	

Macintosh owner's guide

Have never used a word processor

	

Learning Word
before
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Want a quick introduction to some
basic tasks

Have used another word processsing Using Word
program
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Word Reference
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About This Manual

We assume that you already know how to use your Apple Macintosh com-
puter and that you have read Macintosh, your owner's guide. You should
know how to :

•

	

Use the icons on the Macintosh desktop .
•

	

Open, copy, and delete Macintosh documents and disks using the
Finder.

•

	

Point and select with the mouse .
•

	

Scroll in the window using the scroll bars and the scroll box .
•

	

Manipulate the size and position of windows using the size box and
the title bar .

•

	

Pull down menus and choose commands .
•

	

Use the Clipboard and Scrapbook to store information .





To use Word

	

∎ A Macintosh computer
you need:

	

∎ The Microsoft Word master disk
•

	

Formatted disk(s) for copying
•

	

An external drive (recommended)
•

	

A printer (optional)

Before you begin :

Getting Started

Microsoft Word is provided on a "master" disk that contains special iden-
tification that Macintosh must read when you use Word .

You can make as many copies of Word as you need . But Macintosh must
read the identification from the master disk when you start Word the first
time after turning your computer on . After that you can use your copies .

If you use a hard disk with your Macintosh, see "Appendix C, Disk Space
and Memory" for details on copying Word to the hard disk .

D Make at least one copy of the master disk by moving the Word master
disk icon over the icon for the other disk . See Macintosh, your
owner's guide, for details .



Introduction

D

Copy /he Word ma~fer disk fo
blank, forma//ed disk.

After you make the copies, use your master disk only when Macintosh
prompts you to insert it to read the disk identification . Never make
any changes to this disk.

Note

	

Do not use the Macintosh Disk Copy utility to copy your
Word disk. Also make sure that your disk is not write-
protected .

Remove any printer drivers you don't need from your copies of the Word
disk. (A printer driver is a special document that allows Word to com-
municate with a printer .) Word automatically adjusts the screen to match
your printer by checking to see which printer drivers are on the disk .



rake /he prinfer documents you need from fhe Prinfer Folder .

Then move prinfer documenfs fo anofher disk.
Or delete them if you prefer.

Getting Started

If you are using a daisywheel printer with Word, your window display
may look different from those used in this manual. If you are using an Ap-
ple Writer or Apple laser printer, some dialog boxes may differ . For more
information, see "Appendix E, Daisywheel Printers ."

Note

	

To use Word most efficiently, you will need an external
drive. See "Appendix C, Disk Space and Memory" for
suggestions on how to manage your disks, and for infor-
mation on how to use Word with one disk drive or a hard
disk.



Introduction

To start Word with
your copy :

To start Word with
the master disk :

Starting Word

Always start Word with one of the copies you made . Macintosh will ask
you to insert the master disk whenever it needs to read the identification .

U
A

To . . .

Start Word and create

	

Double-click on
a new document

Start Word and open

	

Double-click on
an existing document

	

LETTER

If Macintosh needs to read the Word master disk, it will eject your copy
and prompt you to insert the master disk . Then Macintosh will read the
disk identification, eject the master disk, and prompt you to insert the
copy.

If you inserted the Word master disk first, use this procedure :

Start Word with the Finder .
•

	

Choose the Quit command from the File menu .
Eject the master disk.

•

	

Insert your copy of the Word disk .
•

	

Start Word and begin working .

0

Turn on the Macintosh power switch .
Insert your copy of the Word disk into the disk drive .

Do this:

,Y t:,r j





Learning Word
"Learning Word" shows you how
to create, edit, format, and print a
document with Word . In this
part of the manual, you will
create one short document and
refine an existing, longer docu-
ment. Both are typical of
documents a small business might
produce.

?11

1

r

Step-by-step instructions will
guide you through these basic
tasks as you learn how to pro-
duce simple documents to fill
most of your everyday needs .
After you have worked through
the tasks in "Learning Word"
starting a new document, enter-
ing and editing text, formatting,
and printing-you will be ready
to begin producing your own
documents .



"Learning Word" is divided into
five short chapters . A complete
outline of the material they cover
follows .



Learning Word

In Chapter 1, "Type the Text," you will :

•

	

Type a short sample document
•

	

Insert text by typing
•

	

Reverse with the Undo command
•

	

Select and delete text
•

	

Ask for help
•

	

Save the sample document
•

	

Close the window

In Chapter 2, "Revise a Document," you will :

•

	

Open a longer document (a memo)
•

	

Move text in the memo
•

	

Copy text
•

	

Find and change a phrase throughout the document

In Chapter 3, "Change the Appearance of Your Document," you will :

•

	

Display the invisible paragraph mark (optional)
•

	

Center the title of the memo
•

	

Open space above a paragraph
•

	

Indent paragraphs
•

	

Make the title boldface
•

	

Make the title larger

In Chapter 4, "See It In Print," you will print the memo .

In Chapter 5, "Finish the Session," you will quit and review what you
learned .



Start Word :

	

Start Word by double-clicking on the Word icon . One window opens on
the desktop . This is the active document window . It is untitled and emp-
ty, except for the insertion point and the end mark .

Close box
r a File Edit Search Character Paragraph Document

LI

Untitled

The invisible selection bar / used to
select entire blocks of text quickly .

R When you move the mouse info the
`J selection bar, the moue pointer shifts

Menu bar

The blinking vertical line

	

Window split bar
is the insertion point .

The end mark show where
the document ends .

right.

	

Vertical scroll bar

Horizontal scroll bar

Title bar

Size box

15





Start typing :

1 Type the Text

In the next few sections, you will work with a short listing that a real
estate company might prepare to send to a newspaper as a classified ad .

0 Type the text for the real estate listing, as it appears below . The text
will appear at the blinking insertion point .
Do not press the Return key as you type . Use the Return key only to
end a paragraph or skip a line .

Untitled
Just listed this week--a house thatt has to be seen to be believed!! Call now!!
Richmond Beach area, $70,000 . Classic old world charmer, 2 bedrooms plus
master
appliances

bedroom, fireplace,
and drapes

hardwood floors, unfinished basement .. All
included . Private lot, in good location, close to schools

and freeway . Call Jim Murphy at 999-?7770

Page 1



Learning Word

Try backspacing :

Note that the insertion point moves to the next line each time you reach
the right margin . This is called "wordwrap ." Wordwrap saves you a lot of
work when you insert, delete, or change the format of your text . Word
automatically "wraps" and adjusts lines as you type .

.U=----	 UIIII(ICU	

0

Just listed this week--a house that has to be seen to be believed H Call now !
Richmond Beach area, $70,000 Classic old world charmer, 2 bedr
rnast,er bedroom, fireplace, hardwood floors, unfinished basement All appl o

C	 Untitled

Just. listed this week--a house that has tr) be seen to be believed!! Call nowH
Richmond Beach area, $70,000 . Classic old world charmer, 2 bedrooms plus

All
appliance jo

Wordwrap moves the entire word fo the next line.

If you make a typing mistake, press the Backspace key. The Backspace
key erases characters as it backs over them .

Press the Backspace key four times to erase the period and the last
three 7's in the phone number .
Type: 888.



Add more text to
the listing :

Inserting Text

Add a couple of items to the listing to make the home seem more attrac-
tive to buyers. To add text to the paragraph you just typed, point the
mouse and click to position the insertion point where you want to start
typing.

0

Note that the lines adjusted automatically as you typed . Word also
G(

Click before the period ( .) following "basement" .
Press the spacebar, then type : with washer and dryer
To insert text at the end of the document, click before the end mark .
Press the spacebar and type : Closing costs negotiable.

wraps" text when you insert .

Untitled	
∎Just listed this week--a house that . has to to seen to be believed t t Call now t t

Richmond Beach area, $70,000 . Classic old world charmer, 2 bedr

cost, negoUabieX<>
I

\ .
lnserfed fexf

Mace, hardwood floors, unfinished basement, with
washer and dryer . 11 appliances and drapes included . Private is

ols arid freeway Call Jim MurUhv at QQQ-7&

	

Closing

Type the Text

The mouse pointer changes fo an I-beam
when if i~ in the text area .

19



Learning Word

Undo what you
just typed :

Using the Undo Command

If you make a mistake, or have second thoughts about what you just
typed, you can reverse your most recent action with the Undo command .

0

P1

r

Pull down the Edit menu and choose the Undo Typing command .
(The Undo command changes with your last action-in this case, typ-
ing.) The text "Closing costs negotiable ." disappears .

Look at the Edit menu again . The command now reads Redo Typing .
Choose Redo Typing to put the text back again . The text will be
selected when it appears on the screen again .

HI

Just list
Rich Ill C)

master
washer

Edit
R~ o yping

Show Clipboard
Show Giossary

Show Ruler

	

R
Show qI

	

Y
Preferences . . .

tar Paragraph Document

Untitled	

has to be seen to be believed ! i Call now i
assic old world charmer, 2 bedrooms plus
cod floors, unfinished basement w to
and drapes included Private lot in good
*a*~

	

all Tim 1duirr' 4r at OC)O-7P .SU



First, select the 2 :

Type over the 2 :

Selecting and Deleting Text

You might want to delete text from your listing-for example, the news-
paper may limit the number of words you can put in your listing for a cer-
tain price. You can delete a letter or a word at a time, or you can delete
large blocks of text at once .

To make your listing more concise, you could change the phrase "2 bed-
rooms plus master bedroom" to read "3 bedrooms" .

Before you can change any part of a document, you need to select the
text you want to change .

D

0

Click the "2" and drag across it .

Type the Text

There are several ways to delete with Word . One way is to replace the
selection by typing over it .

Type 3

Untitled	
Just. listed this week--a house that has to be seen to be

	

U! Call now!!
Richmond Beach area, $70,000 . Classic old world chars

	

B irooms plus T
waster bedroom, fireplace, hardwood floors, unfinished

	

nt with
washer and dryer . All appliances and drapes included . Private lot in good
location, close to schools arid freeway . Call Jim Murphy at ~JJ9-7Closing
co :,ts riegotiable .o

Just listed this week--a house that has to he seen to he

	

!! Call now!!
Richmond Beach area, $70,000 . Classic old world chars :

	

irooms plus
master bedroom, fireplace, hardwood floors, unfinished

	

: t with
washer and dryer . All appliances and drapes included . Private lot in good
location, close to schools and freeway . Call Jim Murphy at 999-7Closing
costs negotiable .o

Another way to delete is to use the Backspace key . Now delete the three
words: "plus master bedroom" . Again, you need to select the text first .

21



Learning Word

Select the first word :

Delete the words
using Backspace :

Select the
sentence :

0

0
A

Move the insertion point to the word "plus" .
Double-click to select the word .

_LJ	 Ulll{IIeU

lust listed thi week--a house that has to he seen to he believed!! CE

?a, $70,000. Classic old world charmer, 3 bedrooi
replace, hardwood floors, unfinished basement W
All appliances and drapes included Private lott in good

locatiori, close to schools arid freeway Call Jim Murphy at 999-7888 Closing
costs negot able .o

1113 ter b ire ~m

Press the Backspace key, and the words will disappear .

Now remove the sentence "All appliances and drapes included ." You can
also delete by selecting the text then choosing the Cut command from the
Edit menu .

Move the pointer anywhere in the sentence .
Hold down the Command

	

) key while clicking the mouse .

U	 Untitled	

Just. listed this week--a house that . has to be seen to be believed!! Call now!!
Richmond Beach area, $70,000 . Classic old world charmer, 3 bedroom,

d basement with washer and drye
:vane lot in good location, close to s
-7$ Closing costs negotiable o

;.i > )Itan;es and di . &S in' lud~.1

The rest of the words are
tion to include these words .

on the next line . You need to extend the selec-

Extend the 0 Move the pointer after the last word you want to select ("bedroom") .
selection : a Hold down the Shift key and click .



Delete the
sentence using
Cut:

Select the
first line :

Delete the line :

0 Choose the Cut command from the Edit menu . The text disappears
from the screen .

When you use the Cut command, text is stored in the Clipboard . It will
remain there until you move or copy something else to the Clipboard .
(Moving and copying text will be discussed in the next chapter .)

You can also select a block of text by moving the pointer into the selec-
tion bar on the left side of the window .

Move the pointer into the selection bar to the left of the first line .
The mouse pointer shifts to the right when you are in the selection
bar.
Click once . The line is selected .

0

w

0

The mouse pointer shifts right in the selection bar.

j >'_,t . hSt'?d this ;reel:--a hour t1itt ha ti:1 t * sell t< 1e helievd !! ,.~

	

S 'x.11 ti ;o ., r

fl1 eplace, hardwood floors, unfinished t)asernent with washer and dryer
I iVatk lot . In good location, close t~) schools and freewa y Call Jun Murphy t

999-7888 Closing costs negotaat le

Press the Backspace key once, and the line will disappear .

Type the Text

Text is not stored in the Clipboard when you delete with the Backspace
key, although you can get it back with the Undo command .

If you make a mistake selecting text, you can easily change your selection .
Move the mouse pointer away from the selection . When you click again,
the insertion point moves to the location you are pointing to .

23



Learning Word

Asking for Help

There are two ways you can ask for help :

•

	

You can choose the About Microsoft Word command from the Apple
menu and select any topic from the list box .

•

	

You can type Command-? When the cursor changes to a question
mark (? ), move it to a command or dialog box area . When you click,
Word displays help information about the item you are pointing to .



About Microsoft Word . . .

Scrapbook
Alarm Clock
Note Pad
Calc:ulator
Key Caps
Control Panel
Puzzle

I. Choose the About
Microsoft Word command . . .

I . Press Command 2

Saving [Jncument ;

Word version k .HH

July 25, 1984

© 1984 Microsoft Corp .

100 % free memory

a

	

Help

	

( Cancel

Printing
Printing Form Documents
Undoing & Deleting
Moving & Copying
Using glossaries
Displaying the Ruler

Type the Text

2. Select a topic from the list box
. . . and click Help

File
New
Open . . .
Close

OR

Save 7
Save As . . .
Page Setup . . .
Print . . .

	

P
Print Merge . . .
Printer Setup . . .
Quit

	

o

2. Move the mouse pointer to whatever you
need information about. . . and click.

Z5

Help

Saving Documents
t Save command--saves the document in the active vindov .

If you are editing a document that has been saved before : Word

4)

., ;

Q

updates the old version of the document on the disk .

lljypu choose Save to save a nay document; Word viii display the
Save As dialog box . Type a document name, and click Save .

It is a good idea to save often as you vork vith Word . When yo
save, Word displays the number of characters in the pq
states area of the virdov. The character count remains on the
screen until you make a selection .

* Save As commend--saves your document . Use Save As to

Topics Went (Previous Cancel

Getting Heap
Using the Scrapbook

t

∎
Opening & Closing Windows
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To use the About

Microsoft Word

command:

To ask for help on

a particular topic :

To resume your

work:

0

0

11

0

-J C) C) '7

Choose the About Microsoft Word command from the Apple menu .

The dialog box contains a list box that displays the topics you can get

help with. The dialog box also contains memory information .

* File Edit Search Character Paragraph Document

just its

Richrn~

rirepla

Private

Untitled

Close the help window by clicking the close box .

OR

Press the Cancel button .

1 now!!

S,

er .
rnt,~ a

Many topics have more than one screenful of information. Scroll down to

see the rest of the information .

Hold down the Command key while pressing the ? (question mark) .

Move the ? to the command or to the topic in the dialog box that you

want information on .

When you click, the help window appears. It contains the help infor-

mation on the item you were pointing to .

Help
-'

Saving Documents

* Save command--saves the document in the active vindovi
t

If you are editing a document that has been saved before : word

updates the old version of the document on the disk .

lLy4u choose Save to save a new document : word viii display the

Save As dialog box . Type a document name, end click Save .

It is a good idea to save often as you work with word . When you

save, Word displays the number of characters i n the pegs ~ :

status area of the vincov . The character count remains on the

screen until you make a selection .

* save As command--saves your document . Use Save As to i

Topics NeRt
(Previous ( Cancel



Save the listing :

Saving Your Work

You will probably want to save your work at the end of each Word ses-
sion so that you don't have to type it again . It's also a good idea to save
every 15 minutes during each Word session . This ensures that your work
will not be lost if there is a power interruption or if you leave your Mac-
intosh unattended .

If you decide to save the listing, follow these steps .

Choose the Save As command from the File menu . The Save As dialog
box appears .

A

Note

	

If you have a single drive system or if you plan to go
through this lesson again, you probably won't want to
save this document. You can go on to the next section
and close the window .

tdit Search Character Paragraph document

Untitled

Save Current Document as :

LISTING

0TeHt Only fl Make Backup

Save

Cancel

Word copy

[Eject J

Type the Text

Type LISTING in the box labeled "Save Current Document as :" . This
kind of box is called a "text box ." LISTING will be the name of the
newspaper listing.

27
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11 Click the Save button. Word saves the document .

When you click the Save button, the number of characters in the docu-
ment appears in the lower left corner of the window where the page
number usually is .

For details on the other options in the Save As command, see Chapter 10,
"Handling Documents."

The listing stays on the screen so you can continue working after you
save. For now, close the window and move on to another task.



Close the window :

Closing the Window

Although you can have up to four windows open at one time, it is easier
to close windows that you are not using .

0 Choose the Close command from the File menu .

Type the Text

The window disappears and you see a blank, gray desktop .

Whenever you have unsaved changes or try to close a window containing
a new document, Word asks if you want to save . This ensures that you
will not accidentally lose your work. You will see a box that says "Save
changes before closing window?"

For more information, see Chapter 10, "Handling Documents ."

29
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PREPARING A HOME FOR SALE

r'an understand that showing a home to its best. advantage
makes the buyer want to purchase quickly arid at a better price .
Here are some tested tips to set the stage for a profitable and early
sale .

Fix up inside . Badly faded wa s or worn woodwork reduce appea
Selective painting will help

	

add a fresh look . Glean
windows and unmarred walls will create a bright, cheery
appearance .

Make minor repairs . Dripping faucets call attention to faulty
plumbing .

	

hould make sure all plumbing is in good
working order1 I

	

e seller can correct small items, a critical
prospect can concentrate on major considerationsfLoose door knobs
and sticking drawers or doors can distract the buyer as well .

First impressions are important . The se

	

should keep the lawn
trimmed and edged, cultivate flower beds, and remove all refuse or
clutter from the yard, sidewalk., and porches .

GJDr p b J oUOQDa aQOUt ®Pa
11950 16th Ave . E., Seottle, WA 98112

The seller hould pay special attention to the kitchen when preparing
the home for sale . Shining ovens, ranges, and appliances will catch
the buyer's eye and make a good impression . Keeping the counters
and sink cleared and neat makes the kitchen look spacious . Colorful
curtains in harmony with the counter tops and floors add appeal as
well .

Bathrooms that sparkle can be a real plus . The selle should check
and double-check them .

Bedrooms are important focal points
effort to keep them neatly arranged .

will find it worth the

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



Open the memo :

2 Revise a Document

Now that you are able to use Word to type, insert, and delete text, you
can learn to edit a longer document. This time you will open a document
already on your disk-a memo that lists suggestions on how to prepare a
house for sale .

A Choose the Open command from the File menu . A dialog box appears .
The dialog box contains a list box displaying in alphabetical order the
names of all documents on the disk. You may need to scroll to see
the entire list .

Scroll the list box to see a list
of the documents on the disk .

Ed t Search Character Paragraph Document

MEMO Select a Document :

Word copy

O pen 3	Eject
I

Cancel

31
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Double-click the document name MEMO . The document will appear
on the screen .

Now you can start to edit the memo .J

MEMO

fljrp , ~UUcn 0 QQ ]Ut a

The seller
the buyer
tested

Fix up
painting
walls

Make
seller

PREPARING

can correct

will

tips

inside .

minor
should

want
to set

will help
create

small

A HOME

repairs .
make

can understand

Badly

to
the

a

11950

the

item

FOR

purchase
stage

faded
seller

bright,

sure
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Moving Text With Cut and Paste

You move text in Microsoft Worst the same way that you move text in
other Macintosh applications . You simply cut text from the document,
then paste it hack from the Clipboard into the new location .

For example, you can move the paragraph starting with "First impressions
are important . • ." closer to the beginning of the document .

0

I'

a

0

Revise a Document

Scroll down to the fourth paragraph in the document (beginning with
"First impressions . . ") •
Move the pointer into the selection bar to the left of any line in the
paragraph .
Double-click to select the entire paragraph .

$ File Edit Search Character Paragraph Document
0	 MEMO	

Make minor repairs . Dripping faucets call attention to faulty plumbing The
seller should make sure all plumbing, is in good working order . If the seller
can correct small items, a critical prospect can concentrate on major
considerations . Loose door knobs and sticking drawers or doors can distract .

First; irnr)Ie1si ails are Irnp'Drt~nt. Th. seller should keep the lawn trimmed
~rtd edged, cultiva.t flower beds, and remove all refuse or clutter fIOiii the
yard, sjdev.ialk and orches

The seller should pay special attention to the kitchen when preparing the
home for sale Shining ovens, ranges, and appliances will catch the buyer's
eye and snake a good impression keeping the counters and sink cleared and
neat makes the kitchen look spacious . Colorful curtains in harmony with the
counter tops and floors add appeal as well

M
r.

Page 1

Choose the Cut command from the Edit menu . The paragraph is
stored in the Clipboard .

33
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Select the new location for the text, after the first paragraph in the

memo. Place the insertion point just before the "F" in "Fix . . ." .

© Choose the Paste command from the Edit menu . The paragraph reap-

pears in the new location .

D	 MEMO	

PREPARING A HOME FOR SALE

The seller can understand that. showing a home to its best advantage makes

the buyer want to purchase quickly and at a better price . Here are some

tested tips to set the stage for a profitable and early sale .

First. impressions are important. The seller should keep the lawn trimmed

arid edged, cultivate flower beds, and remove all refuse or clutter from the

yard, sidewalk, and porches .

Fir, up inside Badly faded walls or worn woodwork reduce appeal Selective

painting will help the seller add a fresh look . Clean windows and unmarred

walls will create a bright, cheery appearance

Make minor repairs . Dripping faucets call attention to faulty plumbing The

seller should make sure all plumbing is in good working order If the seller

JR

E

1"M



First, select
the sentence :

Copy the sentence :

Copying Text

You copy text in the same way you move text . However, instead of
choosing the Cut command, you choose the Copy command from the Edit
menu .
For example, there is an important sentence in the fourth paragraph : "If
the seller can correct small items, a critical prospect can concentrate on
major considerations ." You might want to say this again at the end of the
document .

0

A

Place the insertion point anywhere in the sentence .
Hold down the Command key while clicking the mouse .

Choose the Copy command from the Edit menu . The text is copied
to the Clipboard .
Place the insertion point just in front of the end mark.
Choose the Paste command from the Edit menu. The sentence ap-
pears at the new location .

Revise a Document
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=C MEMO	

tour the home

Attics, basements, and garages are important features By removing
unnecessary clutter which may have accumulated, the seller will display the
full value ~:f storage and utility space

Schedule showings treatt are convenient so that . the home will be presented a
its best Personal and famil ;y privacy should be respected

The seller should discuss the wisdom of any major project n h the real
estate agent before proceeding Many large expenditures, though needed,
	 . • . v r. ..4 4.n ,'. .-.r., . a--.g . .,.11 ., r a . .~. :~ . 4r . . .r.rv 4n .- .1i n ti	

If the seller can correct small items, a critical prospect . can concentrate on
major considerations . o

Copied text at enc/of document

Don't worry about the spacing around the sentence-you will fix this
later on .



Replace the text :

Finding and Changing Text

You can easily find and change text with the commands on the Search
menu. For example, you could use the Find command to search through
a document for a name or phrase . The Change command finds and
changes text . You can automatically change all occurrences of the text .
Or you can go through and selectively change each occurrence, one at a
time .

Use the Change command to replace all occurrences of "the seller" in the
MEMO document with the word "you" .

0

Revise a Document

Choose the Change command from the Search menu . The Change
command window appears. (You can move this window around by
dragging the title bar if it obscures your text .)
Type in the text box labeled "Find What :" the seller
Press the Tab key to go to the next text box . Type the text you want
to change it to : you
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Frsf oceurrenc e of 'the seller"

Th'
'.Sv w u~ va
"

	

i

	

t i •

Click the Find Next button. The first occurrence of "the seller" is
selected .

arp

I UI U jJ U .III

	

UUL UIIIGII t

1EM0

bq a Qooou~a ~ooUt or~
Q5(l 1 fit h AvP F SPAt t i P WA QR 1 17

ant. t~ purchase quickly arid at a better price . Here are same

Change

Find What :

Change To :

El Whole Word

Find NeHt

the seller

yob

(1:hange, then Find

fl 'latch Upper/lowercase

CChange ) Change All



8 Click the Change, then Find button to replace it and go to the next
occurrence .

"The seller" was changed to "You". No/e /hat since "The seller" contains
a cap ilal /e/lei', Word cap//alizes You " to replace i/.

tEMO

~o~aq & aUU JQOaQO~tEto

1 V U. 1.0,1 :

buyer Tv

tips to

Find What :

Change To :

fl Whole Word

Find Nent CC ange thenFind

rlrs'. IriipxesslOUS are Imporiii
and edged, cu.lUvate flower be
varr~ cir~ot y 1U anr1 nr - -~

Th& seller

Revise a Document

0	 Change

the seller

yob
[I] Match Upper/owercose

[change) Change All

1VULU Z t't) U10 1ClWI! U 11i11i1C~.i

rix up lnslae . tawy IL

	

)I WOI Il WUOUWOI K I euuce appeal ~eiecuve
painting will help the

	

a fresh look Clean windows and unmarred
walls will create a bri ;

	

pry appearance .

i1/ex/ occurrence

Word searches forward from the insertion point to the end of the docu-
ment, then goes hack to the beginning of the document and searches for-
ward until it reaches the insertion point . In this case, the insertion point
was next to the end mark, so Word went directly back to the beginning .

You can cancel a search at any time by holding down the Command key
and pressing the period ( . ) .
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Close the window :

a

When you c/thnge ill occurrences,
the entire document / ~eleefed

To replace all occurrences of "the seller", click the Change All button .
All occurrences of "the seller" will be changed to "you" •

t IIP t nli yPhtrrn I .niiririPr

Find NeHt

Change

1lti'ratte flvv'€

Fix up 1nc 14_ E.ad1y faded tryail

	

iort itoodworl' r uce appeal : Seletiv~
painting will help you . add a.' 'fresh lc' : • Glean windows and unmarred walls
will cr at? a bri-'lit cheery a ~earanc

. .JI~4 J	• . . .I	M I7

	

. . . •f	\ • . .1	J .\ . . . •	y, •, . .,{. .n!S\ :Y ; . ': { • . .5 :	S{{ . . .
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•
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.~ A{'11\ J{{ •	. . . . . . . . . : . . .,}y .fi	r,{.{.!.K. •{ , j:b.;	rQ~y,.}J. ., ;:.\ >. .J : . . .A~ . . . .Y. . .J	Y. .

	

. .r .: •,

	

:<`~'4~~~ . . . • •

	

~.

	

~	~ • . ~ ., . .~~~! •

Now close the Change window •

0

the seller
yoL

I

Change, then Find

rirnt nit ii uuturnent

Change , Change All

Choose the Close command from the File menu, or click the close
box on the Change window .



3 Change the Appearance
of Your Document

With Word, there are many ways you can format, or change the appear-
ance of, your document . You can change the shape, size, and position of
the characters for emphasis . Or you can change the way a paragraph aligns
on the margin, the indentation, or the amount of space between lines .
You can structure and organize your text into columns or tables .

A paragraph is a group of related concepts, and can be as long or short as
you want. The Paragraph menu commands give you the power and flexi-
bility to format paragraphs in your document in a variety of ways .

When you use Word, pressing the Return key inserts a "paragraph mark,"
which is the end of the paragraph. The paragraph includes any text you
type before pressing the Return key, plus any formatting to the characters
or to the paragraph. When you insert or delete text, text wraps and
realigns only within that paragraph . This is why you should not use the
Return key to end a sentence ; if you do, all your sentences will become
paragraphs and must be formatted individually .

The paragraph mark is normally invisible . You can display it by choosing
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the Show ¶ command on the Edit menu ; do so now if you want to. Then
you can make it invisible again by choosing Hide ¶ .

P~r~graph mark

This / fhe symbol for a .pace.

A paragraph can be at any logical break in the text . For example, the
MEMO title "Preparing a Home for Sale" is a paragraph. You can em-
phasize the title by centering it .

(MO

PREPAR I NG •A •HOME •FOR • SA LE J

The seller can •understand • that showing a home •to •its •best advantage makes •
the . buyer•want to •purchase quickly
tested . tips •to •set the stage •for

Fix up inside . Badly faded walls
paintingSwill •help•the •seller • add

	 and •at•a •better •price . • Here •are •some
a profitable and •early •sale . I

or worn woodwork reduce appeal . Selective
a •fresh look . • • Clean•windows •and •unmarred •

walls . will •create •a •bright, •cheery appearance .1

Make minor repairs . Dripping faucets call attention to faulty plumbing . The
seller •should make •sure all plumbing is • in •good •working •order. lithe seller
can •correct • small items, a critical prospect •can concentrate on majors _'
considerations . • Loose door •kno • •and •sticking drawers or •doors •can •distract • •
the buyer •as •weil .4 4i

Page



Center the title : U
P1

F IIG

	

LUI l

	

)CUI 411

	

L •I IUI U41

r

Select the title ; or make sure the insertion point is in the title .

Choose Centered from the Paragraph menu .

iLJ	
1L!1r p

A

'~qaL
1 1950 16th Ave

PREPARING

buyer want to purchase quickly ar
4., I-

	

4

	

r.nE ft,,-, nfnn,, Pnv r, i- .- lif :1-.1,

First impressions are important . Y
edged, cultivate flower beds, and r
sidewalk, and porches .

Appearance of Your Document

Paragraph

Normal

left
,iientered
Right
Justified

Single Space
Double Space
Open Space

Formats . .1

Tabs ., .

	

T

re are sortie tested

4Tn trimmed and
i.tter from the yard

Fix up inside . Badly faded walls or worn woodwork reduce appeal Sele :Uv
painting will help you add a fresh look . Clean windo \Ys and unmarred walls
will createaabright cheer	,	a earance
Page 1

The Paragraph menu commands set the line spacing for a paragraph . All
of the paragraphs in the MEMO document have an extra space between
them-except for the last paragraph, which you copied earlier .
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Open space above
the paragraph:

I LJ
tour tie to

0

Page 2

I IIC

	

LUIt

	

JCUI III

	

L.IIUI UL I

t 4uc , IJdS* II1~I11~, dUU dI ~l E'S QI

unnecessary clutter which may h~
value of storac e arid utility svace

I
Jl11C 4UIC 51IVWii% 1,11Q1 Ut LVIIYC
ion hnn4

	

P, PS

	

I r,A $PS

	

IIT? r.rert

You should discuss the wisdom of an
agent before proceeding . Many largE

Tabs, . .

	

T
li ou can correct small items, a critic. t . Y~r . . . oncentrate on major
consi . - dons .
0

Paragraph

/left
Centered
Right
Justified

Single Space
Double Space
Open Spate ..r

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

IIi CIII

~y removing,

IT aaa 1 .

	

.'.tY . .'.\'N V. .
.

	

I'

tide real estate

The in~erlion point shouldbe in the paragraph
you wan/ to open space above .

Move the insertion point to any spot within the paragraph .
Choose the Open Space command from the Paragraph menu .



A

B

	 - MEMO	

tour the home .

Attics, basement-s, and garages are important. features . By removing
unnecessary clutter which may have accumulated, you will display the full
value of stA:~rage arid utility space

Schedule showings that are convenient so that . the home will be presented at
its best. Personal and family privacy should be respected .

You should discuss the wisdom of any major project with the real estate
agent before proceeding Many large expenditures, though needed, may not
be economically sound while trying to sell a horrie .

iii you can correct small items, a critical prospect can concentrate on major
considerations .
0

Appearance of Your Document

The memo will look more like a list of suggestions if you indent some of
the paragraphs. Start with the "First impressions . . ." paragraph and contin-
ue through the "Schedule showings . . ." paragraph .

Move the pointer into the selection bar next to the line starting with
"First impressions . . ." .
Click to select the line .
Scroll toward the end of the document . Locate the paragraph starting
with "Schedule showings . . ." .
Position the pointer over the period after "respected" .
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Hold down the Shift key and click. The paragraphs from the selection
to the pointer are selected .

MEMO	

k p t:hnt neatly arl .~iig:~d

:l' 'tS loc1: larger 'r hen (1othe~ are pro )erl ' hun ind shoes, hats ., and
irtlc1CS are all in pl .?':e .

tour the home
of:jects and ol: tj.l:les final:e 1

	

fci ii'. i: ; ~(:

t •ti'is, l: aserrtelits, and garages are important features . $y rerrtoVin ',
11111ESS.3ty cluttrt which may haee acc:utiiulated . "ou.will '.lis Slav the full
v alue', storij :r i nd utility sp . .

:lies:lule sh':'i.Tings that are convenient. yo that• the home will be resented at.
it:, best. Fern ~.~tial and f itiiil' Sri.:ic should be res : e'.t?.
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S'hiff-click here fo extend fhe seleefion .



A

You will use These triangular markers to set indents.

P1

11

Choose the Show Ruler command from the Edit menu . The ruler ap-
pears at the top of the window. You can set indents and tab on the
ruler quickly and easily-and you can see how your formatting
changes look right away.

Appearance of Your Document

0	11	12	13	l4	 I

~~I tip l~r ~t all in .plA

tf'ii .'..*a

t'!Ut lh jJI til

J..1

look largeri when clothes are rte erly hun .ansi Shoes, ha £ and other

rile utility

1~ttk : •'s iii'.lt:

	

arziges are important features ~ r i'eilh~vin
unrlecessar clatt r which may have as :c1Jm1J1Z tA'i "( ii will 'u S ..la'th'? full

f~

	

'ttl;r?ifl that are 'r1"erLwnt i. . tha.t tli~ li' ItiE \rill be )1 ?SCIit : (

•

	

t' t F'&rs~:~t'i~:il ii~l farliil" .art Ta t t yai ull be r S. i

Page 2
You should discuss the wisdom of any major projectt with the real estate

4

Click and drag the marker on the left margin . The small square mark-
er is picked up by the mouse first . This is the marker for the first line
indent. Click and drag this square marker to the half inch mark .
The two triangles at either end of the ruler are for left and right
indents. Click and drag the left triangle to the half inch mark .

47
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Click and drag the firs/ line in den/ marker, then the left indent marker.

aut ~earcn l nara~ ter raragrapn uocument

(0	I1	12	,	13	14	15	((
4

t

0

File Edit Search Character Paragraph Document

When you release the moue bu//on,
your indent / changed.

If you want to hide the ruler again, choose the Hide Ruler command on
the Edit menu .

Ysets loot, larger when clothes are r~> ~ r chic_ any sho$t*at ,,
nd other articles are all in placee

fairways cleared of 4iects and obstacle make it, easier for ros ect5
?) t!)Ur the home .

tUc, ba w'ntS, oitd garagss die i1i4)1)! tflitt I Lutes. By removing
ut rlece ,nary clutter which may have accumulated, ou will dis to the
i ull valU Vf 5tui agr acid utility: spaces

schedule showings Uiat are convenient so that the home will 1
presented at its best . Personal and farm/ rivac should be
f'5 *'ard



Emphasizing Characters

You can emphasize characters by formatting them with the commands on

the Character menu .

For more impact, make your MEMO document title boldface .

A Select the title by clicking next to it in the selection bar .

Choose Bold from the Character menu .

File

	

Edit

t:)uyer 4"ant to pur ::1

Page

ianr

Character

Plain tent

Bold

Ifolic

Underline

004000

DdOiJQ®

Small Caps

Superscript

Subscript
. . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Formats . . . 8€D

First ;mpre~sicn are important . You sn .)ul(:z Keep the lawn trimrrled

nd edged, cultivate flower beds, and remove all refuse or clutter

from the yard, sidewalk:, and porches

Fix up inside . Badly faded walls or worn woodwork: reduce appeal
~elecUve painting will help you add a fresh lo •T1: Clean windo

	

and

	'

Appearance of Your Document

FOR SALE

Ilk ti l Cx'~i \ Cl 11 l C1 C' U1(1

	

.!.J J

r price Here are some tested

=ale

Kph Document

loaut o~a

Perhaps more emphasis is needed-making the title larger might help .
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Make the title larger : U

A

Make sure the title is still selected .
Choose Formats from the Character menu . A dialog box appears con-
taining a list box of fonts . (The font is the design of the alphabet that
characters are displayed in.) The font sizes are on the right side of the
font list box. The list shows the sizes available for the selected
font-in this case, New York, which is the preset font .

t et

r ou can un
buyer want
tine to pat t

Character Formats
-Style
® Bold
o Italic
O Underline
O Small Ceps
O Outline
0 Shadow

Chicago
New York
Geneva
Monaco

a':
∎

OK

( Cancel

Os ion
® Normal
o Superscript
OSubscript

Font
Size :

14

114Q~'C 111AACJ U1G

1.110 10 W11 U 1111111CU

L' . £ '.eLLVV ur./r/bua .

Click fo seleO/ fhe font size .

Word presets the font size at 12 points . Click to select 14 from the
right side of the list box. (The text box at the right labeled "Font
Size:" reflects the change ; you could also type a number here to
change the font size .)



Click the OK button .

Appearance of Your Document

`~ G1UUQOa GQCaoUtcixiP

ve . E ., Seattle, WA 98112

You can understand that showing a home to its best advantage makes the
buyer want to purchase quickly arid at a better price . Here are some tested
tips to set the stage for a profitable and early sale

First impressions are important You should keep the lawn trimmed
arid edged, cultivate flower beds, and remove all refuse or clutter
from the yard, sidewalk, and porches .

Fix up inside Badly faded walls or worn woodwork reduce appeal .
Selective painting will help you add a fresh look . Clean windows and
unmarred walls will create a br t cheer

	

earance .

Note that the dialog box for Formats also contains check boxes for the
other commands on the Character menu-Bold, Italic, Underline, Small
Caps, Outline, Shadow, Normal, Superscript, and Subscript . You can use
the Character Formats command to set all your formatting at once .

See "Formatting Characters" in "Using Word" for more information on any
of these commands .
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To print :

4 See It in Print

You can see the result of your work now by printing your document .

Before you start, make sure your printer is plugged in and installed prop-
erly. See your printer manual for instructions . If you are using a
daisywheel printer, see "Appendix E, Daisywheel Printers."

0

r

Choose the Print command from the File menu . You will see a dialog
box.

A

11

Ed t Search Character Paragraph Document

Quality :

Page Range :

Copies :

Paper Feed :

0 High

® RII

1

(j Standard

	

Draft

0 From :

	

To :

[:ontinuous 0Cut Sheet

OK

Cancel

You can understand that showing a home tx it.~ test aivantage maKes the
buyer want to purchase quickly and at. a better price Here are some tested
t,.ips t set the stage for a profitable and early sale'

First impresslc'ris are imp ::'rt~~nt You should keep the lawn trimmed
and edged, cultivate flower beds, and remove all refuse or clutter
from the yard, sidev~mll, and porches .

Fix up inside Badly faded walls or worn woodwork reduce appeal
Selective painting will help youu add a fresh look Clean windows and

	unmarred walls will create a bright, cheery appearance	
Page i

y .•V

	

I f!.NV

	

:~~~) VVW .T7

	

.~. .:N7.')I).)II V'Y

	

<

If you are using individual sheets of paper, click next to the "Cut
Sheet" option. If you have questions about any of the other settings,
see Chapter 9, "Printing Documents ."

Click the OK button. Your document will start to print .





When you want
to quit :

5 Finish the Session

At this point, you can continue to practice using Microsoft Word, or you
can quit .

Choose the Quit command from the File menu .
You will be asked if you want to save your changes .

If you want to go through "Learning Word" again, or if someone else
will be learning to use Word, click No to discard the changes to the
MEMO document you made in this session . Word quits and returns to
the Finder. Your changes to the document are discarded .

If you want to save, click Yes .

When all documents are saved, Word quits and returns to the Finder.

0

If you don't plan to work through "Learning Word" again, you can free
work space on your copy of the Word disk by deleting the MEMO docu-
ment or by moving it to another disk. It is easiest to do this with the
Finder .

Eventually, as you become more experienced with Word, you may want
to move the help file to another disk also .
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Review

In "Learning Word," you used the basic word processing techniques that
you'll need to build more sophisticated documents . And you have seen
some of the ways that Word simplifies your writing and editing tasks .

You have learned to :

•

	

Start Word
•

	

Type a new document
•

	

Insert text by :
Selecting the insertion point, then typing

•

	

Reverse an action with the Undo
•

	

Select text :
A character
A word
A sentence
A line
A paragraph

•

	

Extend the selection

command

•

	

Delete text by :
Typing over the selection
Choosing the Cut command
Pressing the Backspace key

•

	

Ask for help using the About Microsoft Word command and by press-
ing Command-?

•

	

Save your work using the Save As command
•

	

Close the window
•

	

Open a document with the Open command
•

	

Move text by :
Selecting the text
Choosing the Cut command
Selecting an insertion point
Choosing the Paste command to insert the text



Finish the Session

•

	

Copy text by :
Selecting the text
Choosing the Copy command
Selecting an insertion point
Choosing the Paste command to insert the copied text

•

	

Find and change text two ways using the Change command :
Finding then changing text
Replacing all occurrences of the text

•

	

Center the title by :
Selecting the title
Choosing the Centered command from the Paragraph menu

•

	

Indent paragraphs by :
Selecting the paragraphs
Dragging the indent markers on the ruler

•

	

Make text boldface for emphasis by :
Selecting the text
Choosing the Bold command from the Character menu

•

	

Change the font size by :
Selecting the text
Choosing the Formats command from the Character menu
Choosing the new size in the list box

•

	

Print a document using the Print command
•

	

Quit Word using the Quit command

If you have questions about performing specific tasks, refer to the "Using
Word" section of this manual . If you have questions about the individual
commands, see "Word Reference ."



Using Word

"Using Word" describes Word

	

main tasks: editing, formatting,

features and explains how to

	

creating complex documents,

write and produce a variety of

	

printing, and handling documents .

documents that fit almost every

need. The material is divided

into five chapters that cover the

v 6+n'

rn
k



Many of the tasks that were
described in step-by-step pro-
cedures in "Learning Word" are
explained in greater detail in this
section .

"Using Word" shows you how to
use Word's special features to
make your work easier. For in-
stance, you will learn how to use
the glossary function to store fre-
quently used pieces of text that
you can recall with a few simple
keystrokes. You might use the
glossary to store your return ad-
dress, or long titles, or equations .
Running heads are also described
in this section. You can create
running heads with Word to give
your documents a professional,
finished look.

If you create documents that
need footnotes, you will learn
how to create footnotes in this
section. Word follows your direc-
tions and automatically places the
text and the footnotes for you .

If you need form letters or other
kinds of form documents, you
will learn how to create these in
this section .

The following list shows which
tasks are described in each
chapter .
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If you want to . . .

	

See:

Select text

	

Chapter 6
Editing With Word

Insert or delete text
Move or copy text
Find and/or change text
Work with more than one window
Create a "glossary" for repetitive text

Change font, font size, or

	

Chapter 7
position of text

	

Formatting Your Work
Indent text
Change line spacing
Set tabs

Create running heads

	

Chapter 8
Working With

Footnote text

	

Complex Documents
Number pages
Change the position of footnotes,
running heads, or page numbers
Vary the format of a document

Change the margins

	

Chapter 9
Printing Documents

Print a document
Print a form document

Open a document

	

Chapter 10
Handling Documents

To save a document

See "Word Reference" for information about individual commands .



In this chapter :

6 Editing With Word

This chapter summarizes the basic editing techniques that you can use to
revise and refine your documents. If you have read "Learning Word," you
will find that this chapter reviews the techniques you learned there . This
chapter also covers Word's more advanced editing functions .

•

	

Entering Text
•

	

Selecting Text
•

	

Inserting
•

	

Deleting
•

	

Moving and Copying
•

	

Undoing Your Last Change
•

	

Finding and Changing Text
•

	

Going to a Specific Page
•

	

Using Windows
•

	

Inserting Frequently Used Text : The Glossary



Using Word

Entering Text

To enter text with Microsoft Word, start the program, then start typing .
There are several things you should keep in mind :

•

	

Words that are too long for a line are moved to the next line automat-
ically . This is called "wordwrap ." Wordwrap also occurs when you
insert or delete text ; your lines are adjusted automatically .

•

	

Use the Return key only to end a paragraph . Do not use the Return
key to end each line .

•

	

Use the Backspace key to erase mistakes as you type .

Word also uses key sequences to perform special editing tasks and to in-
sert some special characters .
Press the new line key sequence to end a line without starting a new para-
graph .

The new page key sequence inserts a page break ; that is, it ends the page
and starts another.

A fixed size, nonbreaking space keeps two words from being split at the
end of a line . For example, you might use a nonbreaking space if you
didn't want a line break between two words of a title or a name . A non-
breaking space is not enlarged or compressed when you justify a line .

An optional hyphen lets you specify that a word can be broken at the end
of a line, if necessary . Otherwise, Word moves the entire word to the
next line. The optional hyphen also indicates where you want that word
broken; for example, Clip-board
The Command-A key sequence will repeat your most recent action. For
example, if you type a sentence and press Command-A, the sentence will
be duplicated .



To insert . . .

	

Do this:

New line

	

Hold the Shift key and press
the Return key .

New page

	

Hold the Shift key and press
the Enter key.

Nonbreaking fixed space Hold the Command key while
pressing the spacebar.

Optional hyphen

	

Hold the Command key while
pressing the - (hyphen) key .

Repeat last edit

	

Press the Command-A keys .

See "Appendix A, Key Sequences" or your Quick Reference Card for a
complete list of all key sequences that you can use with Word .

Editing With Word



Using Word

Selecting Text

You must select an insertion point or text before you choose a command .
When you select text, you are telling Word where to perform the next
task.

To select . . .

An insertion point

A character

A word

The previous word

A line of text

A sentence

A paragraph

Part of a paragraph

An entire document

Do this :

Click to the left of a character to insert
in front of it .

Drag across it .

Double-click any character in the word .
The space after the word is also selected .

Hold the Shift key while pressing
the Backspace key .

Move into the selection bar to the
left of the line and click .

Press the Command key and click anywhere
in the sentence .

Move into the selection bar next to any
line in the paragraph, then double-click .

Click next to the first line you want to
select, then drag across the rest . Or extend
the selection. (See the procedure below .)

Move into the selection bar, then hold
down the Command key and click .



To extend any

	

Put the insertion point at the beginning
selection :

	

of the text you want to select.

To change the
selection :

To replace the
selection :
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Editing With Word

Move the pointer. When you click, the insertion point moves to the
new location .

Start typing. The text you type replaces the selection .

Move the mouse pointer to the last character
you want to select then Shift-click.

You can also extend the selection by pressing Shift and double-clicking on
the last word you want to select . This also selects the space after the
word .
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To insert new text :

To insert
teat from
the Clipboard :

Inserting

You can insert text by typing new text, or by pasting from the Clipboard .

You can also insert text from a glossary . See "Inserting Frequently Used
Text: The Glossary Window" in this chapter for more information about
glossaries .

0

0
A

Move the insertion point to where you want to insert the text .
Type the new text .

Move the insertion point to where you want to paste the text .
Choose Paste from the Edit menu to insert text from the Clipboard .

When you insert text, it takes the formatting of the character to the left of
the insertion point . If you are inserting at the beginning of the document,
then the text takes the format of the character to the right of the insertion
point .



Deleting

There are three ways to delete text with Microsoft Word :

•

	

To erase text completely, use the Backspace key or the Clear
command.

•

	

To remove the text from the document to the Clipboard, use the Cut
command.

•

	

To replace text, select the text and type over it .

When you delete text with the Backspace key or the Clear command, you
can use the Undo command to get it back .

To delete . . .

	

Do ONE of these :

More than one character

The entire document

Select the text ; choose Cut .

Select the text ; then press Backspace
(or choose Clear) .

Select the text ; start typing to replace it .

Editing With Word

One character

	

Place the insertion point to the right
of the character and press Backspace .

Select the character ; choose the Clear
command.

Select the character ; choose the Cut
command. This moves the character
to the Clipboard .

Select the character and type over it .

Select the character and press Backspace .

Select the entire document; press the
Backspace key, or use Cut to move
the text to the Clipboard .
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To move or
copy text :

Moving and Copying

You can move or copy text :

•

	

Within the same document
•

	

Between Word documents
•

	

Between Macintosh applications

When you move or copy text to a new location, whether it's in the same
Word document or in a different one, the text takes on the paragraph for-
matting of the text around it-that is, the alignment or line spacing. The
moved text keeps the character formatting it had in the old location . For
example, if it was italic in the old location, it will be italic in the new lo-
cation also .

Select the text that you wish to move or copy .
Choose Cut or Copy from the Edit menu . The selection is placed in
the Clipboard .
Move the insertion point to the new location for the text .
Choose Paste from the Edit menu . The text is pasted from the Clip-
board into the new location .

A
A

Note

	

A copy of the text remains in the Clipboard until the next
cut or copy. The Clipboard will hold only the contents of
the most recent cut or copy . If you cut or copy again be-
fore you paste, your original text will be lost .
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To move text with
the mouse :

To copy text with
the mouse :

It is often faster and easier to move text with the mouse instead of using
the Edit menu commands .

0
A

Select the text to he moved .
Place the mouse pointer on the character or spot where you want to
insert the text .

Editing With Word

© Click the mouse button while pressing the Shift and Option keys . The
text appears at the new location .

You can also copy text the same way, except that you press only the Op-
tion key while clicking .

0 Select the text to be copied .
Place the mouse pointer at the character or spot where you want to
insert the text .

© Click the mouse button while pressing the Option key .

You can move or copy any amount of text within a document using the
mouse. However, you cannot use this technique to move text between
documents .



Using Word .

To move or
copy between
documents :

The procedure for moving and copying between documents is the same as
for moving and copying within a document . You select text, then cut or
copy to the Clipboard . Then you select the new location (in a new docu-
ment) and paste the contents of the Clipboard in that location .

Select the text you want to cut or copy .
Choose Cut or Copy from the Edit menu . The text is placed in the
Clipboard .
Open the document you want to copy to . The new window opens on
top of any other windows on the screen .
Select an insertion point for the text .
Choose Paste from the Edit menu . The contents of the Clipboard are
pasted into the new location .

0
A

11

Note

	

When you are moving and copying text between docu-
ments, it is a good idea to save your document after you
paste. Until you save, Word has to go back to the old lo-
cation to read that text-if you copied text from another
disk, you will be asked repeatedly to insert the other disk.
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To move or
copy between
applications :

Moving or Copying Between Applications
You can also move or copy text, data, or pictures from other Macintosh
applications . If you have a document that mixes text, pictures, or charts,
you can copy (or move) the picture or chart into the document first .
Then copy or move the text separately .

Select the text or graphic you want to cut or copy .
•

	

Use the Cut or Copy command from the Edit menu to put the text in
the Clipboard . (You can also copy it to the Scrapbook .)
Close the document and quit the application .
Start the other Macintosh application .
Open the document you want to copy to .

•

	

Select the insertion point where you want to paste the text or picture .
•

	

Use the Paste command from the Edit menu to paste the contents of
the Clipboard into the new location .

A

A
B
B

This picture was pasted in from MacPainf .

fishietter ==--	-	

April 15, 1984

Mr . J . L . Murphy
11950 16th Ave . E
Seattle, lA 95112

i Rf al Estate Agents
115 Arthur Street

.iF] hind WA Q&)33

When you move or copy text between Macintosh applications, you will
lose all formatting to the text . See "Appendix D, Using Word With Other
Applications," for details .



To undo :

Undoing Your Last Change

You can use the Undo command to reverse your most recent editing or
formatting action . You need to use Undo immediately after the action that
you want to reverse .

When you pull down the Edit menu, the Undo command names the last
action you performed. For example, the menu might read Undo Typing,
Undo Paste, or Undo Formatting .

0 Choose the Undo command from the Edit menu .

Editing With Word

Once you carry out the Undo command, it becomes Redo on the Edit
menu-Redo Typing, Redo Paste, or Redo Formatting . This enables you to
reverse the Undo command . You can switch back and forth between dif-
ferent versions of text, to see which you prefer .



Using Word

Finding and Changing Text

You can easily locate text and change it with the commands on the Search

menu. You can :

•

	

Search for up to 255 characters .

•

	

Change a specified arrangement of capital and lowercase letters .

•

	

Change all occurrences of the text in a document .

•

	

Change only those occurrences you want to .

You can also search for a "wild card" character, using the ? (question

mark) to match any character. You could use this if you think you might

have spelled something more than one way . For example, hea? in the
"Find What

:" text box might find : head, heal, heap, hear, heat. You can

use as many wild card characters as you like in the "Find What :" box .

The Search menu commands affect the window that is active when you

choose the command. If you have several document windows open, you

have to search each window individually .

Finding Text

Use the Find command to look for and select a character, word, or group

of characters or words . The Find command always starts at the insertion

point or at the end of the selection and goes to the end of the document ;

then Find goes back to the beginning of the document and continues

searching to the end of the selection .



A

Click to f/rid only those
ooourrenoes that are .
a //no/ words, so Word
won'/ find your /ex/
embedded within words.

Editing With Word

Choose the Find command from the Search menu . You will see this
window :

Type the text /ha/ you want fo find here.

Q		Find

Find Whnt :

Whole Word

	

Match Upper/lowercase

Find N1

Clink to fnd ooourrenoes
oftext with the speoifed
arrangemen/ of upper- or
loweroase le//ers .

Click the Find Next button to start the search . You can also press the
Return or Enter key. Word searches for the text you specified and
selects the first occurrence (if there is one) .
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i File Edit Search Character Paragraph Document
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windows and
unmarred walls will create a bright, cheery appearance .
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Click the Find Next button if you want to continue . The document
scrolls automatically as needed. When all occurrences have been
found, you see an alert box saying "Search complete ."
When the search is complete, click the close box on the title bar to
close the Find window . (Or choose the Close command .)

If there are no occurrences of the text in the document, you will see an
alert box saying "Search text not found ."

You may want to change something in the document window while you
are searching. You can do this as you are using the Find command .



To edit text in the
document as you
search :

To change the
search text :

0 Click anywhere in the document window to make it active, and edit
the text. The Find window is still on the screen but it is under the
active window .
Choose the Find command again . The search text you used last will
be in the "Find What :" text box. Click the Find Next button to con-
tinue. You can also get the Find window back by dragging the docu-
ment window until you see part of the Find window, then clicking
anywhere in the Find window to make it active .

Double-click the "Fm d Whaf " /ext box.
The box will be selected

f_n

Find What :

[]Whole Word

C

Find

ou
(J Match Upper

Find Neat

Type the text that you want to find

Find Whot : Itt

f Find Neat

C8 5f
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To cancel the
search : Close /he find window by elieking fhe close box or use /he Close

command
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Changing Text
Use the Change command to find text and replace it with something else,
or to change all occurrences automatically .

The Change command also searches forward from the insertion point,
then goes to the beginning of the document and comes back to the inser-
tion point . However, if one or more characters is selected, the Change All
button will say Change Selection . In this case, only those occurrences of
the text that are within the selection will be found and changed .



A Choose the Change command from the Search menu . You will see

this window :

A Type the text that you

want fo / and

Press the Tab key to go book

and forth between text boxes.

C Click fo find and change

those occurrences that

are distinct words only.

(Otherwise, Word finds and

ohange~ search text when

if occur' within a word

e.g., is within display. J

i9 Type the replaoemenf text.

If you leave this box blank, the

search text will be de/efed

Change

Find Whet ;

Change To :

C o Whole Word

Find Next
j

A

8

fChange, then Find

D D Match Upper/Lowercase

Change C Change RII	
)
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D Click fo find only the arrangement

of upper- or lowercase you specify.

(Otherwise, Word ignores cap ifalizafion

when searching for characters. J
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To change all
occurrences :

Fnds the next occurrence of the text .

11

0

A

Click one of the following buttons to start . Word searches for the
text you specified and selects the first occurrence (if there is one) .

Fl

	

net: fl

CI

	

?To :

Find NeHt3

Change -

Change, hen Find

Changes the text when you click,
then fnds the next occurrence .

Change,

Changes the selection .

per/lowercase

Change All

Changes all occurrences
in the document automatically.

To continue searching, press the Find Next button or the Change,
then Find button . The document scrolls automatically as needed .
When the entire document has been searched, you will see the mes-
sage: "Search complete ."
When you are finished, click the close box or choose the Close com-
mand to close the Change window .

Choose the Change command from the Search menu .
Fill in the "Find What :" and "Change To :" text boxes .
Click the Change All button .

All occurrences of your text are changed automatically to the new text
you specified in the "Change To :" text box . The document does not
scroll, but the entire document is selected . Change All can be reversed
only with the Undo command .



To find and change

text within the

selection:

0

11

Select the block of text you want to search. The selection can be as

small as one character or as large as the entire document .

Choose the Change command from the Search menu .

Fill in the "Find What :" and "Change To :" text boxes.

Click the Change Selection button .

File Edit Search Character Paragraph Document

memo2
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find What :

Change To :

0 Whole Word

Find NeHt
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Change

Change, then Find

fl Match Upper/lowercase

Change
(Changeelection

~S

All occurrences of the text within the selection are changed. The docu-

ment does not scroll. You can reverse this change with the Undo

command .

a

if you have a selecfion on the screen,

Change All becomes Change S'elecfion .
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To go to a
specific page :

Going to a Specific Page

Word ends pages (or paginates) in a document when it is printed . You
can also press Shift-Enter to end a page yourself. You can choose the
Repaginate command from the Document menu to paginate a document
that has never been printed, so that you can see the page breaks. When
you want to go directly to a particular page in a paginated document, use
the Go To command on the Search menu . For more information on pagi-
nation, see Chapter 9, "Printing Documents ."

0

GoTo

Page Number: 1
OK

C Cancel )

ii

To go to the last

	

0 Choose the Go To command.
page of the

	

® Type the last page number, or any number greater than the last page
document :

	

number.
© Click the OK button .

Choose the Go To command from the Search menu . You see this dia-
log box :

Type the page number that you want to go to .
Click the OK button .

Word goes to the page you specified ; the first character on the page is
selected .
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With Word, you can have several document windows on the screen at any
time. Using more than one document window can be helpful to :

•

	

Edit several documents for consistency
•

	

Refer to another document for information
•

	

Copy and move text between documents
•

	

Use an outline or notes as you write

You can look at several document windows, or you can look at any of the
special windows . The special windows are used for performing specific
editing tasks. They include :

•

	

The Scrapbook window
•

	

The Clipboard window
•

	

The glossary window
•

	

The Find and Change windows
•

	

The footnote window

You will find more information on the Scrapbook and Clipboard windows
in Macintosh, your user's guide. For information on the glossary window,
see the next section in this chapter ; for information on the Find and
Change windows, see the previous section in this chapter. For informa-
tion on the footnote window, see Chapter 8, "Working With Complex
Documents ."

When you work

	

You can move windows around by dragging them with the title bar . You
with windows :

	

can shrink or expand windows by dragging the size box in the lower right
corner.

You can also double-click in the size box or on the title bar to make a
window full size, or to go from full size back to the smaller size . You can
keep several windows on the screen, and expand them one at a time to
work in each one .
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To open a window
for an existing
document:

You can have up to four document windows open on the screen at one
time. The Clipboard window also counts as one of the four . The active
window usually overlaps any other windows on the screen . (If your win-
dows are very small, they may not overlap .)

You can have up fo four windows open of one Time .

The acfive documenf window overlaps fhe ofhers.

The seller can urider sta
the buyer want to Durc

U

A

file Edit Search t

r p

400 \r

17o able-click here fo go fo full Size.

You can also split a document window into two . This is useful for seeing
two different parts of the same document at the same time. If you display
one document in two windows, changes in one document window will be
reflected in the other. A split window counts as two windows open on
the screen .

er Paragraph Document

Choose the Open command from the File menu .
Click to choose the document in the list box .

lice Rrew

	

2 2 ti



To open a blank
window:

To change from one
window to another :

D

0

A

Open

( Cancel )

Or, oliok to select the name, then oliok Open .

Eject

Editing With Word

n Click the Open button .

OR

Choose the Open command and double-click on the document name
you want to open .

Double-e//ek to open /his dooument

Choose the New command from the File menu . A blank, untitled
document window appears on the screen . This window overlaps any
windows already on the screen .

Move the pointer into the window you want to work in . (You may
have to move your windows around a bit, because smaller windows
may be underneath .)
Click anywhere in that window . It will move to the top .
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To split the

window:

If you need to look at different parts of one document at the same time,
split your window into two parts .

0

w

memo2	

buyer Tint to purchase quickly and at a better price Here are s
tips to set the stage for a profitable and early sale .

a en~. L lore pToceeurng . n1an~ large expenaitu
be economically sound while trying to sell a hor

If you can correct small items, a ci

'

Click on the split bar at the top of the right scroll bar and drag it to
where you want the split to be .

Drag split bar from here . .

I 11 C LWl JCOI t.II

Cn1!Jrp7 d~ GW ~Uc O~ L300U2OG
11950 16th Ave . E ., Seattle, WA 96

l 1101 at,'t 1Q l ayl Op

n is

Both windows contain scroll bars .

A flier( A Uni it rnn ('Air

to where you want the split./



After the split is made, you can change the size of the two parts by mov-

ing the split bar with the mouse. A split window counts as two windows

on the screen .

rite tui t )eat iui i iiar ai. tet r ai ayr apii uu . uitieii t

D

mema2	

bn ~ ~`~~3~a .QOODt&iOG

1 1 Q~n 1 fit h evP F cPAt t i P WA QR 1 1')

~cneauie snowmgs wit are convenient so t.nat the nome Ti

presente
rPcr ct~~

I UU SUUUIU U1SLU5J UIt WISUUILI UI QI1)1 IliQjUl ~JI UjtL vvtut uic t cal c~

agent before proceeding . Many large expenditures,

be economically sound while trvlnQ' to sell a home

consideration

Page 1
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if you move the gyp/// bar toward the fop of the window, the bol%m par/

erpndQ to fill the window.

Drag the split bar to the bottom or top of the window until the split

disappears .

The Clipboard displays the text that was most recently cut or copied from

a document (or application). You can easily move or copy text between

windows on the screen by using the Clipboard. For more information, see

the section on "Moving and Copying" in this chapter .
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To open the
Clipboard
window:

To close a window:

0 Choose the Show Clipboard command from the Edit menu . The Clip-
board appears on the screen .

Click the close box fo close the Clipboard window

∎

D

Clipboard

First impressions are important . You should keep the lawn trimmed
and edged, cultivate flower beds, and remove all refuse or clutter
from the yard, sidewalk, and porches .

You cannot edit fex/ in the Clipboard

Click the close box, or choose Close from the File menu, to close the
active window .

When you close a window that has unsaved changes in it, Word prompts
you to save those changes .

For information about using the footnote window, see Chapter 8, "Work-
ing With Complex Documents ."



Inserting Frequently Used Text :
The Glossary Window
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The glossary window is a special window for storing information that you
use often, but don't want to type over and over . You can use this window
for storing names, addresses, standard clauses for contracts, copyright in-
formation, or special terms or definitions you use often in your writing .
You store each piece of information as a glossary entry . Each glossary en-
try has a name, which can be anything you like-a word, a character, or a
phrase. When you type the glossary name in your text, and then expand
it by pressing the Command-Backspace keys, the full text of your glossary
entry appears in your document .

You can create glossary entries for a particular task and discard them at
the end of the session with Word . Or you can create entries that you save
from one session to another .

You may have used the Macintosh Scrapbook for similar tasks . You can
use the glossary window in much the same way. You use the Clipboard
to move text into it . The advantage in using the glossary window is that
you can type the glossary name and insert the entire glossary entry text in
your document using just a few keystrokes . And formatting to the original
text is kept . 91
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To open the
glossary
window:

a Choose the Show Glossary command from the Edit menu .

Type the glossary name in the
"Name of dlossary: " /ext box.

The list box contains names
of all glossary entries .

These are the
two reserved
glossaries.

Reserved Glossaries
When you open the glossary window, you will notice that Word has
reserved two glossary names for special use: "page" and "footnote ."

You can use the "page" glossary name to insert a page number in running
head text without having to type the number in the text. "Page" is re-
placed with the page number automatically when the document is printed .
You can use the "footnote" glossary as a place holder if you accidentally
delete an automatic footnote number in the footnote window . Word will
insert the correct footnote number when you expand the glossary .
For more information about running heads and footnotes, see Chapter 8,
"Working With Complex Documents ."

Glossary

Name of Glossary : page t
footnote



Using the Glossary Window
Select the text in your document that you want to be the glossary en-
try. If the text is not already in the document, type it in the docu-
ment, then select it . All formatting to the text will be kept in the
glossary entry .
Choose Copy from the Edit menu to copy the text to the Clipboard .
(Choose Cut if you want to remove it from the document .)

© Choose Show Glossary from the Edit menu . The glossary window
appears.
Type the glossary name in the "Name of Glossary :" text box. The
glossary name can be up to 64 characters long .
Choose Paste from the Edit menu .

0

8

The new glossary name
appears in /he list box.

The glossary text appears
in /he area below /he text box .

You cannot always see /he full text.
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Glossary _

Name of 6lossary : page
footno eaddress
address

Murphy & Allen,
Realtors 111950 16th
Rue . E ., Seattle, WA
98112
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To use a glossary
entry:

The glossary window does not have to be on the screen when you insert a
glossary entry in your document . Once you have created the glossary,
you can close the window .

Select the location where you want to insert the text .
Type the glossary name .
Hold down the Command key and press the Backspace key . The glos-
sary text appears in your document .

0

11

Page 1

'_u		flyer	-	
a

This ~laic home is located in Wind-iii-the-Willows 'yYith four spacious
h?drooms and three full-sized bathrooms, it will graciously accommodate a
family in warm, old-fashioned comfort that is rarely found in today's
modern homes

addresc

flyer	

This classic home is located in Wind-in-tl'ie-Willows With four spacious
bedrooms and three full-sized bathrooms, it will graciously accommodate a
family in warm, old-fashioned comfort that is rarely found in today s
modern homes

J jrpd f ~UUc QOOU~OP0
11950 16th Ave . E ., Seattle, WA 96112

~loss~ry name

Expandedglossary entry

s
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There is no limit to the size of the glossary entry text (so long as it fits on
the disk) .

When you expand a glossary entry, the character and paragraph format of
the glossary entry will apply to whatever you type to the right of the en-
try. Press Command-Shift-spacebar to go back to "plain text" character
format, and Command-Shift-P to go back to "normal" paragraph format . If
the glossary includes font changes, choose Formats from the Character
menu to go back to your normal text font and size . See Chapter 7, "For-
matting Your Work," for details on formatting .
You can insert graphics into a glossary from another application . Open
the glossary window using Show Glossary . Then use the Paste command
to move the picture from the Clipboard into the glossary window . The
picture will always be at the beginning of the glossary entry . For more in-
formation, see "Appendix D, Using Word With Other Applications ."

Open the glossary window with the Show Glossary command .
Select the name of the glossary you want to see in the list box . The
glossary name and text appears on the left side of the window .

You may not be able to see all of the glossary entry text-to do so, you
can copy the entry to the Clipboard and open the Clipboard .
The glossary window does not display formatting to the glossary entry
text. When you expand the glossary name, any formats in the original
text will also appear in the new location .
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address

address
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five . E ., Seattle, WR
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To replace a
glossary
entry:

To delete a
glossary:

To save a new
glossary:

You cannot edit glossary text in the glossary window . Instead, you must
change the text in the document, then replace the obsolete glossary text
with the new .

Type the new glossary text in the document, or expand the glossary
name then edit the text .

•

	

Move or copy it to the Clipboard .
Open the glossary window with the Show Glossary command .
Display the glossary text by selecting the name from the list box .

•

	

Choose Paste from the Edit menu to paste the glossary text from the
Clipboard over the text in the window .

A

a
11

The new entry completely replaces the old entry .

0

© Choose the Cut command . This deletes the glossary name and entry

You can choose the Save As command from the File menu while the
glossary window is active, or you will see a prompt to save the
glossary when you quit . You will see a box labeled: "Save Current
Glossary as :" .

•

	

Type the name of your glossary in the box . Most of the time you will
want to save to Standard Glossary, which is the name suggested in the
box
Click the Save button, or press the Return or Enter key .

A

I'

Choose the Show Glossary command .
•

	

Click the name of the glossary you want to remove .

Word automatically uses the Standard Glossary when you choose the
Show Glossary command. If you want all your glossary entries stored in
one place, just save your entry in this glossary .
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However, if you want to save the glossary entries for one session separate-
ly, you can do so by typing a new name when you save . This separate
glossary will appear on your desktop, and you can copy and move it to
other disks . To open a separate glossary, display the glossary window,
then choose the Open command and select the glossary you want to
open. The glossary will be merged into the glossary that is already in the
glossary window (usually Standard Glossary, since Word loads this glos-
sary automatically).

To move your glossary to another disk, use the Finder to copy it . See
Macintosh, your owner's guide, for information on copying files from one
disk to another.





In this chapter :

7 Formatting Your Work

When you format a document, you tell Word how you want your finished
page to look. You can alter the position, shape, or density of characters in
the text. You can change the alignment and spacing of paragraphs, or in-
dent them from the margins . You can set tabs to align your text in
columns. Usually, any format you choose will appear on your printed
document just as it appears on the screen .

With Word, you control three levels of format : the appearance of charac-
ters, the alignment and spacing of paragraphs, and the layout of pages .
This chapter covers character and paragraph formatting. For information
on page layout, see the next chapter, "Working With Complex
Documents ."

•

	

Formatting Characters
•

	

Formatting Paragraphs
•

	

Setting Tabs
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Formatting Characters

Text consists of the characters that you type in your document . Charac-
ters include letters, symbols, numbers, and spaces . There are also some
special characters, normally invisible, that you can display with the Show
¶ command on the Edit menu . See the Show ¶ command in Chapter 11,
"Commands," for more information .

The Character menu commands control font, font size, position, and shape
of characters . Use these commands to :

•

	

Emphasize text by making it boldface, italic, outlined, underlined,
shadowed, or small caps .

•

	

Change the position of a character or characters (subscript or super-
script).

•

	

Change the font-there are several fonts available on the Word master
disk.

•

	

Change the size of the font .

Character formatting is saved when you save your document . Character
formats are also kept when you move or copy your formatted text into
other parts of the document.
When you type text at the insertion point, that text will look like the text
just before the insertion point-unless you change the format with a key
sequence. See the section on "Changing Characters With the Keyboard"
below.

The Character Menu Commands
The Character menu gives you two ways of formatting . When you want
to change the emphasis or position of text quickly, choose the appropriate
command from the menu. But if you want to make extensive changes, or
change several things at one time, use the Formats command .



When you pull
down the
Character menu :

Cha,e ter

When you format characters
a check (v'J appears next to
/he command you used.

PREPARING A HOME FOR

PREPARING A HOME F

iii;

PREPARING A HOME FOR SALE

VFEPrPI!if, A HIJt1E FOR SALE .

PREPARING A HOME FOR SALE .

Plain tear
Bold
I ~Blir

	

These commands' control
Underline

	

the density, shape, and
Owtflfw@

	

emphasis' of characters.
OdOdO©
Small C aps

	

- These commands control
"S u p e r s c rI p

	

tht eposy/ion of characters .
Subscript

Formats . . .

	

things, plus font and

~rmat

a

	

fonts/ze.

Formatting Your Work

P/a/n text d/ plays
text without any character
formatting. This command
also erases character formatting .

Formats controls all these
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To change the
appearance of
characters :

0 Select the text you want to change .
Choose the format you want from the menu :

Pain /ex/

Bold

1
Formats: Font
changed to Monaco

Formats: Size changed fo /gpf.

Note that you can change font and font size, as well as character emphasis
and position, with the Formats command . Details for changing the font
and size are given below .

When you choose commands from the menu, you can add new formats to
previous ones . For example, if you choose Bold, then Italic, the resulting
characters will be boldface and italic . But if you choose a command that
is already checked, this will remove that character format . For example, if
Bold is checked on the menu, then choosing Bold again cancels the format .

_∎

	

charformat

PREPARING A HOME FOR SALE .

`PREPARING A HOME FOR SALE .

PREPARING A HOME FOR SALE .

	

Underline

b~IIll~ F'~F:

	

Dufline

1 . : g

	

Shadow

PREPARING A HOME FOq SALE .

	

Small Caps

PREPARING R NOME FOR SALE .

(PREPARING
A HOME FOR SALE .

0

9



To change character
position :

0
B

Superscript raises the selected characters above the baseline of the text. The
super eripted characters are reduced in size.

11

Select the text to be changed .
Choose Superscript or Subscript from the Character menu .

2

(a +t,)/tab

CH 3 --CH 2 --CH 2 --S--CH 2 --CH2--CH--COON

PRnP t
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supersub	

~'ub~cript lowers the selected characters below the baseline of the text. The
~ubscripted characters are reduced in size .

To change

	

The font is the design of the alphabet in which text is displayed or
the font :

	

printed . The font is preset to 12-point New York ; you can change it to
any of the fonts available on the Word master disk . These fonts may vary,
depending on which version of the Macintosh system you have .
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A Choose the Formats command on the Character menu . You will see
this dialog box :

A Same as Character menu commands. If you want to add or
remove several formats at once, if is easier to click here .

8 Click on the style name to toggle the format on and off

OKCharacter Formats
r Style	

A OBold
Italic B

LI Underline

	

-Position
0 Small Craps

	

® Normal
LI Outline

	

0 Superscript
fl Shadow

	

C) Subscript

CFont Name .

Font
Size :

Chicago
New York
Geneva
Monaco

∎

∎

9
10

14

Cancel

12

C Available fonts scroll to see the entire list.

Choose a font; click the OK button .

To change the

	

You can make your characters larger or smaller with the Formats corn-
font size :

	

mand. For example, you might want to make the title of a document
larger. In Word, character size is measured in points and picas (the stan-
dard measure for typesetters and printers) . A pica is equal to 1/6 of an
inch. A point is equal to 1/12 of a pica, or 1/72 of an inch .



A

A

Choose the Formats command on the Character menu .

The right side of the list box show
sizes available with each font .
As you move from font fo font,
sizes available will change .
Click fo select a size . . .

	

OR

Character Formats
Style	i
C Bold

	

Cancel 1
n Italic
C Underline

	

-Position
fl Small Caps

	

Normal
Outline

	

C) Superscript
Shadow

Font Name :

Formatting Your Work

New York ∎

∎

Font
0 I Size :

12

Chicago

Geneva
Moneco

C Subscript

type here fo specify a font size .

In the lower part of the dialog box a list box displays the names and
sizes of the fonts available with the system on the Word master disk.
To the right of the list box is a text box labeled "Font Size :" You can
specify any size in this box . If you specify a size that is not available
for a particular font, Word produces the size as closely as possible .
(The results may look ragged .)
Select any other formats you wish to change ; then click the OK
button.

Any character formatting that has been applied to the selection is reflect-
ed in the Formats dialog box . For example, if your selection is New York
Bold, the Bold box will be checked, and New York will be selected in the
list box .
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To make several
changes at once:

However, if your text selection contains two or more different formats, all
"Style" check boxes will be gray. The style of the characters in the selec-
tion will not be affected when you click OK, unless you click one of the
styles on or off.

r

Chicago
New York
Geneva
Monaco

OKCharacter Formats
-Style	

0 Bold

0 Italic
Q Underline

	

Posjtion

0 Small Caps

	

0 Normal
J Outline

	

0 Superscript
0 Shadow

	

0 Subscript
R	

Font Name :

Cancel

Font
Size :

The Formats command lets you make several changes all in one step .



Click fo salad
the forma/
fan X appears
in the box) .

Click again fo
remove the
formal.

Character Formats
Style	

Bold

0 Italic

0 Underline

	

-Position
® Small Caps

	

® Normal
fl Outline

	

0 Superscript
O Shadow

	

Q Subscript

Font Name :

Chicago
New York
Geneva
Monat 0

∎

11

12

Select new fonts and
font 'izes from the
list box . .

	

.

. . . or type the size
in the "Foci f Size: "
/ex/ box.

Formatting Your Work

Click OK when
OK

	

you have
chosen allyour
formats .Cancel

Font
Size :

If there are fonts on your copy of the Word disk that you never use, you
can delete them or move them to another disk . See "Appendix C, Disk
Space and Memory," for more information .

If you are working with several fonts and sizes, and the Word program
seems to run slowly, you can use the "Screen Draft" option of the Prefer-
ences command to make the program run faster . "Screen Draft" affects
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To copy character
formats:

characters in large font sizes only . It draws those characters on the
screen with less precision, but does not affect the printed document .

Choose /he Preferences command from the Ed// menu .

Click ' S'ereen Draft. " Then click OK.

Preferences
-Measure ,
() Inch
0 Cm.
oPlo
(j P12
0 Points

OK

Cancel

Screen Draft

©Display as Printed

You can also copy the formats of characters to other characters . (This ap-
plies to font and font size as well .)

Select the text that you want to format .
Position the mouse pointer on the text that already has the desired
format.
Hold down the Option and Command keys and press the mouse but-
ton. When you release the mouse button and the keys, the selected
text looks like the formatted text .

A

A



This format (/4poiti/ Bo//J).

was copied fo the selection using the moue .

F

	

raph Document

iou CAN UNDERSTAN

0		 02

Page i

Gt1orPd ~ U gooG3ooUt
11950 16th A

	

Seatt1e_ WA 981 12

IPREPAR G A HOME FOR SALE

~c snowing a nome ran 1G' oe=r au singe
:A . e quickly and at a better price . Here are

some tested tips to set the stage for a profitable and early sale .

First impressions are important You should keep the lawn trimmed
and edged, cultivate flower beds, and remove all refuse or clutter
from the yard, sidewalk, and porches

Fix up inside . Badly faded walls or worn woodwork reduce appeal .
Selective painting will help you add a fresh look . Clean windows and
unmarred walls will create a brl h cheer a . .earance

a

Changing Characters With the Keyboard
You can change the format of characters with key combinations, as an al-
ternative to using the Character menu commands . This is useful if you are
entering text and want to keep your hands on the keyboard .

A

Formatting Your Work

When you are ready to change the character format, press the desired
key sequence .
Type the text you want to emphasize .
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To change
the font :

To get this format. . .

Font Size

Superscript

Subscript

Italic

Bold

Underline

Shadow

Outline

Small Caps

Plain text

Pressing Command-Shift-spacebar does not affect the font .

For a complete list of formatting keys, see "Appendix A, Key Sequences ."

D Press Command-Shift-E, then a number :

o = Chicago
1 = New York
2 = Geneva
3 = Monaco
4 = Dover
5 = Dover PS

Press these keys :

Command-Shift- < makes text
the next font size smaller .

Command-Shift- > makes text
the next font size larger .

Command-Shift- _ (equal sign)

Command-Shift-(hyphen)

Command-Shift-I

Command-Shift-B

Command-Shift-U

Command-Shift-S

Command-Shift-D

Command-Shift-K

Command-Shift-spacebar

Fonts available on the Word disk may vary .



Formatting Paragraphs

You are familiar with paragraphs-blocks of text set apart from the text
before and after by a line space or by a first line indent . In Word, a para-
graph consists of the characters you type and the formatting you assign
before you press the Return key, plus the paragraph mark inserted by the
Return key .
The paragraph mark is normally invisible. You can select, delete, copy, or
display it by choosing the Show ¶ command from the Edit menu .

A paragraph can be as long or as short as you want . For example, the title
of your document is usually a paragraph . Start a new paragraph when you
want to :

•

	

Make a paragraph break in the text
•

	

Create a heading for your document
•

	

Split a paragraph in two
•

	

Change the alignment, line spacing, or indentation of part of the
document

•

	

Change your tab settings in part of the document

Formatting Your Work
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To break a
paragraph into
two :

To join two
paragraphs :

0

The S'how (J command on the
Ed/

menu was used /o display
/he

eharaeter. (This step / optional.)

The Return key was pressed here .

A

Move the insertion point to where you want to break the paragraph .
Press the Return key .

F

concentrate . on major • considera.ta

	

Loose door knobs and sticking
drawers or doors can distract the

	

as well .1

You should pay • special attention • to tw

	

hen when preparing the
home for sale Shining ovens, ranges,

	

pvlia.nces • will catch the
buyer's •eye and make a good impressi,_ <I

IKeeping the counters and sink cleared • and neat makes the kitchen
look spacious . Colorful curtains in •harmony with the counter tops and
floors •add • appeal as • well .l

bathrooms that sparkle can be a real plus You should check and
~n~ififa_rhcrlr them Q

bedrooms are important fecal poin

	

ne eiior
to keep them neatly arranged I

This text became a separate paragraph .

You may find it easier if you display the paragraph mark, although it is
not required. To display the paragraph mark, choose the Show ¶ com-
mand from the Edit menu .
Select the paragraph mark of the first paragraph . Choose Clear from
the Edit menu or use the Backspace key to delete it . (Use the Cut
command if you want to delete to the Clipboard .)
OR



v

Place the insertion point at the first line of the second paragraph, and
backspace. (Backspace twice if you used the Return key to open
space between the paragraphs .)

concentrate on major considerations Loose
drawers or doors can distract the buyer as

Formatting Your Work

The J is delefed fojoin paragraphs.

memo2	

t

knobs ands .. ;king

You • should • pay •special attention to the kite n when • preparing the
home for sale . Shining ovens, ranges, and ppliances •will catch the
buyer s • eye and •make •a •good •impression . eeping the • counters and
sink • cleared •and neat makes the kitchen •look spacious . • Colorful
curtains in harmony • with the counter • tops and floors add • appeal as
well .

Bathrooms that sparkle can be a real plus . You should check and
.Jou.ble-check them

Bedrooms are important focal points You will find it worth tfhe € 'rt
to keep them neatly arranged i

Closets look larger when clothes are properly hung and shoes, hats

Paragraph formatting is saved with your document . Paragraph formatting
is also kept when you copy or move your formatted text to another loca-
tion, as long as you move or copy the paragraph mark with the text .

Margins are part of the page format, and can be changed with the Page
Setup command in the File menu. See Chapter 9, "Printing Documents"
for more information; also see "Appendix B, Preset Options and Formats ."

The Paragraph Menu Commands
The Paragraph menu commands give you more control and flexibility in
designing your documents. The Paragraph menu commands control line
spacing, indentation, alignment of text, and tabs .

The Paragraph menu gives you three ways of formatting . When you want
to change the alignment or line spacing of a paragraph quickly, choose a
command from the menu . If you want to change indentation, or make
several changes at once, use the Formats command . You can also change
indents and tabs on the ruler, which appears at the top of the screen
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When you pull
down the
Paragraph
menu :

when you choose the Formats command (or the Show Ruler command on
the Edit menu) .

Whenever you use a command on the Paragraph menu, make sure the
insertion point or selection is in the paragraph (or paragraphs) you want
to change .

See "Setting Tabs" in this chapter for more information on how to set tabs
and use the ruler .

A IUorma/restores left alignment and jingle spacing .
It doesn "t affect tabs .

8 These eommand affect alignment of text on the margin.

Attics, basements, and garages are it
unnecessary clutter which may have
value ci storage and utility space .
Attics, basements, arid garages are ir
unnecessary clutter which may have
value of storage arid utility space .
Attics, basements, and garages are it
unnecessary clutter rich may have
value of storage and utility space
Attics, basements, and garages are it
unnecessary clutter which may have
value of storage and utility -,t~Ctce

Paragraph'..

deft a
Centered
Right
Justified

/Single Space
Double Space
Open Space

C These commands affect spacing between lines andparagraphs .

D Formats con /,'o/ indentation, as well as alignment and line spacing.
A ruler is displayed when you choose Formats.

E Tabs allows you to set tab stops.
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Choose one of these commands from the menu : You can also use the
Formats command on the Paragraph menu to change alignment .

When you select two or more paragraphs that do not have the same
formats, a check does not appear on the menu ; when you choose the
Formats command, none of the formats are reflected in the dialog
box.

A The Normal command restores left alignment.

B The Left command align' a paragraph flush left on the margin .

C The Centered command centers the paragraph .

peroformets
ii

	

8

	

gyres . By removing
•

	

s ary clutter which may have accumulated, you will display the full
tTalue of storage and utility space

C

	

tics, basements, and garages are important features By removing
cessary clutter which may have accumulated, you will display the full

value of storage and utility space .

17 ttacs, basements, and garages are important features . By removing
sary clutter which may have accumulated, you will display the full

value of storage and utility space

E attics, basements, and garages are important features . By removing
nnecessary clutter which may have accumulated, you will display the full

value of storage and utility space .

D The Right command align' the paragraph flush right on the margin .

E The Justified commandjusfifies the paragraph by ad u'ting spaces
'o that the text /ills the line to both margin' .
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To change line
spacing:

D Choose one of the following commands to change line spacing :

Single apace restores your
paragraph to single spacing. Use this
command to go back to single spacing
without losing your indents.

unnecessary clutter which may ha

a,ttlcs, basements, and garages are
unnecessary clutter which may ha

	

711 display the full
value of storage and utility space
0

Page 1

Open Space adds a line space above the paragraph containing the selection
or insertion point.

You can use the Formats command to set single, double, and open spac-
ing; to specify space before or after a paragraph ; and to set a fixed line
height.

Double apace adds an extra space
between each line in the paragraph .

Paragraph•

/left
Centered
Right
Justified

/Single Spoce

	

111 - 1u 11i full

Double Spece
/Open Spece

y removing
ill disolav the full

y 1 C111V Y 111
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Select the text you want to indent .

Choose the Formats command from the Paragraph menu . You will

see this dialog box :

46 file Edit Search Lharacter raragrapn Document

Bedrooms are important focal points . The seller will find it . ,,

to kee them neatl arran ed

Stairways cleared o . < hits and obstacles sake i easier !Tar r

t ( .- +

Paragraph Formats

unnece~

full vale

A Type a number fo indent /ex/ From the left margin .

B Type a number fo indent the first line of the paragraph

from the left margin .

C Type a number fo indent /ex/ from the right margin .

to th effort.

Left Indent : 0" A Line Spacing : auto

CoK
First line : 0" B Space Before : 1 Ii

Cancel

Right Indent : o° c Space lifter: o IiD

0 Left

	

Right pKeep with neat Si

0 Centered 0 Justified EKeep lines together



18

Using Word

10

You can indent the first line of the paragraph in two ways :

Click end drag
fhe indenf marker wifh /he mouse . . . OR . . . fype fhe posifion here .

w t

	

seat ci ~

	

tidrat. tat

	

rat dyr +

	

J,tIeIu

Jc'.L1l YY

f!)11 i" t .}1

i

	

a a ''-

	

p.ii, nnere~

12

Left Indent : 0

First Line :

Right Indent :

0 .4'

0"

0 left

	

0 Right

0 Centered C Justified

line Spacing :

Space Before :

Space After :

auto

1 Ii

Oil

15

Cancel

0 Keep with neHt 91
OKeep lines together

I



11 When you click the OK button, your indents are set .

Untitled	

Formatting Your Work

Bedrooms are irnuortant focal Uoints . The seller will find it worth the effort

li'~r~t''- lr)''1' 1r~+I' Ee .,'hE?n

	

)t.hes are .rc :'erlV huitig, ,ati~:i shiie'=:, lint :. . an .:l

3rti' l~'= • :ir~ all in :!lace

Stairways cleared of objects and obstacles make it. easier for prospects to

tour the home .

Attics, basements, and garages are important features . By removing

unnecessary clutter which may have accumulated, the seller will display the

full value of storage and utility space .

Schedule showings that are convenient so that the home will be presented at

its best . Personal and family privacy should be respected

0

~Pege i

You can indent text from the left margin or from the right margin the

same way by dragging the triangular markers instead .

You can also set indents on the ruler with the Show Ruler command on

the Edit menu. See the section below on "Using the Ruler to Indent" for

information on displaying and working with the ruler .

Word uses inches as the preset unit of measure . If you occasionally want

to use another unit of measure (centimeters, points, ten pitch, or twelve

pitch), use the Formats command and type the number and the unit in the

text box for left, right, or first line indent . If you want to change the unit

for every measurement in your documents, use the Preferences command

on the Edit menu. See "A Note About Measurements" below for informa-

tion on changing the preset unit of measure .
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To change line
spacing with
Formats :

A
8

Select the text that you want to change the spacing for .
Choose Formats from the Paragraph menu .
Choose any of these spacing options :

A 'Auto means /ha/ Word adju / sparing between lines aulomalically .
Type a number if you wan/ to specify a fixed line height .

B Inset/ exlra space above a paragraph .

Paragraph Formats
left Indent :

First line :

Right Indent :

0"

0"

o"

® left

	

Q Right
Q Centered 0 Justified

Line Spacing :

Space Before :

Space fitter :

BUfOL~

dli B
C Cancel

G 0 Keep with next 91

E fl Keep lines together

C lnser/ extra space below a paragraph .

D Click to keep se/esledparagraph plus the following
paragraph loge/her on a page.

E Click to keep selecled lines loge/her on a page .

Click the OK button .

If you don't specify a unit of measure, Word uses inches for indents and
lines for line spacing. Word adjusts line height automatically . You can
specify a fixed line height in the "Line Spacing :" text box . See "A Note
About Measurements" below for more information .
Use the "Keep lines together" option when you have two or more lines
that you want to keep together on a page . Use the "Keep with next ¶"
option when you have two or more paragraphs that you want to keep
together on a page-for example, a table with the text explaining it, or
questions with answers .



To change from one
format to another :

To copy paragraph
formats :

0

Type your changes fo indenf~ and spacing in me /ex/ boxes .

Left Indent :

ii s C i.lfl%

	

.

Right Indent :10°

A

Choose Normal from the Paragraph menu to restore text to single
spaced, left aligned, unjustified, with no indents .

OR
Choose Formats from the Paragraph menu .

left

	

Right
(.ii Centered y Justified

nice After :

Click any of /he alignmenf bu//ons .

Oil

C Keep with neet

fl Keep lines together

Formatting Your Work

Click OK

You can also copy the formatting of one paragraph to another paragraph .

Make sure the paragraph you want to format contains the insertion
point; or select the paragraph you want to format .
Position the mouse in the selection bar next to the paragraph that al-
ready has the desired formatting .

© Hold down the Option and Command keys while clicking the mouse
button.
Release the keys and the mouse button . The selected text will look
like the formatted text .
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Using the Ruler to Indent
You can also use the ruler to set indents for your text . The left and right
indent markers are the triangles at the left and right ends of the ruler .
(The left indent marker is partially obscured by the first line indent
marker.)

To display the ruler : Choose one of these commands :

•

	

The Formats command from the Paragraph menu .
•

	

The Show Ruler command from the Edit menu .

Ruler

1419 1 3th E .
Bellevue, WA 98004

Dar Mr ~mitfl

Thank you for listing your home with Murphy & Allen . We hope that you
will find this a pleasant and profitable experience

There are many simple, inexpensive things you can do to enhance the
appearance and the worth of your home Here is a list of suggestions that we
have found helpful in making sure a home is at its best during showings .

First impressions are important You should keep the lawn trirnmed
and edged, cultivate flower beds, and remove all refuse or clutter
from the yard, sidewalk and porches .

Indent marker

10	11	12	,	13	,	14	15	



To set or change
indents:

0

Left indent marker

Frsf line indent marker

Click and drag indent markers with the mouse.

Right indent marker

earcn inaracter raragrapn uocumeni

N

ii

Select the text you wish to indent or change .
Display the ruler as described above.

141y 1 UL

Bellevue, WA 98004

Dear Mr . into.

12
Inttnr )	

13

Formatting Your Work

14 15

Thank you for listing your h{:~ms with Murphy & All .
„~ u Y'ill find til r

	

asant and' profitable e • .rtene.
io a that

There a many simp1 , fines ns1ve things OU can do to enhance the
r'r' ~'ran Y , =thA T (brtri f your homy Harp

	

1i~t of cuggesti,"ins that. We
li_iV? fund h€1 fvl in rnaltim pure . a hOrne it at its best c1»nn~ showm s

Page

First impressions are important You should keep the lawn trimmed
and edged, cultivate flower beds, and remove all refuse or clutter
from the yard, sidewalk and porches .

In this example, the Show Ruler command was used.

Click on one or both of the triangular indent markers at the left and
right ends of the ruler, and drag them to the desired position . (If you
are using the Formats command, the position in inches is reflected in
the dialog box .)
Drag the small square marker to change the first line indent .

When you release the mouse button, your indents are set. You can use
this technique for moving them again .
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To change the
format as
you type :

You also use the ruler to set tabs . For details, see the section in this
chapter on "Setting Tabs ."

Formatting Paragraphs With the Keyboard
You can also use the keyboard to change paragraph spacing and alignment,
as an alternative to choosing commands from the menu .

i After pressing the Return key, press the desired key sequence .
(1 Type the text of the paragraph.

If you apply these formats to a paragraph that you have already typed,
make sure the selection or insertion point is in the paragraph .

To get this format . . .
Erase paragraph formats

Left aligned

Right aligned

Centered

Justified

Open space

Indent first line .5"

Press these keys :
Command-Shift-P (normal)

Command-Shift-L

Command-Shift-R

Command-Shift-C

Command-Shift -J

Command-Shift-0

Command-Shift-F

For a complete list of paragraph formatting keys, see "Appendix A,
Key Sequences ."



You can also "nest" paragraphs-that is, indent them one-half inch from
the previous paragraph, no matter what the indent of the previous para-
graph is. You might do this to indent several paragraphs by increasing
amounts, or if you want to set only one paragraph apart for emphasis
without changing any other indents .

Press Command Shift-n fo ' riesf these paragraphs.

JRPtge
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a1 points . inn seller wn r linci it worm cne abort

':Insets look larger when cl ,'~thAc

	

~~rl'r hlln i :in 1 Eli :~ :r,1' t -.,
tid ot.hE r articles are all in

	

-

tairwa;rs cleared of ob ect arid obstacles rnal: it easier f',r

	

, t~
t,:,qtr t.li h . : . me

Attics, basements, and garages are important features . By removing
unnecessary clutter which may have accumulated, the seller will display the
full value of storage and utility space .

its best. Personal and family privacy should be respected .
0

Preys Command S'hiff-m fo reverse nesting.
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To create a

	

You can create a hanging indent as well . The selected line or lines, usual-
hanging indent:

	

ly at the beginning of the paragraph, will extend further to the left than
the rest of the paragraph .

peraformets2	
∎

Bedrooms are important focal point, The seller will find it worth the effort
to keep them neatly arranged

Closets look larger when clothes are properly hung arid shoes, hats,
arid other articles are all in place

Stairways cleared of objects and obstacles make it easier for prospects
to tour the home

Attics, basements, arid garages are important features By removing ;
unnecessary clutter which may have accumulated, the seller will display the
full value of storage and utilit .v svace

Schedule showings that are convenient so that the home will be presented at .
its best. Personal and family privacy should be respected

Press CommandShift-/ to indent all but the first line of the paragraph .
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A Note About Measurements
When you are specifying a measurement for indentation or line spacing, it
is a good idea to specify the unit of measure you want also . Word as-
sumes that horizontal measurements (for indents) will be in inches ; and
vertical measurements (line spacing) will be in lines .

You can change the preset horizontal unit of measure with the Prefer-
ences command from the Edit menu .
Word adjusts line spacing automatically for you . A line is usually 12
points in height (1 point = 1/72 inch) ; but if the line contains text that is
14 points high, Word automatically adds the extra space above the line .
Most of the time this will be convenient for you .

You may want to specify fixed spacing for a line, however . Choose the
Formats command; then type the measurement and unit of measure in the
"Line Spacing:" text box .

You can also specify extra space before and after a paragraph using the
"Space Before :" and "Space After:" text boxes. Space between paragraphs
is the sum of the space before one paragraph and the space after the pre-
vious paragraph . Keep this in mind when you change spacing with the
Formats command.



Using Word

To change the
preset
unit of measure :

A Choose the Preferences command from the Edit menu . You will see
this dialog box :

Cenlimefers

l0 p//oh

l2piloh

Prose/ unit of measure

references
Measure -

Inch
Cm.

)P10
P12
Points

(/ l 72/1-10/7)

Click to select any of these units of measure . Then click the OK
button .

CaCancel

The preset units of measure for Formats and Tabs (on the Paragraph
menu), for Division Layout on the Document menu, and for Page Setup on
the File menu will be changed to the new unit . Measurements you
specify will be displayed in the new unit of measure . Word saves the
Preferences settings from one session to the next and will apply the set-
tings to all documents .

Display as Printed

Click for lowor
qualify, faster

display.
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You can easily set tabs for lists or tables with Word. You display the ruler
with the Tabs command on the Paragraph menu, or the Show Ruler com-
mand on the Edit menu . Then you click with the mouse at the position
on the ruler where you want to set the tab . This position is called the tab
stop .

You can set one tab-or as many as you want . You can choose the kind
of tab you want :

•

	

Left aligned, right aligned, centered, or aligned on the decimal
•

	

Blank, period, hyphen, or underline as leader character . The leader
character fills the area between text and tab stops .

When you display the ruler, you see up to 6 inches of text. Indents and
tab stops appear just below the inch marks . Tab stops are preset at every
half inch ; preset tab stops do not appear on the ruler . Tab stops that you
set override the preset tab stops .

If you want to see existing tab stops for text in your document, select the
text first, then display the ruler.
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To set tab stops: 0

A

If you are applying tabs to text already in the document, select the
text.
Choose the Tabs command from the Paragraph menu . You will see
the ruler and the Tabs dialog box .

Text is centered
on tab stop.

Text aligns
flush right
on tab stop .

Empty space
Text aligns flush

	

between text
left on tab stop.

	

and tab stops .

Tab	 Line ofperiods
between text

ignment

	

L ader_

	

OK ) -and/ab/ops.s
r ~ Left

	

®Blank
4.

	

Center

	

(1),,,,,,,,, -'Cancel

	

Hyphens
0 Right

	

0	Position ;

	

between text
y 0 Decimal

	

and lab Mops.

Decimal points ~'olid line between
align on tab

	

text and tab stops .
stop.

You can choose the sort of tab you want, and the leader character you
want to fill in between tabs .



Move the mouse pointer into the ruler, on the line below the inch
marks. Click where you want to set the tab stops. You can set as
many as you want .

R Fii e tuu ieurcn iviordrter

11

_Alignment

. ®Left
0Center

a

	

Right
Q Decimal

5-1 I'

^Leader,
® Blank

Click lo sef fib sfops on /he ruler.

rear our OLJII

Lancel1
I

~4.5'

Formatting Your Work

U

Tabs	

or fype number here .

Click the OK button. Your tabs are set ; just press the Tab key as you
type to align your text on the tab stops .

You can also use the Show Ruler command on the Edit menu to display
the ruler and to set tabs as described above. If you are using the Show
Ruler command, your tabs are set as soon as you click in the ruler .
If you want to set tab stops using units other than inches, choose the Tabs
command and follow the procedure above, but do not click on the ruler .
Instead, type the number and unit in the text box labeled "Position:" then
click OK. Repeat for each tab stop you want to set .

it

)wner

	

Phone No

'4C1fjO f,th Av
iOO
l~jlu t.ii1

'53

	

*,tt •t

.4 Ari ;;na >1vd : Ann t hjr
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To set multiple

	

Selecf fhe text.
tab stops :

Choose Tabs or
Show

Ruler.

Click on /he poi//on where you w~nf fo sef / b s/op .

To insert tabs in
unaligned text :

If you want some of your tabs to have a different alignment or leader char-
acter, just choose the Tabs command . Make sure the tab stop in the "Posi-
tion:" text box corresponds to the tab you want to be different . Make
your changes; set any additional tabs with the new alignment or leader .
Then click the OK button .

0

Ownei
®	 0
Phorir No

Alignment
.1® Left

C) Center
i. C) Right
C)Decimel

_leader
	, Blank1

0

Cancel

Position :

5 .3"

:2/14/84

l ; /' :. 't

r(l

Set your tab stops on the ruler as described above .
Click at each item in the document text that you want aligned on a
tab stop, and press the Tab key. Repeat for every item you want to
align on tabs .

Keep in mind that Word treats tabs as characters . If you press the Tab
key while text is selected, the tab will replace the selected text .



To move tab stops
on the ruler :

If your document already contains tabs, and you want to change them,
move the tab stops on the ruler .

Select the text to be realigned on the new tabs .
Choose Tabs from the Paragraph menu (or the Show Ruler command) .
The ruler appears showing the tab stops you set for the selected text
earlier .

0

E Click and drag the tab stops to the new positions .

Drag fib marker fo newpo~ifion . .

_Alignment

Center
i Q Right
C Decimal 0

a rile Lull ~ei ,

	

racier reragrepn uocumeni

Tabs
lender
	, Blanl

The text box refleefs the newposifion .

Position :

Formatting Your Work

. . end click OK.
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You can have any number of tables in a document with different tab set-
tings. You select the block of text that you wish tabs to apply to, and set
the tabs . Then select another block of text and set different tabs for that
section.

This line was not selected II aligns on /he previous tab .

Selected text aligns on new tab pfop.

	13	j	14	15
1	

Phi n~ No

°RA - lii lu

122-r77 7
555-1212

Listed

.-1j t)i .) ij 1 'ith Ave

11111! l C..rr .t .

W. Foota
Alice $ret'i
Gea: rge tTI t:;?r,!

Art, Amher t
Ann !Aur .1i'r

4r~2i Q~~



To delete tab stops : A

A

Choose Tabs from the Paragraph menu (or Show Ruler from the Edit
menu).
Move the mouse pointer into the ruler, and drag the tab stops from
the ruler into the text area . When you release the mouse button, the
tab stops will disappear .

Drag tab stop down from ruler to delete .

The Show Ruler command was used for this example .
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In this chapter :

8 Working With
Complex Documents

This chapter tells you how to create longer, more complex documents
with varying layouts, footnotes, and running heads ("headers" and
"footers") . Word lets you vary the format in parts of your document by
creating "divisions" within it. You can have automatically numbered pages,
or any sort of page number format you want . Word also sets up footnotes
and running heads in just a few easy steps . And you can position these
elements of your document almost anywhere you want .

•

	

Parts of a document: an overview
•

	

Divisions
•

	

Footnotes
•

	

Running heads
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Parts of a Document:
An Overview

A document consists of text and any emphasis (format) you assign to that
text. A document can he any size, one word long or fifty pages long . A
document can also have one format, or many .

When you format any part of your text . Word makes your design part of
the document. You won't see the special codes on the screen ; you see
the result. Word saves formatting information with the document .

Word has certain preset formats . Some of them are shown in the figure
below. Most of the time the preset formats will he satisfactory for your
documents. But you can change them whenever you wish . See "Appen-
dix B, Preset Options and Formats," for a complete list of preset formats
and options .



Running Head

	

Page number: Automatic numbering,
At top, odd & even pages

	

Arabic numbers
•

	

75" from top ofpage 725" from left
•

	

5" from left .75" from top ofpage
Continuous numbering

(Tex/ can be indented from margin)

Footnotes Automatically numbered footnotes
Footnotes on same page

When you work with long or complex documents, you can use the Docu-
ment menu commands to create footnotes and running heads and to con-
trol page layout.

Tabs every
5" (left aligned)

> Page Setup :
Letter size:lgJ4„ by II')

Printed lengthwise

Complex Documents

Paragraph:
Single spaced
Left aligned

IUo indent

•

	

Margin:
•

	

'"'op
& bottom,
1 .25" left & right
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If you want to . . .

	

Use this command:

Specify a type of page number

	

Division Layout

Position page numbers

Position running heads

Position footnotes

Vary format within a document

Print text in more than one column

Create footnotes

	

Footnote

Create running heads

	

Running Head

Repaginate a document that was

	

Repaginate
printed then edited again

Margins
Margins are the minimum amount of space between the edges of the pa-
per and where the text begins (not including any indents you may speci-
fy). In addition to the top, bottom, and side margins, you can specify a
gutter margin to allow extra space for binding on the left side of odd
pages and the right side of even pages .

If you want to change the preset margins, use the Page Setup command on
the File menu. Changes to margins affect text only, and not the positions
of running heads and automatic page numbers .

See Chapter 9, "Printing Documents" for more information about margins .
Also see the Page Setup command in Chapter 11, "Commands."



Divisions

Complex Documents

A division consists of pages that have a single design or layout . Most
documents you write will have only one division-that is, one format
throughout the document. But occasionally you may have sections of
your document that require very different page formats. For example, you
may want your index to look different from the main portion of your
document. When you want to change any part of your page layout, you
should begin a new division .

In most cases, starting or changing a division does not affect what you see
on your screen, except that you see a line of colons where the new divi-
sion begins .

A division can be one page long, or as many pages long as you like. You
can have as many divisions as you want in a document . Create a new divi-
sion when you want to :

•

	

Change the page number style (to Roman numerals, for instance)
•

	

Change the position of the page number
•

	

Change the page numbering sequence
•

	

Change the arrangement or size of columns on a page
•

	

Change the position of a running head
•

	

Change footnote numbering, or placement of the footnote
•

	

Change the way the division breaks the page

For example, if you want to change the position of the page number for
the entire document, you do not need to create a new division . But if
you want to put the page number at the top of the page for the first five
pages of the document, and on the bottom for the remaining ten pages,
you should start a new division .

A division break usually starts a new page, unless you specify otherwise in
the "Break" section of the Division Layout command on the Document
menu .
When you change any of the settings for a division, make sure the selec-
tion or insertion point is in that division .
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To create a
division :

0

=u

Select the location where the new division will start .
Hold down the Command key and press the Enter key . A line of
colons appears across your page on the screen . This marks the end of
the old division. Any text that appears (or that you type) below the
division mark will be in the new division .

home . It is designed to help you become aware of the f

	

ou need to
consider in settling on a price and in dealing with buyer

	

discussion is
very general, please feel free to call us if you have any

	

^r

we nope tnis will oe a pleasant ana proiitaale experiE

	

you ana your
family . Thank you for your confidence in us, we are 1

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

= Appraising a Home

The sale of a home represents
liquida.taon of a major asset for
most people I t implies that some
other significant change has taken
place, or will take place--a job

P1 D1

Di'/ oti mark

Page I, Division I . This reflects the position of the insertion point or
selection .

The division mark stores the division formats for the text before it . The
division mark can be copied, cut, and pasted like any other character .

You can also create a division mark by choosing the Division Layout com-
mand. When you click OK, Word inserts the division mark at the inser-
tion point .



To number pages
automatically :

Page Numbering
With Word you control the page numbering you want, and where the
page numbers will appear . You can vary the page numbering sequence
from division to division, if you wish .

You need to specify that Word automatically number pages as it prints,
otherwise Word will not print page numbers . When you print or
repaginate, the page numbers in the page status area of the window reflect
the correct pagination .

Division layoff

_Break
OContinuous
O Column
® Page

O Odd
0Even

-i uyr i~uinuci r ul 1110

® Numeric
O Roman (upper)
oRoman (lower)

0 Alphabetic (upper)
oAlphabetic (lower)

f

Choose Division Layout.

Click 'Auto Page Numbering,'

® On Same Pag
1) At End of Div

From Top :

From Bottom :

Number of Columns :

)lump Spacing :

Complex Documents

0 .I

1
0 .5'

I

then click OK.
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To choose page

	

If you do not want automatically numbered pages, you can specify the
number format:

	

type of page number you want-numeric, Roman, or alphabetic-with the
Division Layout command .

C Choose the Division Layout command from the Document menu .
Click "Auto Page Numbering.

© Click one of the options in "Page Number Format ."

Presef forma/: 1, 2, 3, 4 . . .
I, II, III, IV . .

	

.

Division layoff

_Break

C) Continuous
C) Column
C) Page
Q Odd

o Even
0

m~ is
an (u

may lower)

A

	

abetic (upper)
Alphabetic (lower)

P g Nu

0 er)

Click the OK button .

Page numbers displayed in the lower left corner of the window are always
numeric, no matter what page number format you choose .

er for
OK

r	
f Anral

.Footnotes Appear

® On Same Page

C) At End of Division

® Ruth Page Numbering : Running Heod Position :

From Top : 0 .75" From Top : 0 .75"

From left : 7 .25" From Bottom : 0 .75"

Start Page Numbers At : Number of Columns : 1

Column Spacing : 0 .5"



To change page
number position:

To change page
numbering
sequence :

0 Choose the Division Layout command.

Division layout
Break
o Continuous

o Column
®Page
Q Odd

Even

A®Auto Pege Numbering :

From Top :

From Left :

Start Page Numbers At :

_Page Number Formal
ti Numeric:

o Roman (upper)
O Roman (lower)

O Alphabetic (upper)

O Alphabetic (lower)

0 .75" B 1
7,25" C

_Footnotes Appear
®On Same Page
1) At End of Division

rom Top :

)lump Spacing :

Complex Documents

D OK

0 .75"

0 .75"

0 .5"

A Ifyou want auloma/ c page C . . . or from the left edge of the
numbering, click here .

	

page . . .

B Type a number to specify a D . . . then click OKK
poi// on from the lop edge
of the page . .

	

.

Make sure that you do not position the page number and the running
head in the same place . Otherwise, Word prints the running head and
does not print the page number . See the section on "Running Heads" in
this chapter for details on embedding a page number in the running head .
Word assumes the unit to be inches, unless you specify otherwise by typ-
ing a different unit of measure, or by changing the unit of measure with
the Preferences command .

Word assumes that page numbering will be continuous . You can change
this setting to start at any page number you want at the division break .
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To print your
document in
columns:

A

Division ~ayo~

_Break

o Continuous

o Column
(I) Page
Q Odd

o Even

_Page Number Forma

Numericc

o Roman (upper)
O Roman (lower)

O Alphabetic (upper)

O Alphabetic (lower)

0.75"

7,25"

Start Page Numbers At :

QOK D

On Same Pag

C) At End of Diu

® Auto Page Numbering : nn~rq Head Position

From Top :

From left :

:f1iC7%'t iii LiJIUi~ItiS .

;lump Spacing :

Choose Division Layout.

Type the page number that will sfarf the new division here . .

0 .71

then click OK.

Printing in Columns
Most documents are printed in one column that extends the entire width
of the page . ( In Word, this is the preset format . ) Occasionally, you may
want to print your document in two columns-for example, you can
create and format a two-column brochure . To print a document in two or
more columns, you can use the Division Layout command .

When you change the layout to print more than one column, your text ap-
pears on the screen in one narrow column only . Line breaks will be accu-
rate, but you will need to scroll to see the rest of the text. Word does
not display column breaks . When you print the document, it will be
printed in the number of columns you specified . (You may find that
Word takes longer to print in a multi-column format .)

Use the "Number of Columns:" text box to specify the number of
columns you want .
Type a measurement in the "Column Spacing:" text box to specify the
space between columns.



Division tayou

_Break	

O Continuous
oColumn
®Page
O Odd

Q [yen

E Auto Page Numbering :

From Top :

From Left :

Start Page Numbers At :

®Numeric
O Roman (upper)
oRoman (lower)
O Alphabetic (upper)
Q Alphabetic (lower)

0.75"

7 .25"

Preparing a Home for Sale

You can understand that showing a
home to its best advantage makes
the buyer want to purchase
quickly and at a better price . Here
are some tested tips to set the
stage for a profitable and early
sale .

First impressions are important.
You should keep the lawn trimmed
and edged, cultivate flower beds,
and remove all refuse or clutter
from the yard, sidewalk, and
porches .

Fu up inside . Badly faded walls or
worn woodwork reduce appeal .
Selective painting will help you
add a fresh look . Clean windows
and unmarred walls will create a
bright, cheery appearance .

®On Same Pai

0 At End of Dii

Running Head Positic

From Top :

	

0.7

Number of Columns :

Complex Documents

Choose Division Layout, then type the number
of columns you want on the page .

Specify space between columns . . . /hen click OK.

. . . . . . . . .. .. . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . .. . .. . .. . . . . . . . . . . . . . .. .. . .. . . . . . .. . . . .. . .. . . . . . . . . . . . . .. . . . . . . . . . . . . .

the buyer's eye and make a good
impression. Keeping the counters
and sink cleared and neat makes
the kitchen look spacious. Colorful
curtains in harmony with the
counter tops and floors add appeal
as well .

Bathrooms that sparkle can be a
real plus. You should check and
double-check them .

Bedrooms are important focal
points . You will find it worth the
effort to keep them neatly
arranged .

Closets look larger when clothes
are properly hung and shoes, hats,
and other articles are all in place .

Stairways cleared of objects and
obstacles make It easier for
prospects to tour the home .
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More on Division Layout
There are three other sections in the Division Layout command : "Break",
"Footnotes Appear" and "Running Head Position ."

See the next section in this chapter, "Footnotes," for details on specifying
where footnotes will appear . See the section in this chapter on "Running
Heads" for information about specifying running head position .

The "Break" options change the way page breaks occur when you start a
new division . The preset option is "Page" ; this will probably be the best
choice for most of your work . "Page" starts a new division format on the
next page, and the division mark forces a page break (the start of a new
page) .
The "Odd" and "Even" options also start a new page with each new divi-
sion. The "Odd" option starts printing on the next odd-numbered page ;
the "Even" option starts on the next even page. In either case, you may
get a blank page . If you choose automatic page numbering, page numbers
will be printed on the blank page .

Use the "Column" option in multi-column documents when you want the
new division to start the next column . So if your division break occurs in
the second column, Word goes to the next page ; if the division occurs in
the first column, the new format begins with the second column on the
page .

The "Continuous" option causes the old format to continue until the top
of the next page; in this case, the division does not break the page .



To change how
the division
will break pages : 0

A
Choose the Division Layout command .
Choose one of the options under "Break :"

A Old division format continues until the next page after the division mark .
Then the format for the new division takes effect

B In a multi-column document, the division mark ends the column .
The new division format starts with the next column .

(I Usually, Word starts a new page at the division mark.

iut
Break

40 Continuous
Bo Column
C~ Page
DO Odd
EQEven

LJ Auto Page Numbering :

From Top :

From left :

Start Page Numbers At :

0 .75"

7 .25"

D The division mark breaks the page, and the new format starts on the
next odd numberedpage.

(It skips a page if the last page of the "old" division is odd-numbered)

E The division mark breaks the page and the new format starts on the
next even-numbered page .

11 Click the OK button .

Page Number Format
i) Numeric
Roman (upper)
Roman (lower)
Alphabetic (upper)

}Alphabetic (lower)

Complex Documents

The "Break" options change the way page breaks occur when you
start a new division.

Cancel

_Footnotes Appear
) On Same Page
0At End of Division

Running Head Position :

From Top :

From Bottom :

Number of Columns :

Column Spacing :

0.75"

0.75"

1

0.5"
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To create a
footnote :

Footnotes

If your document requires footnotes, you can create and number them
with the Footnote command . You position the footnotes with the Divi-
sion Layout command. Both commands are on the Document menu .
You can let Word number footnotes for you automatically, or you can
specify a footnote reference mark instead of a number . (The footnote
reference mark appears in your document text to indicate the correspond-
ing footnote text . ) The footnote reference mark can be anything you
like-a letter, symbol, or phrase up to ten characters long . (If you change
the format of your footnote number or reference text in the document
text, this change will not be reflected in the footnote window .)
The footnote text appears in the footnote window . The footnote window
is actually a window split, but it differs in some ways . The footnote win-
dow split is created differently, and its position in relation to the rest of
the document is determined in the Division Layout command .

Footnotes can appear on the same page as the reference mark, or at the
end of your division . If you have more than one division in your docu-
ment, they can appear at the end of each division .

The footnote can be as long as you wish, and can contain any number of
paragraphs . You can scroll in the footnote window and edit the footnote
text .

0 Place the insertion point immediately after the text that the footnote
will refer to .



Choose the Footnote command from the Document menu .

a File Edit Search Character Paragraph

fnr r,c,t - cnr~aI

taalaw

otumen

Exclusive use ()f a part. if your home means that you . must use a specific part
of your horn	 n with your
ernploymen'

	

ice arid also

®Auto-numbered Reference

or

Footnote Reference Mark :

OK

Cancel

Complex Documents

Page t 1
z

If you don "f wan/ aulomafical/y numbered foo/nofes, enfer eharacfer(2J for
/he foofno/e reference mark here .

"Auto-numbered Reference" is the preset option. To change this, type
your footnote reference mark in the text box .
Click the OK button. The footnote window opens at the bottom of
the screen and becomes the active window .
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Aufomatie footnote numbers are smaller than doeumeri/ /ex/ and
supers~ripfed

Type the footnote . There is no limit to the size of the footnote text .

tdHlaW

sine use of a part of your home means that you must

	

specific part .
ur home solely for conducting your business or in con

	

n with your
oyment I f you use part of your home as your busine
Pt"s()n 1 fl1U t)()SPS V()11 iVE? n()t m t t_h PXc111s1V~? 11sP

ordirig tx Publication 587, the taxpayer's use of the home office must bE
wl regular and exclusive . 1

footnote

lndieafe~ you are in the footnote window .

When you finish typing the footnote text, move the insertion point back
into the document window and continue your work . The footnote win-
dow remains on the screen until you close it .



You can go into the footnote window to edit the footnote without creat-

ing a new entry .

a Press the Shift key while you click and drag the split bar down the

window. When you release the mouse button, the Footnote window

appears .

bar

n	

Exclusive use of a part. of your home means that you must . use a specil

of your home solely for conducting your business or in connection witi

employment. If you use part of your home as your business office an

for personal purj

pIJuuIu I

taHidLi

Pre /he rh/ft key, no'c//cknddwg fhe 4p/if bar.

Complex Documents

1
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To close the
footnote
window:

File Edit Search Character Paragraph Document

taalew

Exclusive use of a part of your home means that . you must use a specific partt
of your home solely for conducting your business or in connection with your
employment. If you use part of your home as your business office and also
for personal purposes, you. have not met the exclusive use test i
0

0

footnote

ul~~xaisurr '~

	

r

	

ary r s ~

	

cir r it

	

f1t rrrrsL it
both regular and exclusive .
0

Click and drag the split bar /0 /he bottom of the screen. The Ioofnofe window
disappears .



To expand the
footnote window:

To specify
footnote
position :

To expand the footnote window, drag the split bar toward the lop .

tile East Search i.narocier raragrapn uocumeni

taHlaW	

Exclusive use of a part of your home means that you must use a specific part
of your horse solely for conductin ; your business or in connection with your
employment. If you use part of your home as your business office and also
for personal purposes, you have not met the exclusive use test .i
0

1 A(cOrolng to l'UDlicaUon j~', tntaxpayer s use oI trie norrie oiiice must qe
both regular and exclusive
0

NHMN4MMNMNHIYM~

	

'.Y/M•MM4VNM~HW.~Ms

Complex Documents

Use the Division Layout command to specify where you want to position
footnotes. Word places your footnotes on the same page as the footnote
reference mark. You can change this and place footnotes at the end of the
document, or at the end of the division if there is more than one division .

155



Using Word

To delete a
footnote:

Choose f7/v//on Layouf

Click here to position footnotes .

0

Division Cayou
_Break

C) Continuous
C) Column
® Page
C) Odd

C) [yen

n Auto Page Numbering :

From Top :

From left :

Start Page Numbers At :

Note

_rage NumDer r orma
Numeric

C) Roman (upper)
C) Roman (lower)
C) Alphabetic (upper)
C) Alphabetic (lower)

0 .5"

7 .25''

Footnotes Rppear
®On Same Page
Q At End of Division

Running Head Position :

From Top :

From Bottom :

Number of Columns :
Column Spacing :

duck OK.

OK

Cancel )

0 .5"
0 .75"

1
0 .5"

See the "Divisions" section of this chapter for more information on the
Division Layout command .

Delete the reference number or reference mark in the document text .
References around it will be automatically adjusted if you have num-
bered footnotes .

You cannot delete a footnote completely by deleting the
text in the footnote window. The text will disappear, but
the last paragraph mark for the footnote reference text
can't be deleted . You must always delete the number or
reference mark in the document text .



The reserved glossary name "footnote" can be used if you accidentally
delete an automatic footnote number in the footnote window .

Type footnote at the location in the footnote window where you need
to insert the footnote number .
Expand the glossary by holding down the Command key while press-
ing the Backspace key. Word inserts the correct footnote number .

0

If you delete a footnote reference number in the document text, you can
reinsert the footnote reference number and Word will automatically adjust
the surrounding footnote numbers .

See Chapter 6, "Editing With Word," for more information about using
glossaries .

Complex Documents
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Running Heads

A running head is text that appears at the top ("header") or at the bottom
("footer") of your page . Running heads can appear on even pages only,
odd pages only, or on all pages .

Use the Running Head command on the Document menu to :

•

	

Set text apart as a running head .
•

	

Choose whether you want the running head at the top of the page or
at the bottom of the page .

•

	

Specify whether you want running heads on even pages, on odd pages,
or on the first page of the document (or division) . Running heads are
preset to appear on both even and odd pages, but not on the first
page of a division .

Use the Division Layout command to position the running head at the top
or bottom of the page . Running heads are preset to print three quarters
of an inch from the top edge of the paper and three quarters of an inch
from the bottom edge of the paper .



A Type the text for the running head . The running head text can be as
long as you want. Pressing the Return key ends the running head .

Select the running head text .

iie tdi i Search Character Paragraph

we at Murphy & Al
home It. is designe
consider in settling
very general, pleas
concerns.

family Thank you
the sale of your ho

selling

Introduction

Running Head

- c.curs on
®Odd Pages
® Even Pages
Q First Page

OK

Cancel

Position--
1 Top

0 Bottom

Complex Documents

ocumen

u In selling your
ors you need to
the discussion is

r,r t,r

t, -'. acc,c-t U .•,ii ,~-

If/he running head is par/ of the document text (a chapter title, for
inQ/anceJ, type the text again, or copy if

a
4
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ii Choose the Running Head command from the Document menu .

S'pecify whether you want running heads
at the top or bottom of the page . . .

a File Edit Search

We at Murphy & All
home It is designer
consider in settling
very general; please
c c-)nc~rns

we hope this win aE

family Thank you 1
the sale of your hon

1 ne sale VI d home I epi

P1 01

	

i__i: . . .

Character Paraaraoh

sellin

in+rnAsent a

Running Head

Occurs on
® Odd Pages
©Even Pages
0 First Page

Cancel

Position
® Top

Bottom

Dorumen

J 11yu1'.AUwV11 \ I u A . .u '...

	

~.,'.1.''.

	

.'.

	

£A£`.'Jl'

	

' ' , .. 1~' .

Ln seu ng your
you need to
e discussion is

1
Y

` . l l A c'.AAu 1 U LA A

. . or on even, oddpages, or both; and on the first page of the division .



Click the OK button .

selling	

', e at Murphy & Allen hope that this brochure will help you in selling your
home Itt is designed to help you become aware of the factors you need to
consider in settling on a price and in dealing with buyers The discussion is
very general, please feel free to call us if you have any questions or
concerns

We hope this will be a pleasant and profitable experience for you and your
family Thank you for your confidence in us ; we are happy to assist. you in
the sale of your home

ome

bl .6 V . . . V . V h' . V V V .5/ v~ . .a

	

v . .

Introduction

The running hea J ymbol « appears in the doeumenf
next fo the running head text.

Complex Documents

When you print the document, the running head text is placed on the
pages you specified .

If you want to end a line within the running head, or add a line space
within the running head, press the Shift-Return keys . This "new line" key
sequence ends the line without ending the running head .



162

Using Word

To specify running

	

You can have running heads at the top ("headers") or at the bottom of the
head position :

	

page ("footers") . Whether they appear at top or bottom is specified in the
Running Head command .

The "Running Head Position" section of the Division Layout dialog box
controls the position of running heads in relation to the top and bottom
edge of the page .

Choose Division Layout .
Specify a position from the fop
or the bo>/om of the page.

Click OK

p

Divi

~Bre~

o Continr

0 Colum

®Page

Q Odd

o Euen

age

Numeric

ian tupper)

ion (lower)

ripper)
we r)

Auto Page Numbering :

From Top :

From Left :

Start Page Numbers At :

0 .75"

7 .25"

Running Heed Position :

From Top :

From Bottom :

l '-""L ~' J

_Footnotes Appear

® On Same Page

C' At End of Division

0.75"

0.75"

rvumoer of i oiumns : ( i

Column Spacing :

	

! 0.5"

Running heads print one-half inch from the left and right edges of the

To change this position, use the Formats command on the Paragraph
menu, and indent the running heads as you would any other paragraph .
See Chapter ?, "Formatting Your Work" for more information about para-
graph formatting ; and see below for the procedure on indenting running
heads .

Note

	

If you position running heads less than one-half inch from
the left or right side of the page, your printer may cut off
part of the running head .



To delete a
running head:

To edit a
running head :

To change a
running head back
to normal text:

To embed a page
number in a
running head :

If you want to print the running head on the first page, the running head
text must be the first thing in that document or division .

0

0

0

11

0

ii

Complex Documents

Select the running head text in the document .
•

	

Delete the running head by pressing the Backspace key ; or move it to
the Clipboard by choosing the Cut command .

Change the running head text in the document as described in the
"Editing With Word" chapter .

Choose the Running Head command .
•

	

The boxes next to "Odd Pages" and "Even Pages" are selected as the
preset option, and the "First Page" box is blank . If you have not
changed this yet, click next to "Odd Pages" and "Even Pages," so that
all three boxes are blank. This specifies that the running head is to
appear on none of the pages.
Click the OK button .

You can also embed page numbers in running heads, by using the "page"
glossary. The "page" glossary is a page number place holder that is ex-
panded automatically when the document is printed . You can use this
glossary in running head text to place a page number in a running head,
without having to type the actual number in the text . See Chapter 6,
"Editing With Word," for more information on using glossaries .

Type page in your running head text at the location you want to
reserve for the page number .

•

	

Expand the glossary entry by pressing Command-Backspace . The
word (page) appears in the running head text in the document .
Format and position your running head as usual ; when you print, the
(page) will be replaced with the page number .
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<<Appraising a Home (page

U
A

11

B

selling

We at Murphy & Allen hope that this brochure will help you in selling; your
home I t is designed to help you become aware of the factors you need to
consider in settling on a price and in dealing with buyers The discussion is
very general, please feel free try call us if you have any questions or
concerns

We hope this will be a pleasant arid profitable experience for you and your
family Thank you for your confidence in us, we are happy

	

assist you in
the sale of your home

P101

Introduction

The 'age"

	

pglossary will be replaced with a page number when you print
the document.

If you don't expand the "page" glossary immediately after typing it, you
can select it later and expand it .

To indent running

	

Running head position is not affected by the left and right page margins .

heads :

	

Running heads are preset to print one-half inch from the left edge of the
page .

Use the Formats command on the Paragraph menu to indent the running
head from the left side of the page, as you would any other paragraph .

Select the running head text .
Choose the Formats command from the Paragraph menu .

Indent the running head by typing the position in the text boxes ; or
by dragging the markers on the ruler .

Click the OK button . When your document is printed, your running
heads will be indented .
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Introduction

We at Murphy & Allen hope that this brochure will help you in selling your
home It is designed to help you become aware of the factors you need to
consider in settling on a price and in dealing with buyers The discussion is
very general, please feel free to call us if you have any questions or
concerlis

We hope this will be a pleasant and profitable experience for you and your
family Thank you for your confidence in us, we are happy to assist you in
the sale of your home

Complex Documents

Remember that the ruler shows only six inches of text; if you position
your running head at the right side of the page, you may need to scroll
the document horizontally to look at it on the screen .

You can use this method to alternate the position of the running head-
that is, to make the running head appear on the right side of odd num-
bered pages and on the left side of even numbered pages .

This running head was indented one inch from /he left.

If the text for the running head will be the same for both left and
right pages, copy the running head text so that it appears twice . If the
text will be different (for example, book title on left pages and
chapter on right pages), type the text for each running head .
Format the two running heads separately, using the Running I lead
command. Specify that one running head appear on odd pages ; specify
that the other appear on even pages .
Use the Formats command from the Paragraph menu to align the run-
ning head flush right for odd pages . The other running head is
aligned flush left automatically, unless you want to indent it (with the
Formats command) .





9 Printing Documents

In this chapter :

	

∎ Using the Print Command
•

	

Setting Up Pages
•

	

Pagination
•

	

Printing Form Documents

First, install your printer according to the instructions in Macintosh and in
your printer guide . You should be familiar with the general instructions
for printing as described in these two manuals .

If you are using a daisywheel printer, see "Appendix E, Daisywheel
Printers ." If you are using an Apple Writer or laser printer, the dialog
boxes may differ slightly from those that appear in this manual .
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To print a
document :

Using the Print Command

When you print, you can specify how many copies and what pages to
print; what sort of paper to use ; and print quality .

The preset options for printing are :

•

	

Standard quality (screen quality print)
•

	

All pages in document printed
•

	

one copy of document printed
•

	

Continuous form paper

If you want to change any of the preset page dimensions (such as
margins or paper size), choose the Page Setup command and make
your changes. See the section below on "Setting Up Pages ."
Choose the Print command from the File menu . Note that there are
some preset options .

0

A

ii
e

A High qualify print (~/owJ

8 Pre~ef option : .oreen qualify
~fasfer~

C Teal only, one size, plain /ex/
plus bold and underline'fasfe~/J .

6 S'peoify how many copies
loprin/.

H a/andardprin/erpaper

If you want to change any of these options, do so .
Click OK. The document will start to print .

D Prints all pages in document
(pree/Js

E & F Click to print par/ of document
/hen ~peoifypage range.

l Single sh ee% ofpaper

Quality ;

	

A High B ® Standard C Drait OK

Page Range : D®RII Ec3 From : To:F

Copies : 1

Paper Feed : H® Continuous Cut Sheet Cancel



To interrupt
printing :

a Press the Command key and type a period .
This stops printing completely .

Printing Documents

You may find that saving your document before you print will speed the
process. This is particularly true if you make a lot of formatting changes
to your document .

To reprint:

	

Word prints your documents with the settings you used the last time you
printed. You need not set the Print command options each time you
print, unless you wish to change the settings .
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Setting Up Pages

When you choose the Page Setup command, you will note that certain
page options are already set :

•

	

Letter-size page (8 112 by 11 inches)
•

	

Printed lengthwise down the sheet
•

	

Margins are one inch at top and bottom, and one and one-quarter inch
on the left and right sides .

A 8/"wide, //"high

a g/" wide, l4" high

C European standard,
g," wide, l I %" high

p gp " wide, l2" high

Paper: A ® US Letter CC) R4 Letter

B c) U5 Legal DC) International Fanfold

Orientation : Et Tall

	

F 0 TaII Adjusted C o Wide

Margins :

Top :

	

1 "

	

left :

	

1,25"

	

Gutter :

Bottom: 1 "

	

Right : 1,25"

(H0K

Canoe J

E Text prints lengthwise

	

Prints across the width of the
down the page .

	

page-the length ofpaper is
used for the width of theF Prints pictures in proportion .

	

document.

N Click OK when you have chosen your formats .



To specify margins
for your document:

a

Printing Documents

Choose the Page Setup command from the File menu .
The margin settings are in the lower part of the dialog box. Type a
number or numbers in the text boxes . Specify a unit after the
number if you do not want inches .

© Click the OK button .

Paper:

	

() US Letter

	

0R4 Letter

Q US Legal

	

International Fanfold

Orientation : Ce) Tall

	

C) Tall Rd jested

	

) Wide

ii Margins :

Top :

	

1 "

	

Left:

	

1,25"

	

Gutter : 1
Bottom: 1 "

	

Right : 1 .25"

0 " 8

OK

Cancel

A Type a number Word assumes inches, unless you specify otherwise.

B Specify extra space on righf margin of even pages, left margin
of oddpages, for binding.

The "Paper" and "Orientation" settings at the top of the dialog box are
remembered from one session to the next . You need not change them
each time you print .

The margin settings are saved with your document . These settings can
differ from document to document when you print .
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You do not need to worry about pagination most of the time . Word
breaks pages (ends one page and starts the next) for you automatically .
Word also has "widow" and "orphan" control so that a single line in a
paragraph is not printed at the top or bottom of a page .

To end a page :

	

You can tell Word where to end the page if you want to do so .

To keep lines or
paragraphs
together :

Pagination

0 Select where you wish the page break to occur .
Press the Shift-Enter keys .

You can specify that certain lines and paragraphs be kept together on a
page. Use the "Keep lines together" and "Keep with next ¶" options in the
Formats command on the Paragraph menu. See Chapter 7 on "Formatting
Your Work" for details .

Paragraph Formats
Left Indent :
First Line :
Right Indent :

0"
0
0

Click fo keep paragraphs
fogelher on a page .

Line Spacing :
Space Before :
Space fitter ~n ii

auto
0h Canoe

Keep with next 91
Keep lines together

Clink fo keep selected lines
fogefher on a page .

You can specify what kind of page number you want, where you want
page numbers to appear, and whether you want page numbering to be
continuous or to restart at each division . Use the Division Layout com-
mand to control page numbers . See Chapter 8, "Working With Complex
Documents," for details about using the Division Layout command .



To repaginate :

	

Use the Repaginate command on the Document menu to repaginate docu-
ments you have already printed. This is particularly useful if you have
made editing changes since you last printed, and need to see how your
page breaks are affected .

D

Printing Documents

Choose the Repaginate command from the Document menu .

The document you are editing is repaginated . Page breaks appear as equal
signs (_ ) on the left edge of the document. Changes in pagination will
appear when you print .

You can also choose Repaginate to see page breaks in a document that has
not been printed .

Repaginate will not change a page break inserted by pressing Shift-Enter .
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Printing Form Documents

When you want to produce many documents that will be very similar, you
can always do so by creating many slightly different versions and printing
them one at a time. But you will find this time consuming and tedious .
The easier way is to create a "form document" and use the Print Merge
command to automatically print all the different versions . A form docu-
ment can be :

•

	

A form letter that is customized to the recipient-for example, the
person's name and address can appear in the letter .

•

	

A main document that contains text that is inserted only if a certain
condition is true .

•

	

A merge document that compiles data from other documents (person-
nel records, perhaps) or from other programs (like ASCII merge docu-
ments from Microsoft File) .

You can also use Print Merge to insert entire documents into a main docu-
ment, then print them in sequence, without having to choose the Print
command over and over.

To create a form

	

To produce a form letter, first create two documents, then combine them .
letter :

•

	

The main document contains the "standard" text . This text remains
the same for all copies of the document .

•

	

The merge document contains the text that varies from one copy of
the form document to the next .



The main document and merge document
are comb/ned to produce form documents .

ft/n document

tj Tp, lobdata

. , 1u11name
address,

Dear mama

Thank you Ior respor :i tg, to ur advertisement in the newspaper r r a
a~r,I4<n

lormletter job ~-

11950 16th Ave E, Seattle, WA 98112

IF Interview _ ve W< wouM like to •IS uss this position with vau
further Please call our seuetary Ms boner to s hedule an interview «E1:E
The posit^n y u applied I t has been tilled N .wever we will keep your
resume ,n file f r six m n :,

	

If any partl_r open !ha : rlta,..hes y .>ur
09lilicatr	thin that time we will tontart you ,.FNr~IFH	1{~~
Pee 1

	

,

Print
Merge

;~	 Jobdota

fullnarre address name p^rIU n
Kenneth Watson • 7yvu I l,th NE
katt]c WA 98103, Mr Watson !onsultan~
Mr John Quiet, 500 N 42nd
Bellevue WA 9800 ;, Mr Quiet, window washer
John Keeley 2200 SW 4th
Kirkland WP, 987 ; ; . Mr Keeley, rnarntenam.e engmeei
Ms Charlotte W Nas.h, 34009aler St
Seattle WA 98122, Ms Nash, word pro essing operator
Mr Bryan Dllkington, 100 11th W
Seatue WA 9 101, Mr Dtlkmgton lreelante artist
0

Page I

	

k}~~

Merge document

Printing Documents

I A11i4, I.e10s"u
11950 16th Art E, Seattle, WA 99112

Lebneth Aat9an
7900 111th NE
Settle WA 9610}

Dar Mr lhtaw

Thank you for respoodartg to out advertisement m the newspaper lot a
consWt~nl

We would like to discuss this poabon with you Iurturth.c Pleas. call ow
s.cretary Ms Jones to schedule an mtarnew

We appreciate your interest to our company

Sincerely .

Mule ADea

& Miss, Ma14s's
11950 16th Ave F, Seattle, WA 98112

Mr John purer
500 N 42nd
&Ilevue WA 9800}

Dear Mr Quiet

Thank you lot responding m our advertisement in the newspaper for a
window wishes

The positron you applied la his been filled However we will keep your
resume on rile lot is months If any positron opens that matches your
vudJianom within thn timee we will contact you

We appreciate your interest m our company

Sincerely

Marie Alien

i

11950 16th Are E, Seattle, WA 98112

Joan galey
2200 SW 4th
Isrklsnd WA 960}}

Dar Mr [alq

Thank you lot responding to our advertisement to the newspaper lot a
malnte0ance engineer

W. would tike to discuss this posltloh with you further Pleas, all our
teaetary Ms Jane, to acbeduM an Interview

We apprecuk your interest m our company

Sincerely,

Mute Allen

Form documents
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See "Creating a Main Document" and "Creating a Merge Document" below
for directions on creating these two documents .

Creating a Main Document
You edit and format the main document like any other Word document .
The main document is different in that it contains special fields and in-
structions where Word inserts information while printing .

A "field" represents one item of information or data . The field name is
usually a general category, such as "name," "address," or "salary ." An
"instruction" tells Word to insert information in a specific way-typical in-
structions are ASK, INCLUDE, and IF . . .ENDIF.

When the document is printed, Word replaces the field names with infor-
mation from the merge document. The inserted text has the same charac-
ter formats as the field name it replaces . For example, if the field name
«address» appears in your main document, the address will be italic when
you print the document .

Main doeumen/

Special merge characters

formletter-job

1iJurpyb~UUnO~ 1Utc P©
11950 16th Ave . E, Seattle, WA 98112

D AT , lobdata>:>

	

DATA instruction

<:<.fu.liname>;

	

Field names
address\

	

v JJ

Dear <<narne>:

Tharik you for responding; to our advertisement in the newspaper for a
<posatiori : >

Etse call our secretary leis Tories
you

applied
for has been

to schedule an interview
filled However, we will keep

«1
yc

Paqe 1 IIIIII 1111111 1111 1111111 IIIIII



To create a main
document:

A

Printing Documents

The DATA instruction must be the first instruction in your main docu-
ment. This instruction tells Word the name of the merge document
to open for information. For example, the instruction «DATA
jobdata» inserts data from the "jobdata" document .
Type the main document text . Type field names at the places where
you want to insert text from the merge document . Surround each
field name with a set of special merge characters-for example,
«address» . (These special characters are international quotation
marks, not angle brackets.) Hold down the Option key and press the
Backslash (\) key to get the first « and press Shift-Option-Backslash to
get the second » .

Instructions appear in this manual in capital letters for emphasis ; you can
use any combination of capital and lowercase letters in an instruction .

You can have up to 256 fields ; each field name can be up to 64 characters
long. As long as the DATA instruction is first, you can put the field names
and instructions in any order you like in the main document . You do not
have to include all the information that is in the merge document ; you can
choose to include only those fields you want in the main document .

You can also use a header document name in addition to the merge
document name in the DATA instruction. See the Print Merge command
in Chapter 11, "Commands," for details .

For a complete list of the instructions you can use in a main document,
see "Instructions" below .

Creating a Merge Document
The merge document contains the information or data that you want to
merge into the main document . You can use Word to create a merge
document; or you can use unformatted ASCII documents from other
Macintosh applications-Microsoft File, for instance .

A merge document is made up of data records . Each data record contains
the fields of text that are inserted to produce one version of your docu-
ment. A data record in a payroll file might include this information for
each person on the payroll : name, social security number, gross income,
net income, and so on . You end a data record by pressing the Return key .

The first data record is a special one, called a "header record ." This
header record lists the field names . For example, a typical header record
might read "name, address, phone, date of birth" . These categories will
correspond to the field names in the main document .
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To put commas in a
field :

To put quotes in a
field :

To prepare a merge
document :

Note that in the merge document you do not type special characters
around fields . Instead, you separate them with commas or tabs .

Merge document

Header record

D

D

A

Header record and data record order
must match in the merge document .

\I
S'eparafe fie/ds with commas or fabs.

Surround the entire field with quotation marks . For example, your
data record might read : "John Smith, Jr.", 1419 13th E, house, $50000

Surround the word(s) with double quotes and the field with quotes .
For example, another data record might read: Mary Brew, 1820-18th
Avenue, "fixer-upper" ", $30000

Type the header record and press the Return key . The header record
must be the first data record ; it names the fields for all data records
that follow .

∎ jobda a --

Kenneth
Seattle
Mr . John
Bellevue
John
Kirkland
Ms .
Seattle
Mr .
Seattle
0

f ullnarrie, address, name,
Watson, ?900 114th
WA 98103, Mr. Watson,
Quiet, 500 N . 42nd
WA 98003, Mr .

Keeley, 2200 SW 4th
WA 98033, Mr .

Charlotte W . Na.sh, 3400
WA 9812 2, Ms . Nash,

Bryan Dilkington, 100
WA 98101 r

	

Dilkirlgton,

position
NE

consultant

Quiet, window washer

Keeley, maintenance
Galer St
word processing

11th W
freelance artist .

engineer_

operator

Dafa records

Page



Now type the rest of your data records . Fields should be separated
with commas or tabs only . Type the fields in the same order in which
they appear in the header record . Press the Return key to end each
data record .

Merge document Show j was used to show symbols .

Ike Shift-Return (new line) to end a line without ending the data record

0

Press the Return key to end each data record

Printing Documents

fullnarne, address, • name, position
Kenneth Watson, ?900 114th •NE
Seattle RYA 98103, Mr . latson, consultan ~
Mr. John Quiet, X00 N . 42nd .
Bellevue . WA • 98003, Mr . Quiet, window washer
John Keeley, 2200 SW 4th .
Kirkland WA • 98033, Mr . Keeley, maintenance engineer
Ms . •Charlotte 1 . Nash, 3400 Galer St .
Seattle . ANA 9812 2, Ms . Nash ) word processing operator
Mr . • Bryan Dilkington, 100 1 l th W
Seattle 1A98101, Mr . . Dilkingtori, f reelanc:e artist.
0

Instructions
You type instructions in the main document to tell Word how to handle
or where to look for specific information . Instructions are also surround-
ed by << special merge characters » .

You can type instructions using any combination of capital and lowercase
letters .

79
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Examples

Summary of Instructions

DATA

	

Tells Word in which document to find data .

ASK

	

Prompts you for the contents of a field .
You can also specify the prompt .

INCLUDE Inserts the text of the specified document
in the main document .

You can use this instruction to print several
documents at one time .

NEXT

	

Tells Word to go to the next data record
in the merge document .

SET

	

Sets the contents of the field equal to one
value for all documents printed.

You can also use this instruction to display
a prompt every time it is encountered so you
can type the information as each copy of the
document is printing out .

DATA
If you type «DATA orders» at the beginning of your main document, this
instruction tells Word to use the data document named "orders" to fill the
data fields in the main document . The DATA instruction must always be
the first instruction in the main document .

ASK
If you insert the instruction «ASK Interview=?Do we want to interview?»
in your file, you will see this message at the point that the instruction is
encountered : "Do we want to interview?" The first question mark after the
equal sign is required; the second is part of the text for the prompt in this
example. You would probably use this in combination with a conditional
instruction. The response to the ASK statement usually corresponds to the
information in the IF statement. See the conditional statements in the
table below .



,-WKTh. *uefion will display a prompf.

b Q0uJ3~G3o 040

Aun c coc tth

	

1A QR 1 1')

«ASK Interview=?Uo we want to interview «name» ? >>

«fullname>>

<address .>

Dear <<riarne>>

Thank you for responding to our advertisement in the newspaper for a

«position>>

<<.IF Interview = "yes"»We would like to discuss this position with you

further Please call our secretary Ms Jones to schedule an interview <<ELSE>>

The Uositaor	 lll~cI	w ,11 ,~~ ~ Y~?1?I. . .
Page 1

	

_ .

Printing Documents

lter-job	

INCLUDE

If you type the instruction < INCLUDE brochure >> in your main document,

the entire "brochure" document will be inserted at the point where the

instruction is encountered .

The number of documents you can include this way is limited only by the

amount of space left on your disk, because Word builds one large file,

then prints it .

NEXT

This instruction tells Word to go immediately to the next data record in

the merge document. For example, if you type « NEXT>> between field

names in your main document, you can print all the information in one

form document, instead of one data record for each field in each docu-

ment.
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This example prints all the names and addresses from the merge docu-
ment in one form document .

< name >>

	

<<address >>
<<NEXT>>
<<name>>

	

<<address>>
<<NEXT>>
<< name >>

	

<<address >>

Mary Brew

	

1820 18th Ave .J
John Smith, Jr. 1419 13th E .
Beth Clarke

	

11249 145th St .

SET
Use the SET instruction to insert the same information each time the field
is encountered. If you type the instruction < SET date = March 1,1984> ,
Word will print the < date> as "March l, 1984" in all your copies .

You can also use the SET instruction to display a prompt at each oc-
currence of the << date >> field. For instance, << SET date = ?The date is : >>
displays the message: "The date is :" when the <<date>> field is encountered .

You can use the SET instruction fo display a prompt.

<<SET date =?What is the date?»

<<f ullr ame>>
rr .<<a< d re >>

Dear <<name>>

Thank you for responding t~~ our advertisement in the newspaper for a
<<p0 Si tj n>>

IF Interview = "yes"» 'e would like to discuss this position vnth you
further . Tease call our secretary Ms Jones try schedule an interview . <<ELSE>>

ii_1111 1111111111

	

1II111II1IIIIJ
i

	-- tormietter-hod

~pbq a Q9 Uc o o QooUtou~



Examples

Printing Documents

You can also insert conditional instructions. This means that Word prints

the text only if a certain condition is true ; or that Word prints one thing if

the condition is true, and something else if the condition is not true . If

your condition requires a response from you (instead of the condition

matching a name or number, for instance), you will be asked whether the

condition is true when you print .

Conditional Instructions

IF. ..ENDIF

	

Inserts text if the condition specified

is met. You can also use the comparison

operators > (greater than) and < (less

than) in this instruction .

IF. . .ELSE. ..ENDIF

	

Also inserts conditional text . If the

condition specified is met, the text is

inserted. Otherwise, another text

entry that you specify is inserted .

You can also use greater than or less

than operators .

Put quotes around the conditional item in the instruction .

IF . . ..ENDIF

If you want to confirm a meeting with one (or more) persons, type :

«IF name="J.S. Clark"» I look forward to meeting

with you on Thursday at 10 :00 a.m. to discuss

the contract. «ENDIF»

When the name you specify is found in a data record, Word prints the

message. «ENDIF » completes the conditional instruction .

You can use SET or ASK to set a prompt, if you prefer that the IF state-

ment be a response to a question. You can also use greater than or less

than operators ; for instance :

IF maximum account balance > " 50000" » We would

like you to attend our office Christmas party on

December 23, 1984.«ENDIF»

183



Using Word

IF. ..ELSE . . .ENDIF
In this example, if you respond with "yes" to the "attend meeting" prompt,
Word prints the first sentence . If you respond with anything other than
yes, Word prints the text that comes after the ELSE instruction . (Use SET
or ASK to specify a prompt .)

IF attend meeting= "yes">> I look forward to meeting
with you to discuss our mutual interests . <<ELSE>> I regret
that I cannot meet with you at that time. I will be happy
to arrange a meeting at your convenience . << ENDIF

See the figure below for another example .

IUI IIIICl(CI JUU	

Dear <<name

Thank you for responding to our advertisement in the newspaper for a
<posiUon>>

<<IF Interview = 'yes">>We would like to discuss this position with you
further Please call our secretary i s Jones to schedule an interview <<ELSE>>
The position you applied for has been filled . Ho Vvµ v er, E? vvill keep your
resume on file for six months . If any position opens thatt matches your
qualifications within that. time, wewill corita':a you. <<ENDIF

We appreciate your interest in our company

Sincerely,

For more details about the Print Merge command, see Chapter 11, "Com-
mands," in " Word Reference ."



To print a form
document :

Merging the Documents
When you have created both the main document and the merge docu-
ment, you can start printing form documents using the Print Merge com-
mand. The main document, the merge document, and any documents in-
serted with the INCLUDE statement need to be on the same disk .

Each field name in the main document must match a field name in the
merge document . Or you can define a field by using a SET or ASK in-
struction.

A

fullriame, address, name, p
Kennet.l7 Watson, 7900 11
Seattle 'A QB 1 u ~ . Mr W
M
BE

1

Open the main document . The main document window must be ac-
tive when you start to print .
Open the merge document if you wish . If you do not open the merge
document, Word goes to the disk for it .

Merge document

Main document mu / be active

Promp/

	• .

<<DATA jobda.ta>>
<ASK ln.terview=?Do we wa to interview <<:name>7 ::>
«SET date=? What is the date >»

«f uliname>>
«address>>

Dear <<name>> :

r p AI

Printing Documents
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To reprint part
of the merge
document:

11

B

A

11

8

Choose the Print Merge command from the File menu . A dialog box
appears that is identical to the Print dialog box. Choose options just
as you would to print any document .
At this point, if you have inserted conditional instructions or prompts
in the main document, you may be prompted to respond to questions .
Fill in the text box below each question exactly as you are prompted .
Click OK in the Print Merge dialog box to start printing .

If you inserted conditional instructions or prompts, Word will stop and
prompt you for each copy of the form document that you print . Printing
continues until all information in the merge document has been combined
with the main document .
If you make a mistake in one of the data records, you probably do not
want to reprint all of the data records in the merge document .

Correct the error in the data record .
Create a new (empty) merge document .
Copy and paste the corrected text into the new merge document .
Change the DATA statement in your main document so that it inserts
the newly created merge document .
Use the Print Merge command as described above .

You can use this technique to reprint any number of data records if you
need to .



In this chapter:

	

∎ Opening documents
∎ Saving documents

10 Handling Documents

This chapter explains how to get your documents from the disk and put
them back using the Open, Save, and Save As commands on the File menu .

For information on topics relating to disks and memory management, see
"Appendix C, Disk Space and Memory ."
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To open
documents:

Opening Documents

There are two ways to open an existing document . You can open the
document from Word by using the Open command. Or you can open a
document from the Finder by double-clicking on the icon for the docu-
ment. This loads the Word program and the document at the same time .

0

A
I'

Choose the Open command from the File menu .

The list box contains the names of all documents on the disk .

Scroll to gee the entire list .

letter2
MEMO

Select a Document :

Word Disk

Open

(Cancel

Eject

If you make a mistake, or insert the wrong disk, press Cancel or Effect .

Click the name of the document you wish to open .
Click the Open button . Your document appears on the screen .
OR

Double-click on the document name in the list box to open it .

You can also open a new, empty document window or open an existing
document using the Finder .



To open another
document window :

Start Word and create

	

Double-click on
a new document :

AS )k

Start Word and open an

	

Double-click on
existing document :

	

LETTER:

U

A

To . . . Do this:

Choose Open from the File menu .
Click the document name in the list box .
Click the Open button .

OR

Choose the Open command and double-click the document name in
the list box .

Handling Documents



To open a new,
blank window:

To open a docu-
ment on a
different disk:

If you have two
disk drives

D

You can also use the Open command to open a document on another disk
without returning to the Finder.

Choose Open from the File menu .
Click the Eject button in the Open dialog box .
Insert the disk containing the document you want to open . The Open
dialog box reappears .
You will see a list box containing the names of all Word documents
on the disk. Click the name of the document in the list box.
Click the Open button, and the document appears on the screen .

0
A
11

B

Choose Close from the File menu or click the close box to close the
window on the screen. If there is more than one window on the
screen, this closes the active window .
If there are unsaved changes in this window, you will see an alert box
asking if you want to save the changes .

If you click Yes, your document will be saved . If you are saving a
new document, the Save As dialog box will appear . Type a name and
click the Save button to save the changes . The window will be
closed .

Clicking No discards the changes in the window without saving .

Choose New from the File menu . A new untitled window document
appears. Word will prompt you to name the document when you
save it .

If you have a single drive system and the disk in the drive does not con-
tain the Word program, you will be asked to reinsert the Word disk .

Choose Open from the File menu .
Insert the disk in the external drive and click Drive in the Open dia-
log box .
Click the name of the document that you want in the list box .
Click Open to open the document (or double-click the name in the
list box) .

B

Using Word

To close a 0
document
window:

e



Saving Documents

Handling Documents

It's a good idea to save your documents at least every 15 minutes . Saving
this often ensures that you won't lose information by accident if there is a
power interruption or if you leave your computer unattended .
You are also asked if you want to save when you use the Quit and Close
commands. See Chapter 11, "Commands," in "Word Reference" for more
information on these commands .

When you change a document and save it, the new version replaces the
old one on the disk . To save different versions of a document, or to
create a backup copy of a document, use the Save As command .

a Choose the Save command from the File menu .

If you've saved your document before, no dialog box appears . Your
changes are saved automatically . The new, edited version of the document
replaces the old one on the disk .

To save a new document, use the Save As command . However, if you
choose the Save command instead, Word will display the Save As dialog
box.
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Using Word

To save a new
document:

0 Choose the Save As command from the File menu .

Check fo discard forma//ing. Otherwise, Word saves all forma//inq with
the document text.

8

aue Current

Check if you want fo make a backup copy of your document .

Type a document name here.

<<

:1 _ J

Docu ent as :

	

Word Disk

Eject

Q eHn y

	

ake Backup

The number of characters in the document
will appear here when you click Wave.

Cancel

Type the name of the document in the text box labeled "Save Current
Document as:" If you type the name of a document that already exists,
you will be asked to confirm that you want to replace that document .
Confirm, or cancel the command .
Click the Save button, or press the Return or Enter key, to save your
document. The number of characters in your document appears brief-
ly in the lower left corner of the window . Your page number will
reappear when the document has been saved, and you start working
again .



To save more than

one version of a

document:

To save a backup

copy of a

document:

If you change a document, but want to keep the old version on the disk as

well as the new version, you can use the Save As command to give the

new version a slightly different name (for example, the new version of a

RESUME document could be named RESUME2 ) .

Choose the Save As command from the File menu .

•

	

Type the name for the new version of the document in the text box .

© Click the Save button, or press the Return or Enter key .

If you want to keep extra copies of very important or frequently used doc-

uments on your disk, use the Save As command to make backup copies .

A

A

© Click the OK button to save .

Word saves the backup copy, which is named "Backup of document

name" .

Word needs a copy of the document on the disk to make a backup copy,

so the document should have been saved once . When you tell Word to

make a backup copy of a new document that you have not yet saved,

Word will not be able to do so . However, Word will make a backup copy

the next time you save this document .

To discard

	

You may want to discard a document's formatting for several reasons .

formatting:

	

Perhaps you intend to change the format later . You may want to save

space on the disk. Or you decide to discard formatting so that you can

move text from Word into another Macintosh application-for example,

you could write a program with Word and move it into Microsoft BASIC .

A

11

Choose the Save As command from the File menu. Word proposes

the current name of the document.

•

	

Click the box labeled "Make Backup ."

Handling Documents

Note

	

You can use any combination of characters in a document

name, with one exception : you cannot use a colon .

Choose the Save As command .

•

	

If necessary, type the document name in the text box .

Click the box labeled "Text Only ."

•

	

Click the OK button.
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To save to a
different disk:

0
P1
A

n

Choose the Save As command .
Type the document name in the dialog box .
Click the Eject button ; or click the Drive button if you have an exter-
nal drive .
Insert the disk you want to save the document on .
Click the Save button.

When You Quit
If there are unsaved changes to any documents when you quit, Word asks
you to confirm whether or not you want to save changes to your docu-
ments. If you click No in this first box, Word quits and discards all
changes to all documents .

If you click Yes, you will be asked again if you want to save the changes
for individual documents . The windows move to the top one at a time ;
the Save box applies to the document displayed in the top window . If
you click No, Word discards the changes and quits . If you click Yes,
Word displays the Save As dialog box for any new documents . When all
changes to all documents have been saved, Word quits and returns you to
the Finder.





Word Reference
"Word Reference" includes the

	

∎ Appendices on the following
following information :

	

topics :

∎ Word commands Key sequences
Preset options and formats
Disk space and memory
Using Word with other applica-
tions
Daisywheel printers

∎ A list of terms used in this
manual







11 Commands

This chapter describes the Word commands . They are arranged in the
order in which they appear on the menus . If there are options you can
choose, they are listed in the discussion of the command .

For an alphabetical list of commands, look in the Index under "Com-
mands."

What is a

	

A command is an instruction to your Macintosh to perform an action .
command?

	

When you pull down a menu on the Macintosh, some of the commands
appear gray, or "dimmed ." A command is dimmed when it does not apply
to what you are doing at the moment. You cannot choose a dimmed
command .

Some commands appear with a check mark beside them on the menu .
The check mark tells you that the command is in effect. In most cases, a
checked command applies only to the text that contains the insertion
point or is currently selected .

Some commands are carried out as soon as you select them . Others need
more information. Any command on a menu that is followed by an
ellipsis ( . . .) displays a dialog box. The dialog box appears when Word
needs more information to carry out the command .
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Contents

a File Edit

About Microsoft Word . . . New

	

1~N Undo Typing

	

Z

Open . . .
Scrapbook Close Cut

	

H

Alarm Clock Save Copy

	

€C

Note Pad Save As . . . Paste

	

u

Calculator Page Setup . . . Clear

	

B

Key Caps Print . . .

	

P Show Clipboard

C:ontrol Panel Print Merge . . . Show Glossary

Puzzle Printer Setup . . .
Quit

	

'Q Show Ruler

	

R
Hide 91

	

~
Preferences . . .



Search

Find . . . F
Change . . . €H
6010 . . . ~€G

Character

Plain tent
Bold
l talic
Underline

~~~~8a0

~d~J0©
Small Caps
Superscript
Subscript

Formats . . .

	

D

Paragraph

Normal

Left
[:entered
Right
Justified

Single Space
Double Space

Open Space
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Formats . . .

Tabs . . .

	

T

Document

Division layout . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Footnote . . .

	

'E
Running Head . . .

Repaginate #,J

Commands
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Menus

Word has seven command menus: Apple, File, Edit, Search, Character,
Paragraph, and Document.

•

	

The Apple menu is the same as in all Macintosh applications . The
About Microsoft Word command shows how much memory is used
by the program, and offers help about Microsoft Word .

•

	

The File menu commands are used to open and save documents and
windows, to print, and to end a session .

•

	

The Edit menu includes some familiar Macintosh editing commands
(Undo, Cut, Copy, Paste, Clear, Show Clipboard), as well as some edit-
ing commands that are unique to Word. The editing commands allow
you to edit or to use the Clipboard, glossaries, and ruler .

•

	

The Search menu contains the Find, Change and Go To commands, so
you can look for and change a particular word or phrase .

•

	

The Character menu commands change the appearance, size, and posi-
tion of your characters on the screen .

•

	

The Paragraph menu commands set alignment, indents, line spacing,
and tabs.

•

	

The Document menu commands are for designing complex docu-
ments. You can change the size of columns, number or renumber
pages, create and position footnotes and running heads .



Dialog Boxes

You will see the following features in dialog boxes :

Buttons

	

Most dialog boxes have OK and Cancel buttons ; a few have
other buttons instead . Click the OK button to carry out the
command. Click the Cancel button to cancel the com-
mand. If the button is outlined, pressing the Return or
Enter keys will carry out the command as well .

Other buttons are described under individual commands .

List Boxes

	

Dialog boxes often contain list boxes that list the items that
command acts upon (for example, documents, fonts, font
sizes). If the entire list doesn't fit, the list box will contain
scroll bars; scroll to see the rest of the list .

If a dialog box has a list box, click the response you want,
then click the OK button .

Text Boxes Some dialog boxes have text boxes in which you type a
number or some text. Word may propose a response ; if
you want to use this response, just click OK . If you want a
different response, type the new response . Use the Back-
space key to erase typing errors .

Check Boxes Some dialog boxes give you several options . To choose an
option, click in the check box next to it . In some cases,
the check box may already be checked, indicating that the
option or format has been chosen (or is a preset option) .
You can click OK to use this option or format; or you can
click in the box to turn the option "off." Some check boxes
may be gray when the dialog box appears. This means that
the selection contains more than one format or setting .
Clicking OK will not change the format of the selection
with reference to gray settings .

Commands
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About Microsoft
Word

About Mu rosoft Word . . .

Scrapbook
Alarm [Ion k
Note Pad
f dlc ulator
Key [ aps
f ontrol Panel
Puzzle

About Microsoft Word displays a dialog box with two kinds of information
about Word : the amount of memory used, and help .
The memory information can help you plan your documents . The dialog
box shows the total amount of memory available and the percentage of
memory used.

The help list box contains topics for which help information is available .
Click a topic on the list, then click the Help button . Word displays a win-
dow with information about that topic .

If you want to see information on another topic, click the Topics button
to see the list of help topics. You can also see the next help topic by
clicking the Next button; and you can see the previous help topic by
clicking the Previous button .

An alternative to choosing the About Microsoft Word command is to press
the Command-? (or Command-/) keys . The mouse pointer changes to a
question mark; then choose the command you want information about, or
click on the option or feature in a dialog box that you want details on .
When you release the mouse button, Word displays the help information
on the command or dialog box . If you asked for information about a dia-
log box, that dialog box stays on the screen, but is not active .

Once the help information appears, you can use the Next, Previous, and
Topics buttons as described above .

To cancel help and return to your work, click the Cancel button .

See Macintosh, your owner's guide, for a discussion of the desktop acces-
sories listed on the Apple menu .



New

File

New #.N

Open . . .

	

~&0
Close

	

8&W
Save

	

8€S
Save As . . .
Page Setup . . .
Print . . .

	

8~P
Print Merge . . .
Printer Setup . . .
Quit

	

~Q

Commands

The New command displays a new, empty document window .

If there is already a document on the screen, Word will lay the new, blank
window over the document on the screen. The first window is not erased
or replaced; it is below the new window .

If you already have four windows (including splits) open, you will not be
able to choose New; it will be dimmed on the menu . Close one of the
windows, and then choose New again .
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Open

File

New
Open . . .
Close
Save
Save As . . .
Page Setup . . .
Print . . .

	

~&P
Print Merge . . .
Printer Setup . . .
Quit

	

e~Q

The Open command gets a document from the disk and displays it on the
screen .

If there is already a document on the screen, Word will lay the new docu-
ment window over the document already on the screen.

When you choose the Open command, you will see a dialog box .

A Click the name of /he document you want fo open .
B Then click Open .

OR double-click on the document name.

The list box contains the names of all the Word documents on the disk . It
also includes any unformatted ASCII text documents ("text only" docu-
ments from Word, File, or Microsoft BASIC, for example) . MacWrite for-
matted documents will also appear in the list box .

The box has scroll bars that become active if there are more documents
on the list than can fit in the box .

Use this list box to select the document you want to open. To select a
document, click on the document name . Clicking twice selects and opens
the document in one step .

If the glossary window is open, choosing the Open command displays the
names of the glossaries on the disk (Standard Glossary plus any others you
might have saved separately) . When you click the Open button, the
selected glossary document is added to the glossary that is already in the
glossary window .

Eject The Eject button ejects the disk from the disk drive . You can insert
another disk; Word displays the list box for the documents on the other
disk.

Drive Click the Drive button to see the documents on the disk in the oth-
er drive. This button appears only if you have more than one disk drive .



Close

Seue As . . .
Page Setup . . .
Print . . .

	

8BP
Print Merge . . .
Printer Setup . . .
Quit

	

8~Q

Commands

The Close command closes the active document window, any of the spe-
cial windows, and the desk accessories .

The Close command can be used instead of the close box to make a win-
dow disappear .
If you close the only window on the screen, Word will display an empty
desktop. The only commands you will be able to use are Quit, and any of
the commands that open a window (for example: New, Open, Show Clip-
board, or Show Glossary) .

If you try to close a window that has unsaved changes in it, you will see
this message : "Save changes before closing window?" If you click Yes, the
changes will be saved . (If the document is untitled, you will see the Save
As dialog box.) If you click No, changes to the window are discarded .
Clicking the Cancel button cancels the Close command, and the window
remains open .

File
New 8~N
Open . . .
[lose
Save

#~th
8~S
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Save/Save As

File

New 8~N
Open . . . 0
Close

	

~W
Sue
Sdue us . . .
Page Setup . . .
Print . . .

	

8BP
Print Merge. . .
Printer Setup . . .
Quit

	

eBQ

The Save command saves the current document on disk.
If you are editing a document that has been saved before, you will not see
a dialog box or message . The Save command saves the document under
the name used the last time it was saved ; it overwrites the old version of
the document on the disk.

If you choose the Save command to save a new document, you will see
the Save As dialog box asking for the document name . Type the name,
then click the Save button .

The Save As command displays a dialog box asking for the document
name and lists some options. You can save the text without the format,
and you can choose to save a backup copy of a document .

A Type document a Click to save

	

C Click //'you
name here.

	

the document.

	

want fo save
to another disk .

Save Current Document as :

letter

	

4

Teet Only JMake Backup

BSave

C Cancel )

Word Disk
(
CEject

r

Drive

D Click to save

	

E Click to save a
text only

	

backup copy.
ono formatting).

F If you have an
external drive,
clicking the Drive
button saves to
the external drive .

Type a name for the document in the text box labeled "Save Current
Document as :" The name can be any combination of letters, numbers, and
symbols except the colon ( : ) .
If the document already has a name, Word will propose it . Click OK to
accept the proposed name, or type a new one to save the document
under a different name .
If the name you type has already been used for a different document on
the disk, Word will present a dialog box that says : "Overwrite existing
document?" Click Yes to replace the document on disk with the current
document. Click No to display the dialog box again . You can then type a
different name .
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After a document is saved, it remains on the screen . You can continue to
change it and save it again under another name if you want to keep dif-
ferent versions .
If you choose to save a backup copy of a document, it is named as "Back-
up of document name" . The version that is saved will be the last version
you saved . It will not contain editing changes made after you saved .

If you click next to "Text Only," formatting to your document will not be
saved. This option is useful for transferring Word text to other applica-
tions .
It is a good idea to save changes to your document often, especially if you
are moving or copying text to the document from another application or
another document .
If you run out of disk space while saving a document, you may find a
document on your disk called "Word Rescue" that contains as much of
your document as Word could recover. Your old version of the docu-
ment on the disk will not be affected. For information about storing docu-
ments on your disk efficiently, see "Appendix C, Disk Space and Memory ."
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Page Setup

File

New 2€N
Open . . . ~€0
Close W

Save S
Save As . . .
Page Setup . . .
Print . . .

	

8&P
Print Merge . . .
Printer Setup . . .

Quit

	

e~Q

The Page Setup command controls the appearance of the printed docu-
ment.

When you choose the Page Setup command, you see the following dialog
box :

A 84" wide, l I" high

a 514" wide, I4" high

C European standard,
8W' wide, l l %" high

D g/" wide, 12" high

Paper: 4® US Letter CC) A4 letter

i90 US Legal 170 International Fanfold

Orientation ; E®Tall

	

FO Tall Adjusted

	

0 Wide

Margins :

Top :

	

1"

	

left:

	

1 .25"

	

Gutter : f

Bottom : 1 "

	

Right : 1 .25"

H0K

[Cancel j

E Text prints length wise

	

Prints across the width of the
down the page .

	

page-the length ofpaper is
used for the width of theF Prints pictures in proportion .

	

document.

H Click OK when you have chosen your formats .

If you are using a printer other than the Imagewriter, this box may look
slightly different .

When you change the margins, the new margins are saved with the docu-
ment. Changes to all other Page Setup options remain set, and will be ap-
plied to other documents you print .
Margins The left, right, top, and bottom margins determine the amount of
space between the edge of the paper and the printed document . The
preset margins are one inch at top and bottom, and one and one-fourth
inches on the left and right sides . If you wish to change the margins, type
a number. Unless you specify otherwise, Word assumes the measurements
to be inches . To specify otherwise, type a unit of measure after the
number; or use the Preferences command on the Edit menu .
Minimum margins are one-fourth inch on the sides and one-half inch on
the top . Your printer may not be able to print this close to the edge of
the page, however .
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You can specify a margin in tenths of an inch (for example, 1 .5 represents
one and one-half inches) . Or you can specify any unit of measure in
points, centimeters, ten pitch, or twelve pitch .

You can also specify a gutter margin to allow extra space for binding . The
gutter margin is on the left side of odd pages and the right side of even
pages.
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Print

File

New

	

8BN

Open . . .

	

8B0
Close

	

8~W

Save

	

8BS

Save Rs . . .
Page Setup . . .
Print . . .

Print Merge . . .
Printer Setup . . .
Quit

	

eBQ

The Print command prints a copy of the current document . The Print dia-
log box controls these options :

A High qualify print (slow)

	

D Prints all pages in document
(preset)

B Preset option: Screen qua///y
(tas/er)

C Teal only, one size, plain text
plus bold and underline ,1t s/es/J

E& F Click to prinlpar/ of document
then specify page range .

1

B® Standard CC) DraftQualitq :

	

A D High

Page Range :P RII

	

E C) From :

Copies :

Paper Feed : H) Continuous ()Cut Sheet

To : F
( OK

	

)

Cancel

Specify how many copies
/oprin/.

H S'/andardprinlerpaper

If you use a printer other than the Image writer, this dialog box may look
slightly different .
Resolution is the number of dots used to form characters on the page .
High quality is dense with a large number of dots ; it prints slowest. Stan-
dard quality is less dense ; it prints faster than High quality . Draft quality is
least dense ; it prints fastest.

If you are using a daisywheel printer, see "Appendix E, Daisywheel
Printers." Also, see below for information on the Printer Setup command .

/ Single shee% ofpaper
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File

New

	

8~N

Open . . .

	

8~0

Close

	

W

Seue

	

8&S

Seue As . . .
Page Setup . . .
Print . . .

	

8~P
Print Merge . . .
Printer Setup . . .
Quit
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The Print Merge command prints multiple versions of a form document ;
each version contains variable information . A typical use for this com-
mand is to create personalized form letters . The main document, which
contains the standard text plus special fields and instructions, is combined
with a merge document containing the variable information . Print Merge
also lets you print several files as one document .

Main documents can contain fields and instructions. A field is a name for
one data item ; for example, <<address>> . An instruction tells Word to look
for something, or satisfy some condition, when inserting text from a
merge document .

A merge document contains , data that will be inserted into the main docu-
ment. The information is inserted in the fields . Each merge document
must have a "header record" that names the categories of information, us-
ing the same names used in the fields . The header record must be the
first data record ; all subsequent data records must list information in the
same order as the names in the header record . (For example, if your
header record contains the two field names "address" and "phone
number," you must always list the information in your merge document in
that order : 1928 14th Avenue, 333-9999.)
Each field name in the main document must match a field name in the
merge document . Or you can define a field by using a SET or ASK in-
struction .
Separate information in your merge document with tabs or commas . If
you want to include commas or quotes in the information you will insert
in the main document, you must surround the field with an extra set of
quotation marks . For example, if you wanted to place a comma between
city and state in an address, you would type : "Philadelphia, PA" .

When you choose the Print Merge command, you see a dialog box that is
identical to the Print dialog box . See the Print command for details on
the options available .
The following instructions can be inserted into the main document . They
are read by Word when the Print Merge command is carried out . The
boldface, lowercase words are general categories of text or information ;
you will replace these with your own prompts, fields, and so on .

Surround each instruction with <<>> . These special characters are foreign
quotation marks-press Option-Backslash (\) to get <<, and press Shift-
Option-Backslash to get >> .
The instructions need not be in any particular order in the main docu-
ment, except that the DATA instruction must be first .

Use any combination of capital or lowercase letters when you type in-
structions. (They are shown uppercase in this manual for emphasis .)
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<<ASK held = ?prompt>>
Field is any individual data item . Prompt is any prompt you specify . (The
first question mark after the equal sign is required . ) This instruction
prompts you for the contents of the field when the form document is
printed. Example : < ASK major account= ?Is this a major account? > will
cause this prompt to be displayed when the documents are merged : "Is
this a major account? Word will wait for your reply .
<<DATA header document merge document»
Merge document is the name of the merge document that you want to
combine with the main document. For example, << DATA orders >> merges
data from the merge document "orders."

You can use a "header" document name in addition to the merge
document name in the DATA instruction . To do this, type the header
document name immediately after the DATA instruction; for example, in
<< DATA birthdates employeefile >>, "birthdates" is the header document .
Using a header is helpful if you have a large merge document with many
fields and want to use only a few fields in the form document you are
printing right now. In the header document, type the field names separat-
ed by commas or tabs ; press the Return key to end the header document .
For the "birthdates" header document in the example above, you might
type these fields : name, date of birth

<< IF held = data> text . . . «ENDIF
This instruction sets up a condition under which the text you specify will
be printed if the information in the merge document meets a certain con-
dition . For example, if you want to include a personal note to a particular
person in a letter, you could type :

IF name = "Frank" >>Thank you for the bottle of
wine you sent John and me for Christmas . « ENDIF»

<<IF field =data>>text. . .<<ELSE>>text. ..«ENDIF»
This instruction specifies a condition under which the first text will be
used; if this condition is not met, then the text following <<ELSE>> is used .
«ENDIF» marks the end of the conditional instruction. Field is the name
of the field-for example, name . Data is the corresponding information in
the merge document. For example, if you wanted to insert a personal
note to John Smith in your form letter, you could use this statement :

<< IF name = "John Smith" > P .S. See you this weekend .
«ELSE »Please contact me if you have any questions . «ENDIF >>
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IF field < or > data»text . ..«ELSE»text. ..(<ENDIF>>
This instruction is used like the previous one, except that you can use a
mathematical comparison operator (greater than or less than) instead of
an equal sign to specify a condition. For example :

IF balance > "20000" >>If you do not pay the balance
within 10 days, your account will be sent to a
collection agency . «ELSE »Please contact us as soon
as possible to make payment arrangements .< ENDIF>>

<<INCLUDE document name
This instruction inserts the text of the document named in the instruction
into the main document . The text of the second document is inserted at
the location where the INCLUDE instruction is encountered. (The
number of documents you can include is limited by disk space only .)

<<NEXT>>
This instruction uses the next data record immediately instead of waiting
until the next copy is printed . This is useful if you want to print your data
out as a list in one document, instead of merging the data into a form
letter. For example, you may need to print out a list of all your clients in
one document, instead of sending a letter to each one of them .

<<SET field = information>>
Sets a field equal to information that does not vary from copy to copy .
For example : <<SET date = March 15, 1984>> would print the same informa-
tion (the date) on every copy of a form document .

<<SET field = ?prompt>>
This instruction displays a prompt that you specify whenever the field is
encountered. For example: <<SET date = ?The date is:>> would cause this
prompt to be displayed every time the << date » field is encountered : "The
date is :" Word will wait for you to type a date .
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Printer Setup

File

New

	

N
Open. . .

	

8~0
Close

	

8~W
Save

	

8&S
Save As . . .
Page Setup . . .
Print . . .

	

8~P
Print Merge . . .
Printer Setup . . .
Quit

The Printer Setup command indicates to Word which printer your docu-
ments will be printed on .

Word will use the printer driver that you last used, or the Apple driver
that is on your disk . It is a good idea to remove printer drivers you won't
use from your copy of the Word disk .

But if you switch back and forth between two printers (or more), use
Printer Setup to tell Word which printer and what sort of print wheel you
are using.
When you choose Printer Setup, you see this dialog box.

Click if you have a dai~ywheelprinfer.

Choose a p//oh fo match your print wheel.

OK

Cancel

When you print, Word uses the printer you most recently chose, unless
you specify otherwise in this dialog box .

Ordinarily, Word displays text as it will appear when you print. If you use
a daisywheel printer, your screen will reflect this . See the Preferences
command on the Edit menu for more information about the "Display as
Printed" option .

Printer Setup
-Pitch •

	

au
Image Writer

® 3W)
Brother

Q 17. . ~} f311€1
AppIeDaisy

Q 1x3 o i 1i111
NEC7710 o 24W)
Dieblo630
Typewriter o .lil Il i3
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Save Rs . . .
Page Setup . . .
Print . . .

	

~P
Print Merge . . .
Printer Setup . . .
Quit

Commands

The Quit command ends a Word session . If you have made changes to a
document without saving, Word will present a box that says : "Save
changes before quitting?"
If you click Yes, you will see a prompt for each document : "Save changes
to . . .?" You will be asked about each unsaved document you worked with
by name. You will see the Save As dialog box for untitled documents .

If you have several windows on the screen, you will be prompted to save
each one individually . The window will move to the top as the prompt
for that document is displayed .

The Clipboard is saved when you quit Word, whether you save your docu-
ment or not . See the Show Clipboard command in this section for infor-
mation on using the Clipboard .

If you have any unsaved changes to the glossary window, you will see a
prompt to save your glossary entries as well .

If your Word disk has been made into a startup disk (with the Macintosh
Set Startup command) and the Finder has been removed, the Word disk
will be ejected . You will be prompted to insert a disk with a Finder. See
"Appendix C, Disk Space and Memory" for information on making your
copy of the Word disk into a startup disk .
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Undo

Edit

Undo Copy 8BZ

Cut ~H
Copy ~C
Paste 8CV
Clear 8BB
Show Clipboard
Show Glossary

. . . . .. . . . . . . . . . . . . . . . . .. . . .. . . . . . . . . . . . . . . .. . . . . . . . . .. . . . . .

Show Ruler 8~R
Hide 9l
Preferences . . .

The Undo command reverses the last editing or formatting action. You
can also undo the Change command on the Search menu . In some cases,
Undo puts the previous contents of the Clipboard back in the worksheet .
The command that will be reversed appears after Undo on the menu (for
example, Undo Paste).
When you are typing in the document, the command on the menu be-
comes Undo Typing, which discards the information you just entered . If
the most recent command cannot be undone, the Undo command be-
comes Can't Undo, and will be dimmed on the menu .

Once a command has been undone, the Undo command changes on the
menu to Redo followed by the name of the reversed command (for exam-
ple, Redo Typing). Redo stays on the menu until you choose another
command. Redo can also be undone .



Cut/Copy

Show Clipboard
Show Glossary

Show Ruler IR
Show 8~Y
Preferences, . .

Commands

The Cut command deletes selected text and puts it in the Clipboard, re-
placing anything that may already be there. Use the Cut command when
you want to move text from one part of a document to another, from one
document to another document, or from one application to another . You
can also use Cut to remove a glossary entry.

The Copy command copies a selection and puts it in the Clipboard .

Both Cut and Copy can be reversed with the Undo command, as long as
you don't choose another command before choosing Undo .

Once the selection is cut or copied, you can paste it into an insertion
point; or you can paste it into a selection to replace the selection. (A
copy of the text remains in the Clipboard until something else replaces
it.) See Chapter 6, "Editing With Word" for more information .

If you cut or copy from one part of your document to another part, or
from one document to another, formatting will be moved or copied also .
But if you move or copy from one application to another, formatting will
be lost.
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Undo Copy 8B2
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Paste 8BU
Clear l8
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Paste

Edit

Undo Copy 8BZ

Cut
Copy
Paste #.U
(leer lB
Show Clipboard
Show Glossary

Show Ruler IR
Show 9 8~Y
Preferences . . .

The Paste command inserts the contents of the Clipboard into an insertion
point or a selection .

If you use Paste to insert into a selection, the selection will be completely
replaced by the contents of the Clipboard .

You also use the Paste command to move your glossary entry text into the
glossary window. See the Show Glossary command for more information .

Whenever you are pasting text in your document from another document,
it is a good idea to save after you paste .



Clear

Show Clipboard
Show Glossary

Preferences . . .

Commands

The Clear command erases the selected text without storing it in the Clip-
board. Use the Clear command for deleting text from a document per-
manently. You cannot use Clear to move or copy .

The erased contents can be retrieved by choosing the Undo command
before choosing any other command.

Show Ruler 8BR
Show 8~Y

Edit
Undo Copy 8BZ

Cut 8~H
Copy 8~C
Paste
f IPar

8BU
;#;R
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Show Clipboard

Edit

Undo Copy 8BZ

Cut
Copy

Paste
Clear

8~C

8~U
8~B

Show [ lipbodr l
Show Glossary

Show Ruler 8~R
Show 9 8~Y

Preferences . . .

The Show Clipboard command opens the Clipboard window . The Clip-
board window shows the text that was most recently cut or copied . You
cannot edit the contents of the Clipboard window .

To close the Clipboard window, click its close box or choose the Close
command from the File menu .

Use the Clipboard to move copy from one place to another . The Clip-
board can be particularly useful for moving copy from one Macintosh ap-
plication to another .



Show Glossary

hut

Undo Copy 8BZ

Cut ~H
Copy ~C
Paste 8BU
Clear lB
Show Clipboard
5hou' tlossar y

Show Ruler IR
Show 8~Y
Preferences . . .

The Show Glossary command opens the glossary window. This is the only
way you can open the glossary window; you cannot use the Open com-
mand to open the glossary window, nor can you open it from the Finder .

The glossary window is similar to the Scrapbook, except that you can
specify individual glossary entries by name, then insert the text that
corresponds to the name into a document by pressing the Command-
Backspace keys. You can insert this text whenever you want, without
opening the glossary window .

The Show Glossary command displays this window :

A Type /he name of /he glossary enfry here . Vu can type up fo 64 eharacfers.

B L/sf box displays glossary names .

Commands

page This is a predefined glossary name. When you type page and ex-
pand it by pressing Command-Backspace, it appears in the document as
(page) . When you print your document, Word replaces (page) with the
appropriate page number . You can include this glossary name in your
running heads to embed page numbers in the running head .
footnote This is a predefined glossary name. When you type footnote in
the footnote window and expand it, the word "footnote" is replaced with
the automatic footnote number . Use this glossary to insert a footnote
number in the footnote window .

To add entries to the glossary window, type the text in a document and
then select it. Then use Cut or Copy to move the text to the Clipboard .
Choose the Show Glossary command to open the glossary window, and
name the new glossary. Use the Paste command to paste the glossary text
into the window from the Clipboard. The text appears below the glossary
name. The glossary name appears in the list box . The size of the glossary
text is limited only by disk space .

Ilossary-

Name of Glossary : page

4 footnote a

n
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Any character or paragraph formatting applied to the glossary text before
you copied or moved it to the Clipboard is kept in the glossary window .
These formats are not displayed in the glossary window, but when you ex-
pand the glossary entry, the formats appear in the document window .
(You may need to turn "off" these formats to continue typing or editing .)

You can also move or copy pictures into the glossary window ; they will
always appear at the top of the glossary entry text .

To remove entries from the glossary window, open the window and then
click the glossary name you want to delete in the list box . Choose the
Cut command to delete the glossary name and entry .
To replace the text of a glossary entry, paste new text over the old . You
cannot edit text in the glossary window .

Use the Save As command to save your new glossary entries. Usually, you
will save your glossary entries in the Standard Glossary document. This is
a special document that Word loads automatically . When you are prompt-
ed to save, or when you choose Save As, Standard Glossary is the pro-
posed document name . If you want to save your glossary entries in a
separate glossary document, type a name when you are prompted to "Save
Current Glossary as :"
Open a separate glossary (not stored in Standard Glossary) by opening the
glossary window, then choosing the Open command . The separate glos-
sary will merge into the glossary that was already loaded into the glossary
window (usually Standard Glossary).



Show Ruler

Show Clipboard
Show Glossary

Show Ruler
Show

	

81 ~
Preferences . . .

Commands

The Show Ruler command displays the ruler . Indents and tab stops are
shown just below the inch marks .

Ruler

Left indent

Frsf line indent

	

Thbs

	

Right indent

You can use This ru/er to indent or set fab stops.

The indents and tab stops reflect the settings for the first selected para-
graph or the paragraph containing the insertion point .
You can move indents or insert, delete, or move tab stops on this ruler .
You can also use the Paragraph Formats command or the Tabs command
to adjust indents and tabs on the ruler . If you make a change on the ruler
to indents or tabs, the change will be applied to the entire selection .
When the ruler is on the screen, the command on the menu changes to
Hide Ruler. The ruler is calibrated in inches .
To change to another unit of measure, use the Preferences command on
the Edit menu .

Edit
Undo Copy 8~Z

Cut 8BN
Copy ~C
Paste 8BU
Clear 18
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Show ¶

Edit

Show Ruler IR
Show Si

	

:# Y
Preferences . . .

You can look at formatting characters that are normally invisible with this
command. The characters that are displayed when you choose the Show
¶ command are :

¶

	

The paragraph mark; insert by pressing the Return key .

New line; create by pressing Shift-Return .

Space; insert by pressing the spacebar .

3 Tab; insert by pressing the Tab key.

Fixed-size nonbreaking spaces are displayed as blank spaces (regular
spaces appear as dots). Use Command-spacebar to insert a fixed-size
space .

These invisible characters can have character formats . The paragraph
mark stores paragraph formatting as well .

After you choose Show ¶, the command on the menu changes to Hide ¶ .
Choose this command to make these characters invisible again .

Undo Copy 8BZ

Cut ~H

Copy 8BC

Paste 8BU

Clear lB

Show Clipboard
Show Glossary



Preferences

Edil
Undo Copy 8BZ

Cut 8BN
Copy ~C
Paste 8BU
Cleor l8
Show Clipboard
Show Glossary

Show Ruler IR
Show 9 8~Y
Preferences . . .

Use this command to change the preset unit of horizontal measure . Word
assumes that all horizontal position measurements that you type in text
boxes are inches, unless you specify otherwise . You can specify different-
ly in each individual text box . Or you can choose one of the following
options from the Preferences dialog box .

A Preset measure
8 Centimeters
C l D p//oh
D l2 p//oh
E (/172/rich)

Preferences
-Measure

4 ® Inch
a 0 Cm .
C O P 10 F 0 Screen Draft
D C)P12 ~~Di spl ay as Printed
E 1 Points I
II

Cancel

Commands

F Click fo make Word run faster if you are using several foal . This results in
lower qualify display.

Click fo disable printer qualify screen. You may see formal /ha/ are
unavailable for your pr/n/er .

Word uses lines as the vertical unit of measure within a paragraph . Word
adjusts spacing between lines automatically . If you want to specify a fixed
line height, use the Formats command (Paragraph menu) .

If you change the preset unit of measure with this command, the unit of
measure in Page Setup, Formats ( Paragraph ), Tabs, and Division Layout
will be changed. Settings you change with Preferences are not saved with
the document . Word saves the Preferences settings from one session to
the next, and applies the settings to all documents .

The "Screen Draft" option makes the Word program run faster. You will
not see a print quality screen in the document window . In particular,
characters displayed in font sizes larger than 12 points will look ragged .
The quality of printing will not be affected . Use this option when you are
editing a document with several fonts and font sizes . 227



Word Reference

The "Display as Printed" option displays text on the screen as it will ap-
pear when you print. This is the preset option . This means that the
appearance of your screen may vary, depending on which printer(s) you
are using. This option is especially useful for previewing line breaks . You
can click to turn this option off if you want to see fonts or sizes that your
printer doesn't use, or to make your display more legible .

The "Display as Printed" and "Screen Draft" options do not affect each
other.



Find

Search

Find . . .
Change . . . 8~H
Go To . . .

	

G

Use the Find command to search for text in a document . You can specify
any text you wish-a character, a word, or paragraph up to 255 charac-
ters. You can use the "wild card" character ? (question mark) also . Word
finds and selects the first occurrence, then scrolls to the next occurrence
when you click the Find Next button .

When you choose the Find command, you see this window . You can
move and close this window just as you would any other .

A Type the search text here. You can type up /o
255 oharaofer~-the text will

	

/oroll fo the left as you type .

B Cliok fo ~eleof disfinof words only riot text
embedded within other text.

D	Find	

the AFind What :

BQ Whole lllordG' Q Match Upper/Lowercase

Find Next

C Cliok fo find only the arrangement o/
oaps/ foweroase typed in the "Find What: "box.

When you click the Find Next button, the search starts at the insertion
point. If you have a selection, the search starts at the end of the selection .
The search continues to the end of the document. Then Word goes back
to the beginning of the document and continues finding text until it
comes back to the point you started at .

Commands
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Find Next Click this button to continue finding after each occurrence of
the text is selected .

You can cancel the search at any time by pressing Command- .(period) .
If the text is not in the document, you will see the message : "Search text
not found." You will see the message "Search complete" when Word gets
back to the insertion point.

You can also search for special characters . Use the key sequences in the
table below to search for these characters :

Type. . . To search for:

Aw

	

white space

s

	

fixed-size nonbreaking space

At

	

tab

p

	

paragraph

n

	

new line

-

	

optional hyphen

d

	

division mark



Change
Sears h

Find . . .

	

8~F

Change . . . #:N

Go To . . .

	

8BG

The Change command can be used to find and change text selectively ; or
to replace all occurrences of the search text . You can specify any text
you wish-characters, words, even paragraphs . You can also change all
occurrences of text within a selection .

See the Find command for information on wild card characters and for de-
tails on searching for special characters .

When you choose the Change command, the Change window appears on
the screen.

Press the Tab key /o go back
and forth between text boxes .

C Click fo fi'nd and change
those occurrences /ha/
are distinct words only.

(Otherwise, Word finds and
changes search text when
if occurs within a word
e.g., is within display)

A Type the text that you
want fo f'nd

B Type the replacement text .

If you leave this box blank, the
search text will be deleted

Change

Find What :

Change. To :

C 0 Whole Word

Find Nent

A
B

(Change, then Find
DLJ Match Upper/Lowercase

Change Change RII

Commands

D Click fo find only the arrangement
of upper- or lowercase you specify.

(Otherwise, Word ignores capifalizafion
when searching for characters . f

If you leave the "Change To :" box blank, the search text will be deleted .
Word starts the search at the insertion point. It continues to the end of
the document, then goes back to the beginning of the document and con-
tinues until it reaches the insertion point again.
If there is a selection in the document window, Word finds and changes
within the selection only . The Change All button reads Change Selection .

231
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Find Next Click this button to start a search ; or to go to the next oc-
currence of the text without changing .

Change, then Find Click this button to change the selected text and
then go to the next occurrence of the search text . Word selects the next
occurrence without changing it .

Change Click this button to change the selection only .

Change All Click this button to change all occurrences of the search text
in the document.
Change Selection If there is a selection in the document window when
you choose the Change command, the Change Selection button appears
instead of Change All . Clicking this button changes all occurrences of the
search text within the selection only . Word stops the search at the last
character of the selection .

As you find and change text, Word scrolls to the next occurrence of the
text automatically .

If you are changing all occurrences of the text, the document will not
scroll, and the entire document will be selected .

You can cancel the search at any time by pressing Command- .(period).

You can also reverse any changes you make with this command with the
Undo command on the Edit menu .
If the text is not in the document, you will see the message : "Search text
not found." You see the message "Search complete" when Word com-
pletes the search and comes back to the insertion point .



GoTo

Sean h

Find . . . 8BF
Change . . . 8~H
Go To . . .

Use the Go To command to go to the page number you specify. This
command can be used in any document that has been printed or repa-
ginated.

Type the page number you wan/ to go /o . .

6o To

Page Number :

OK

ante

. . /hen click OK.

Commands

When you click OK, Word goes to the page you specify in the text box .
The first word on the page is selected .

If you type a number greater than the number of the last page, you will go
to the last page in the document .
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Plain text/Bold!
Italic/Underline!
Outline/Shadow!
Small Caps!
Superscript!
Subscript

Character
Plain tent
fluid
l to/it
Underline
Oa~00ao

Small Ceps
Superscript
Subscript

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Formats . . .

	

D

These Character menu commands are used to format characters . Charac-
ter formats are saved with the text when you save a document . They are
also kept when you copy or move formatted characters into unformatted
text or text that is formatted differently .

When you want to change the format of the selected text, you can choose
the appropriate command from the Character menu . A check appears on
the menu next to the command that is in effect . (This does not occur if
the selected text has two or more character formats ; in this case, no
check appears .)
If you choose a command that is already checked, this reverses the effect
of that command and removes the character format .
If you want to assign a more complex design, or change font and size,
choose the Formats command on the character menu .
Plain Text removes all character formatting except font and font size
changes from your text .

The Bold command changes the selected text to boldface.

The Italic command changes the selected text to italic .
The Underline command underlines the selected text.

The Outline command reverses characters to display white characters out-
lined in black .

The Shadow command reverses characters to display white characters
with a heavy three-dimensional outline .

The Small Caps command displays selected text in smaller size capital
letters .
The Superscript command raises the selected characters above the base-
line of the text. The superscript appears in a smaller size .

The Subscript command lowers the selected characters below the base-
line. The subscript appears in a smaller size .



Formats

Character

Plain tPHt

lout
l talii
Underline
004~~0~
OdOdO©
Small [ups
Superscript
Subscript

Formats . .. 3D

The Formats command controls all aspects of character design . If you
want to quickly assign one format to text, you can use the menu item .
But if you want to assign several types of character design to one
selection-for example, to make text bold, italic, and underlined-you
would use the Formats command. You also use this command to change
font and font size .

It is also a good idea to use this command to remove character formats if
you don't want to go back to plain text .

When you choose the Formats command, you see this dialog box :

A Clink on name to go between "Yes "and ' Wo.
B Click fo change these character styles .
C Click fo position oharacfers .

Charec:ter Formats
StgIeA	
[]Bold

BLJ Italic

0 Underline

	

1osition
fl Small Caps C,• Normal
Q Outline

	

Superscript
Q Shadow

	

Subscript

Font Name :

Font
Size :

ChicagoChicago
New York
Geneva D
Monaco

t

i

9
10

1 4

Cancel )

12 E

D Scroll to see fonts and sizes. Clink fo choose a font or sire.
E Type a font size here .

At the top of the box are buttons for character formats. These correspond
to the menu commands. Click the formats on or off.
Below the buttons is a list box containing the fonts available with the
Word master disk. (The fonts may vary, according to which version of
the Macintosh system you have .) Some of these fonts are :

Commands
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Font

Chicago

New York

Geneva

Monaco

Dover 8

Dover 10

Dover 12

Dover PS

Description

System font

Roman (serif)

Sans-serif

Monospace

Daisywheel 15-pitch

Daisywheel 12-pitch

Daisywheel 10-pitch

Daisywheel proportional

Your disk may contain additional fonts for daisywheel printers as well .
The fonts and sizes are in the System folder on the Word disk . You can
use the Font Mover utility to add or remove fonts .

When you choose a font from the list box, the list of sizes at the right side
of the box is updated to show which sizes are available for this font . You
can choose a font from this list . To the right of the list box is another
text box labelled "Font Size :" . You can also specify any size in this box . If
you specify a size that is not available for a particular font, Word will scale
one of the available sizes to correspond to the requested font size . (The
results may look ragged .)

The Formats dialog box reflects the character formats that are in effect for
the selected text. However, if you have two or more formats in the selec-
tion, the check boxes will be gray . The character styles of the selected
text will not be affected when you click OK, unless you click the styles on
or off.



NormaULeft/Centeredl
Right/Justified!
Single Space/Double
Space/Open Space

Paragraph

Normal

left
[entered
Right
Justified

Single Space
Double Spare
Open Spate

Formats . . .

Tabs . . .

	

~€T

Commands

The Paragraph menu commands control the arrangement of lines and para-
graphs on the page . These commands affect the paragraphs that contains
the selection or the insertion point.

You specify paragraph breaks by pressing the Return key . You can see the
paragraph mark by choosing the Show ¶ command from the Edit menu .

You can format paragraphs two ways : by choosing the commands from the
menu, or by using the Formats command . You choose the Formats com-
mand when you want to assign more than one paragraph format at a time .

The Normal command sets all paragraph formats to the preset alignment
and spacing. It does not affect tabs . The "normal" format is aligned left,
unjustified, and single spaced .
The Left command aligns text in the selected paragraph flush left on the
margin .

The Centered command centers the selected text in the text area .
The Right command aligns text in the selected paragraph flush right on
the margin .

The justified command justifies the paragraph-that is, it fills in the spaces
between words to align the selected paragraph on the left and right mar-
gins .

The Single Space command sets the line spacing to single spacing- that
is, no extra space between lines . If the line includes different font sizes,
the height of the line will vary to accommodate the tallest character in
the line. To set fixed spacing, see the Formats command (Paragraph
menu).

The Double Space command adds extra space between each line of the
selected paragraph . The line spacing is fixed at three lines per inch .
The Open Space command adds an extra line space before the paragraph .
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Formats

Paragraph

Normal

left
Centered
Right
Justified

Single Space
Double Space
Open Space

Formats . . .

Tabs . . .

Use the Formats command when you want to change several aspects of
paragraph format at once .

When you choose the Formats command, the ruler appears at the top of
the current document window, and you see the dialog box on the oppo-
site page .

The left and right indent markers are the triangles at either end of the
ruler. The first indent marker is the small square-you usually can't see it
until you move the triangular marker away from it .

You can indent or change indentation by dragging the indent markers
with the mouse. Clicking in the ruler inserts a tab marker (see the Tabs
command for more information) .

Word adjusts line spacing automatically for you the "Line Spacing:" text
box contains the word "auto ." Line spacing is usually the same
throughout the document. But if you want to insert a word 18 points
high in a line of text, Word will adjust the line spacing for you .

If you want to specify the line spacing, simply type a number (and unit) in
the "Line Spacing:" text box, and Word will not adjust line spacing for
you. You can also specify spacing before and after a paragraph with the
"Space Before :" and "Space After :" text boxes.

Word automatically avoids "widow" and "orphan" lines when printing; you
can also use the "Keep lines together" option when you have two or more
lines in a paragraph that need to remain together on a page . For example,
if Word reaches the end of the page, and you have assigned this option to
a paragraph that would have been split, then the entire paragraph will be
moved to the next page .

Use the "Keep with next ¶" option when you have two or more para-
graphs that should be kept together on a page-for example, a table with
text explaining it .
Your changes take effect when you click the OK button. If you click Can-
cel, changes to the ruler will be cancelled as well as changes in the dialog
box .

If your selection includes paragraphs with different formats, the dialog box
will not reflect any formatting ; the text boxes will be blank .



A Type a number to indent paragraph from left margin .
B Type a number to indent first line of a paragraph .
C Type a number to indent text from right margin .

Paragraph Formats

Left Indent :

First Line :

Right Indent :

~) ieri

	

U tirgni

0" 4
0" B
0" C

~t
fontnrnv1 (ml (~~r4ifinr~

Line Spacing :

Space Before :

Space After :

auto/7

0li E

O li F

U Keep wun next
n Vnnn Iinnr ~nnn

~OK D
Cancel

D Wordadjust line spacing automatically, as' the preset
option. Type a number to set a fixed line height.

E Type a number to insert extra space above a paragraph .
F Type a number to insert extra space below a paragraph .

Paragraph Formats

•

	

l I IIUGIi I . ~ U . .)

rst line :

1Oleft

	

/Right
HC)CenteredJ) Justified

6 Paragraph aligns
flush left

H Paragraph
is centered.

/ Paragraph aligns
flush right.

LIIIC JpUL •! I J .

Space Before :

UU .U

Oil
In ,~

Cancel

KEKeep with neat 91
L

	

Keep lines together

J Paragraph aligns on left
and right.

K Keeps two or more
paragraphs together on a page.

I Keeps lines in a paragraph
together on a page.

Commands
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Tabs

Paragraph

Normal

left
[:entered
Right
Justified

Single Space
Double Space
Open Space

Formats . . .

Tabs . . .

	

,T

Use the Tabs command to align text on tabs . Tabs apply to the selected
paragraphs. You can have several different tab settings for a document (or
different tab settings for each paragraph, if you like) .
When you choose the Tabs command from the Paragraph menu, the ruler
will appear at the top of the screen, and you see this dialog box .

A Text aligns /lush left on tab stops.
B Text is centered on tab stops.

Tabs

~Rlignment_

,4c ) Left
94. 0 Center

C ~ 0 Right

D y 0 Decimal
I'

i) Blank1r`
rS ,,	

V 1\

Cancel

Position :

C Text aligns flush right on tab stops.
D Pee/ma/point align on tab stops .

E A "leader" eharacter fills the spare between tab stops.
F Blank spare between tabs
d Line ofperiods between tabs

Tabs E-

~leeder,

F Blank

/0

CancelC
Position :

J

H Hyphens between tabs
l solid line between tabs
J Type a number (and unit, if you wish) to Qpeei/y tab

position. Changes on the ruler are reflrr/ed here as' well .
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You can choose the sort of tab you want : left aligned, right aligned, cen-
tered on the column, or aligned on the decimal point . You can also
choose the kind of leader character you want to fill the space between
tabs. You can change the leader character or alignment for tab stops
within a paragraph if you want-for example, within a line of text you
could align some tabs flush left and others on the decimal point .

The ruler shows about six inches of text . Indents and tab stops appear
just below the measurements on the ruler . Indents are preset to zero, and
tab stops are preset at every half inch. You do not see the preset tabs on
the ruler .
Click with the mouse on the positions where you want to set tab stops .
The sort of tab inserted depends on your choices in the Tabs dialog box .
To set the tabs, click the OK button . If you click Cancel, your changes
are cancelled and the tabs go back to the previous settings .

If you want to use a unit of measure other than inches, type the position
plus a unit of measure in the "Position :" text box, then click OK . You
need to repeat this for each tab you want to set . You can also use the
Preferences command to change all units of measure .

You can see tab stops on the ruler when you choose the Show Ruler com-
mand from the Edit menu. You can also set tab stops by choosing the
Show Ruler command, then clicking and dragging the tabs with the
mouse. To move tabs, click and drag the tab stops to the new position .
To delete tabs, click and drag the tab stops off the ruler .

Indents also appear on the ruler . Use the Formats command on the Para-
graph menu to set indents; or drag them with the mouse while you are us-
ing the Tabs command .
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Division Layout

Doc ument

Division layout . . .

Footnote . . .

	

~€E
Running Head . . .

Repaginate ~€J

The Division Layout command controls pagination ; positions of page
numbers, running heads, and footnotes; how many columns appear on the
page ; and how the division will break pages . When you create a division
within your document, use the Division Layout command to specify how
the page layout for the new division will vary from the layout for previous
pages .

When you choose the Division Layout command, you see the dialog box
illustrated on these pages .

Press the Command-Enter keys to insert a division mark ; the division mark
ends the old division format . If you choose the Division Layout command
and your document contains no division marks, Word will insert a division
mark at the end of the document when you click OK . Word stores divi-
sion information with the division mark . You can move or copy the divi-
sion mark just as you would any other character .

See the Footnote command for information on creating footnotes .

See the Running Head command to create a running head and specify
where it will appear in relation to the document text .

See the Page Setup command for information on setting page margins.

AE Auto Page Numbering :

From Top: 80 .75"

From left :C7 .25"

Start Page Numbers At : Number of Columns :

Column Spacing :

Running Head Position :

From Top :

	

E0.75"I
From Bottom : F0 .75"

l

y0 .5 "l

A Click for automatic page number .
8 & C Specify page number position from fop and left.
D Type a page number /hat will start division .
E & F Specify a number and unit for position from edge ofpage .
&H /Dumber of columns on page and amount of spaoe between them .

vision LeyouI OK
creak Number_Page Format

i Continuous c! Numeric Cancel

Column
) Page

Roman lupperl
Roman tlowerl _Footnotes Appear-

Odd
)Even

' Alphabetic

o Alphabetic
(upper)
(lower)

® On Same Page

0 At End of Division



l IVew division format doesn 't start until beginning of next
page after the division break .

J Division break causes a new column to be starter, with
new division format.

K fkually, Word starts a new page at division break.
L New division Marts on next odd numberedpage.
M New division starts on next even-numbered page.

Division layout

r Break

/ 0 Continuous

JO Column
K Page
L O Odd
/VIQ Even

. VY V' , \V . . . V `'I . . .yI

rom Top :

rom left :

•

	

1,2,3,4 . . .
•

	

1,11,1/1,/V . .

	

.

•

	

,./,;///,/v . .

	

.
•

	

A,B,C,D . . .

0 .75"

7 .25"

age Numbers At :

OK
rPuge Number Format_.

~N • Numeric

00 Roman (.upper)
P Roman (lower)

	

Footnotes Appear

Q Alphabetic (upper)

	

® On Same Page
RO Alphabetic: (lower) SQ At End of Division

Ilullllllly ii uu 1 t, . . uull

From Top :

	

10.75"

From Bottom :

	

0.75"

Number of Columns :

	

1

f ,Limn Cnnrinn •

Cancel

I n r"

R a,b,c,d . . .
c Click to place footnote at

end of document or division .

Commands
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Footnote

Document

Division layout . . .

Footnote . . .
Running Heed . . .

Repeginete 9€J

Use the Footnote command to create a footnote, open the footnote win-
dow, and specify whether you want automatically numbered footnotes.

To create a footnote, first select an insertion point in the document text
that you want to reference . Then choose the Footnote command. You
will see this dialog box .

A Word automatically numbers footnotes for you . .

I
A ® Auto-numbered Reference

or

Footnote Reference Merk :

OK

Cancel )

B

B . . . but if you don "f want automatic numbers,
type a reference mark here .

Word creates automatically numbered footnotes, or you can type the foot-
note reference mark (up to ten characters long) in the text box . Your
number or reference mark appears in the document text . It is super-
scripted and in a smaller font .

At the same time, the footnote window opens and the same number or
reference mark appears there . Type the footnote text . There is no limit
to the size of the footnote text.

You can also open the footnote window without creating a new footnote .
Press the Shift key while clicking and dragging the split bar down . When
you release the mouse button, the footnote window will open . To close
the window, click and drag the split bar to the bottom of the window .

To delete a footnote, delete the reference mark in the document text . If
you have automatically numbered footnotes, the numbers around the
deleted footnote will adjust automatically . You cannot delete the footnote
completely by deleting the text in the footnote window-you will not be
able to delete the last paragraph mark of the footnote text .
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If you already have four windows (including special windows and split
windows) on the screen, the footnote window will not appear . However,
your footnote will still be created .

You can also expand and contract the footnote window using the mouse
and the split bar .

If you change the format of the number or reference mark in the docu-
ment text, this change will not be reflected in the footnote window .
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Running Head

Document

Division ragout . . .

Footnote . . .

	

8€E
Running Heed . . .

Repaginate

	

J

Use the Running Head command to create running heads ("headers" and
"footers" ) and to specify where you want them to appear in relation to the
document text. The running head can have any format you like .
To specify where running heads will appear in relation to the top and bot-
tom of the page, use the Division Layout command . To specify a position
from the left and right edges of the page, use the Formats command on
the Paragraph menu to indent running heads just as you would any other
paragraph . Note that the ruler shows the position of the running head in
relation to the edge of the paper, not to the margins . (Changing the mar-
gins has no effect on running heads .)

To create a running head, select the running head text in the document or
type the running head text. The running head should be a separate para-
graph; it ends with the paragraph mark, and can be formatted like any
other paragraph. Then choose the Running Head command from the
Document menu . You see this dialog box .

A Running heads can appear on even, odd, or first pages
or on all pages.

Running Head

-Occurs on
A

Odd Pages
® Even Pages

First Page

OK

Cancel

Position
® Top a

Bottom

J

B You can have running heads of the /op or bo//om of the page .

Specify whether you want running heads to appear at the top or bottom of
the page. Also specify whether you want them to appear on odd and even
pages, and on the first page of the document or division . The preset op-
tions are running heads at the top of odd and even pages, except for the
first page.
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To print running heads at the top and bottom of a page, type the text as
two separate paragraphs ; then specify the positions separately, placing one
at the top of page, and one at the bottom . If you specify a running head
to appear on the first page, then the running head text must be at the top
of the first page of the document or division .

When you make a paragraph into a running head, it will no longer be
printed in the body of the text . It will appear only in the specified posi-
tion for the running head. Word displays running heads with a « in the
left border of the window .

To change a running head back into normal text, choose the Running
Head command, and specify that the running head appear in none of the
available positions .
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Repaginate

	

Use the Repaginate command to see how editing changes made since
printing will affect page breaks. You can also use Repaginate to see where
page breaks will occur in an unprinted document .

The Repaginate command does not affect page breaks that you insert by
pressing Shift-Enter . These pages remain the same ; those around them
may be adjusted .

When you choose the Repaginate command, the page break symbols in
your document-the equal signs in the left margin-are adjusted to reflect
the new pagination . Page breaks are stored with your document .



Appendix A
Key Sequences

You may prefer to use the keyboard to perform a task-for example, to
format as you type . With Word, you can use key sequences as well as the
mouse for word processing tasks .

Commands
You can choose these commands by pressing Command key sequences in-
stead of choosing from the menu .

To choose . . . Press: To choose . . . Press:

New Command-N Clear Command-B

Open Command-0 Show Ruler Command-R

Close Command-W Show ¶ Command-Y

Save Command-S Find Command-F

Print Command-P Change Command- H

Quit Command- Q GoTo Command-G

Undo Command-Z Formats (character) Command-D

Cut Command-X Tabs Command-T

Copy Command-C Footnote Command-E

Paste Command-V Repaginate Command -J
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Editing Keys
You can use the following editing key sequences as you type :

To insert . . .

Nonbreaking fixed space

Page break

New line

Optional hyphen

Expanded glossary name

New division

Leading "merge print" quote

Trailing "merge print" quote

Again key
(Repeats your last action)

Press:

Command-spacebar

Shift-Enter

Shift-Return

Command-hyphen

Command-Backspace

Command-Enter

Option-Backslash

Shift-Option-Backslash

Command-A



Character Formats
You can format characters by pressing these key sequences as you type :

For this format . . .

Boldface

Italic

Underline

Shadow

Outline

Superscript

Subscript

Small caps

Decrease font size

Increase font size

Font change

Erase character formats
(except font)

Press:

Command-Shift-B

Command-Shift-I

Command-Shift-U

Command-Shift-S

Command-Shift-D

Command-Shift- _

Command-Shift-hyphen

Command-Shift-K

Command-Shift-

Command-Shift- >

Command-Shift-E-number

Command-Shift-spacebar

Key Sequences

Fonts available on the Word master disk may vary . The numbers for the
fonts may include the following :

o = Chicago
1 - New York
2 Geneva
3 Monaco
4 - Dover
5 Dover PS
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Paragraph Formats
You can format paragraphs by pressing these keys as you type :

For this format:

Erase paragraph formats
(normal)

Left aligned

Right aligned

Centered

Justified

Open spacing

Indent first line .5"

Nest paragraph .5"

Unnest paragraph

Hanging indent

Press:

Command-Shift-P*

Command-Shift-L

Command-Shift-R

Command-Shift-C

Command-Shift -J

Command-Shift-0

Command-Shift-F

Command-Shift-N

Command-Shift-M

Command-Shift-T

*If you select a picture, pressing Command-Shift-P restores the picture to
its unscaled size .

Mouse and Key Combinations
To. . .
Copy selection

Move selection

Copy format to selection

Press :

Option + click

Option-Shift + click

Option-Command + click



Appendix B
Preset Options

Word uses some standard preset formats for documents. In most cases,
these settings will be fine for your documents . Changes to character,
paragraph, document formats, and margins are saved with your document.

Page Setup

Margins

	

Top = 1 inch
Bottom = 1 inch
Left = 1 .25 inch
Right = 1 .25 inch

Paper

	

US Letter
8 112" x 11"
Printed lengthwise

Paragraphs

Indents

	

None
Spacing

	

Single
Automatically adjusted

Alignment

	

Left
Tabs

	

Left aligned every .5"
Blank leader

Printing

Quality

	

Standard
Pages

	

All
Paper Feed Continuous
Copies

	

One
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Document

Page Numbers

Running Heads

Columns

	

One
Footnotes

	

Same page, automatic numbering
Division

	

Breaks page

Other Settings

Automatic numbering
Numeric, continuous
From top = .75"
From left = 7.25"
At top
All pages except first
From top = .75"
From sides = .5" minimum

Character Format New York
12 point
plain text

Find and Change Matches upper/lowercase .

Finds embedded text .

Searches from insertion point
to end of document, then from
beginning back to insertion
point .

Measures

	

Unit = inches
(Preferences command)

Display

	

As printed (Preferences command)
Save

	

Formatting saved, no backup



If you see the disk
full message :

Appendix C
Disk Space and Memory

When you receive your Word master disk, there will be little extra space
on the disk for your work .

The Word master disk includes the following documents and folders :

•

	

The Word application
•

	

The Macintosh System Folder
•

	

The Printer Folder, which contains printer drivers supported by Word
•

	

Standard Glossary
•

	

The Word Document Folder, which contains sample documents
•

	

Word Help, which contains help information about Word

If you have an external drive, you can store documents on a disk in the
other drive . If you have one disk drive, you may need to move or delete
some documents from your copy of the Word disk .

You should never alter the Word master disk . You can make some
changes to your copies of the Word disk to create more space on your
disk.

You should leave at least 10K free space on your copy of the Word disk .
As you work, Word builds temporary documents on the disk for storing
changes, and needs space on the disk for them .

Using an External Drive
Word operates most efficiently with an external drive . You can then store
documents on a separate, formatted disk in the extra drive . You don't
need the Word program on this "document disk ."

When you open documents, you can click the Drive button to see a list of
documents on the disk in the external drive . When you save, use the Save
As command and click the Drive button to save to the external drive ; or
use Save to save a document to the disk that it was opened from. Word
saves to the disk volume named in the upper right portion of the Save As
dialog box . This disk will be the one you specified the last time you
clicked the Drive button .

A Click the OK button in the alert box .
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11

11

8

Choose the Save As command from the File menu .
Fill in the text box and choose any options you want .
If you have room on the disk in the external drive, click the Drive
button to save to the external drive . Or click Eject to eject either
disk, and replace it with a disk that has space on it .
Click the Save button .

If Word runs out of disk space while printing, it will print one page at a
time. If you specified multiple copies of the document, you will get the
specified number of copies of each page, one at a time .

Using Word With One Drive
If you are using Word with one disk drive, you need the Word program
on each Word disk you use, because Word needs to read parts of the pro-
gram as you work. You will probably find it inconvenient to use "docu-
ment disks" (formatted disks containing documents only), because you
will have to swap disks very frequently.

If you move all unneeded printer drivers, fonts, and documents from
copies of the Word disk, you will be able to store 50-60 pages on each
copy of the disk .

To free disk space :

	

∎ Move any printer drivers you don't need to another disk, or delete
them .

•

	

When you finish "Learning Word," remove the MEMO document from
your copy of the Word disk .

•

	

When you feel familiar with Word, you can move the help document
(Word Help) to another disk .

•

	

Move fonts that you rarely or never use off the disk . Use the Font
Mover on the Macintosh Utility disk .

•

	

Make your copy of the Word disk a startup disk . See "Making Word a
Startup Disk" below for details .

You will find document moving operations easiest to do in the Finder .
You cannot save to a folder, but you can arrange documents in folders us-
ing the Finder.

If you have more than one printer, you might want to move each printer
driver onto a separate disk, with the documents that you will print on that
printer. For example, if you like to print all your correspondence with a
daisy wheel printer, you can keep all your letters and the daisywheel
printer driver on one disk . Word will always read the disk, and display
text as it would be printed using that particular driver .



If you see the disk
full message :

To copy Word to a
hard disk:

To make Word the
startup disk:

0

A

A

Making Word a Startup Disk
If you need more space on your disk, you can make your copy of the
Word disk a startup disk and remove the Finder from the disk . (The
Finder takes up about 55K on your disk.) Then every time you turn on
your Macintosh and insert your copy of the Word disk, the Word program
loads automatically. This means that when you insert your disk, the first
thing you see will be an untitled document, instead of the desktop .

Insert any disk with the Finder on it . (You need to start up the Mac-
intosh with another disk if you are going to remove the Finder from
the Word disk, because Macintosh has to return to the Finder when
you quit a program .)
If you do not have an external drive, eject the disk .
Insert your copy of the Word disk . If you have an external drive, in-
sert the Word disk in the external drive . Click on the desktop to
select the Word icon . (Do not double-click .)
Choose Set Startup from the Finder's Special menu .

A

11

11

Disk Space and Memory

Choose the Save As command from the File menu .
Click the Eject button and insert another Word disk that has plenty of
space on it .
Click the Save button to save your work .

Using a Hard Disk
If you are using Word with a hard disk, copy your Word master disk using
the following procedure .

Open the desktops for your Word master disk and your hard disk .
Move the Word documents and folders to the desktop for the hard
disk. You can move them one at a time, or as a group (by extending
the selection) .

Warning

	

Do not use the Macintosh Disk Copy utility to copy the
master disk. Do not completely replace the contents of
the hard disk with the Word disk, unless the hard disk is
empty.
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To discard

the Finder:

11

A

You will see an alert box asking you to verify that you want Word as

the startup application . Click OK to continue . This makes Word the

startup program .

Now you can discard the Finder.

Double-click to open the System folder .

Click to select the Finder icon. Drag it to the trash can .

© When you choose Empty Trash from the Special menu, or eject the

disk, the Finder will be deleted .

You will also notice these differences in the way the program works :

•

	

When you insert the Word disk, you do not see a desktop . The Word

program is loaded automatically .

•

	

You cannot manipulate documents using the Finder . You will need to

insert a disk containing the Finder, eject it, then insert the altered

Word disk.

•

	

When you quit Word, you will not exit to the Finder (unless you have

the Finder on a disk in another drive) . Word quits and ejects the

disk. You will be asked to insert a disk with the Finder on it.

Using Print Merge

If you work with form documents very often, you may have problems

with memory occasionally, because the Print Merge command requires a

lot of space on the disk for building these documents .

Word combines the main document and the merge document before it

prints the entire document. If your merge document contains a lot of

data records, Word will build a very large form document .

You can insert as many files as you want with the INCLUDE instruction

and have any number of data files ; but Word builds the entire form docu-

ment and then sends it to the printer . So the number of documents you

can insert with the INCLUDE instruction is limited by the amount of space

on the disk.

Note

	

The main document, the merge document, and any docu-

ments inserted with the INCLUDE statement must be on

the same disk .



Appendix D
Using Word With
Other Applications

You can use Microsoft Word with any other Macintosh application to mix
text with graphics or data. Generally, there are two ways to do this :

•

	

You can save an entire document in an ASCII text file (unformatted)
and copy the text file into an application that accepts ASCII files .

•

	

You can copy the text or picture to the Clipboard or the Scrapbook,
then copy the information from one application to another .

You will find it convenient to use the Clipboard to move one block of
text at once . But the Clipboard holds only one block of text at a time . If
you have several things scattered throughout a document (or on a disk),
you can use the Scrapbook instead .

If you use the Clipboard to copy or move text or pictures from one
Macintosh application to another, any formatting that was applied to that
text or pictures will be lost .

Note

	

When you move text between Word and any Microsoft
application that uses data, make sure that your text is
separated by tabs. Otherwise, your text will appear in the
second application as a large string of characters rather
than as separate data items. Using tabs to separate data
items is the common element of most of the Microsoft
Macintosh applications .

Microsoft File
You can copy and use unformatted documents from Microsoft File direct-
ly, without having to move text into the Clipboard . To use a File docu-
ment with Word, you need to save the File document as text output. This
removes all File formatting and inserts tabs between information in data
records.
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To save a Datafile
as a Print Merge
document :

To save a Report as
Text Output :

11

The most common use for this information transfer is to use this docu-
ment as a merge document. Use the Print Merge command to print your
form documents as described in Chapter 9, "Printing Documents" chapter
in "Using Word."

Design the Report in File ; see the File manual for details.
•

	

Save the Report separate from the Datafile by choosing the Save Re-
port As command.
Check the "Text Output" option in the dialog box .

•

	

File saves the report text in tabular format (without File formatting) .
Now you can copy this document to the Word disk using the Finder .

A

11

To move text

	

You can also use unformatted Word documents in Microsoft File . You can
into File :

	

save the Word document as text only, then move the entire document
onto the File disk with the Finder .

A

P1

a

Organize the data in the Datafile window or document. See the File
manual for details .

•

	

From the Microsoft File program, choose the Save Records As
command.
Click the box labeled "Text (Microsoft Print Merge ) ."
Once you have saved the File document as a text file, you can copy
this document to the Word disk using the Finder.

Separate the information in the Word document with tabs ; File will
use the tabs to separate the information into the appropriate fields .
Choose the Save As command, and click the "Text Only" option .
Close the document and quit Word .
Copy the Word document onto the File disk using the Finder .

•

	

Prepare the fields and organize the data as you would in any other
File document .
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If you want to insert only a portion of a Word document, use the Clip-
board or Scrapbook to move the text you want. To do so, you need to
prepare the fields in the File document first. You should also keep in
mind that all formatting to the Word document will be lost, except for
tabs, which File will read as separators .

Microsoft Multiplan
You can move parts of Multiplan worksheets into Word using the Clip-
board or Scrapbook. You can also copy any documents saved in SYLK for-
mat to use in Word, just as you would any other unformatted ASCII text
file .
When you copy Multiplan documents into Word, the numbers lose their
properties and are treated as text-you cannot calculate, and any links are
dissolved. The numbers format is kept, however. Tabs are inserted
between the numbers as separators .

To move Word documents into Multiplan, you can use the Clipboard or
Scrapbook to transfer the text . Or you can save the Word document as
text only and copy the document to the Multiplan disk . Use tabs to
separate the text entries into different cells . Use the Return key to start a
new row. Open the document in Multiplan as you would a SYLK
document .

Microsoft Chart
You can copy the data series or the chart from Chart . Copy the data
series and graphics separately . Use the Clipboard or Scrapbook to copy
one, then the other into the Word document. You can also save the chart
as a SYLK document .

Word will read the data from Chart as text, and will treat the chart as pic-
tures. See the section below on "MacPaint and MacWrite" for information
on using pictures in Word .

When transferring Word text into Chart, make sure your text is in tabular
format. You can transfer blocks of text using the Clipboard or the Scrap-
book; or you can save the Word document as text only, then open it in
Chart as you would a SYLK file . 261
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To change a
picture :

To restore a picture
to original shape
and size:

MacPaint and MacWrite
Use the Clipboard or Scrapbook to copy or move pictures from MacPaint
into a Word document .
Once you have moved the picture, you can change its size and shape, and
indent or align the picture .

A

11

1

A

First select it. Click on either side of the picture. A box appears
around the picture and there are three squares at the bottom of the
box.
Click and drag the square at either corner to widen the picture .
Click and drag the square in the middle to lengthen the picture.
Click and drag the picture frame to move the picture horizontally .

Select the picture.
Press Command-Shift-P to restore original size and shape .

You can align pictures with the Paragraph commands . The preset align-
ment is left justified ; choose a command to change the alignment, or
select and drag the picture to the position you want .

Word can use formatted MacWrite documents just as if they were Word
documents . However, you cannot use a formatted Word document with
Mac Write .



Appendix E
Daisywheel Printers

This appendix includes the following information :

•

	

Daisywheel Printers
•

	

The Word Screen
•

	

Printer Setup
•

	

Fonts

Install your printer according to the instructions in your printer manual .
A printer driver is a program that allows Word to communicate with your
printer. Printer drivers are often customized to a particular printer . You
must have a printer driver on your disk to use a printer with Word .
Move or delete any printer drivers that you don't use from your copy of
the master disk. (Never alter the Word master disk.) Most people only
have one or two printers, and the drivers take up a lot of disk space .
When you get ready to print, the dialog box in Printer Setup shows a list
of the printer drivers that are on the disk .

Daisywheel Printers
The Word master disk includes drivers for some or all of the following
printers :

Imagewriter
Apple Daisy
NEC
Diablo 620/630
Brother HR15, HR25, HR35
TTY printers

The Printer Folder on the Word master disk may contain other printer
drivers as well . Move or delete any printer drivers you don't use from the
disk

The Word Screen
The Word window displays printer quality text . This is the preset option
(in the Preferences command, Edit menu) . This means that Word shows
you what you will get when you print. Word reads the printer driver in-
stalled on your disk, and adjusts the screen to conform to the printer .

2G3
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To specify a printer :

This manual shows screens produced with an Imagewriter . If you have a
daisywheel printer driver on your copy of the Word disk, your screen
may look very different from the screens shown in this manual. You may
not see many of the special fonts and formats discussed in this manual .

If you have a daisywheel printer but want to see the fonts anyway, choose
the Preferences command from the Edit menu . The "Display as Printed"
option is already turned on ; click to turn it off. Keep in mind that your
line breaks on the screen will differ from those that will actually appear
when the document is printed .

Printer Setup Command
Use the Printer Setup Command or the File menu to specify the type of
printer you want to use .

0 Choose the Printer Setup Command . You will see a dialog box con-
taining the names of the printer drivers on your disk .

Click ftyou have a daisywheel printer.
	/

Printer Setup

Imagewriter
Brother
AppIeDeisy
NEC7710
Dieblob30
Typewriter

eu
® 390
o }Ilil
o 111111

o 2400
~ .:Ill it it

0	~1t3 1111

Choose a p//oh to ma/oh yourpr/ti f wheel.

Cancel

Click to choose a driver . Word always selects the last printer driver
you printed with as the preset . If you want to use a different printer,
you need to specify which one .

© Choose the type of print wheel you will be using in the "Pitch" sec-
tion of the dialog box .

n Click the OK button .



Daisywheel Printers

You can also choose one of the special daisywheel fonts that are included
on the Word disk . To do so, choose the Format command on the Charac-
ter menu and select the font that corresponds to your print wheel .

The list below shows the daisywheel fonts that are available with Word .
Printing elements are measured by "pitch," or number of characters per
inch. Since Word measures in points, the corresponding point measures
are given in the right column of the list :

Dover 10 (P 10)

	

12 points
Dover 12 (P12)

	

10 points
Dover 15 (P15)

	

8 points
Dover PS (Proportional)

	

12 points

10, 12, and 15-pitch fonts are "fixed-pitch" fonts ; the width of all charac-
ters in the font are the same . In PS, some characters are wider than oth-
ers
Some printers supported by Word cannot print in proportional spacing .

If you want to use a daisywheel printer and an Imagewriter, you can plug
the daisywheel into the modem port and the Imagewriter into the printer
port. Then you can specify in the "Port" section of the dialog box to send
output to the daisywheel attached to the modem port. (The Imagewriter
always sends output to the printer port .)

Warning

	

Make sure you have a printer plugged into the modem
port before changing the "Port" setting . Do not set the
printer to the modem port if you have a hard drive at-
tached to the modem port . Set the printer to the modem
port only if there is a printer attached .

You can also change the baud rate in the Printer Setup dialog box . See
your printer manual for the correct baud rate setting for your printer .





Active

Terms

Of the things you are working with, the one to which the next command
will apply (for example, the active window). This item is selected . See
also Selection.

Alignment

	

The horizontal position of text on the page .

Left

	

Lines are aligned flush left, ragged right

Centered Lines are centered .

Right

	

Lines are aligned flush right, ragged left .

Justified

	

Lines are aligned flush left and right ;
spacing is adjusted to fill in .

See also Justified.

Autonumbered

	

A footnote
footnote

	

in the footnote
note command
ence appears

Backspace

	

The Backspace
to delete

Baseline

	

The bottom

number that Word inserts automatically in document text and
window. You can specify that Word do this in the Foot-
on the Document window . This type of footnote refer-

as a superscript small number . See Footnote reference mark .
key backs over text and deletes it . You can also backspace

the selection .
of the line of text .

is used over and over without change, such as a company's own
a copyright notice, or even whole sections of papers or reports .

which is darker and heavier than normal text .

the text is deliberately stopped and a new start follows .
of breaks are word breaks, line breaks, paragraph breaks, page
division breaks . 267

Boilerplate

	

Text that
address,

Boldface

	

A typeface

Break

	

A place where
Examples
breaks, and

Caps

	

Capital letters .

Case

	

The forms of letters, either capitals (uppercase) or small letters (lower-
case) .

Character

	

Any number, letter, punctuation mark, symbol, or special mark (e .g., @, ,
*, %, $) that you type as text .
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Check box

Choose
Click

Close box

Command

Cut and paste

Data record

Delete

Dialog box

Division

Division mark

Document

Embed

End mark
Expand

Extend
Field

A box for choosing an option . Clicking a check box puts a check in it and
chooses the option . If the box is already checked, clicking removes the
check and cancels the option.

To pick a command from a menu .

To press and release the mouse button on the spot where you want to
perform the next task.

The icon on the left end of the title bar . Click this icon to close a win-
dow.

An instruction to Word to perform a task . A command may have one or
more options .
To edit a document by combining documents and parts of documents .
Use the Cut command to move text from the document into the Clip-
board, and the Paste command to insert the text at the new location .
A group of related fields in a merge document . Use the Return key to end
a data record .

To remove text permanently from the document you are working on. Use
the Clear command or the Backspace key to delete text .
A box where you make choices or provide information needed to perform
a task.

The point at which you change the page layout, page numbering, or run-
ning head within a document . (For example, you might make an index or
each chapter of your document a separate division .)

The character displayed as a line of colons indicating the start of a new
division .

Any text you save on the disk is a document . A Word document includes
both text and any formatting which has been applied to it. Common
types of documents are letters, reports, memos, pamphlets, and brochures .
To put text within other text . For example, you can embed a page
number in a running head . When using the Find or Change command,
you can encounter text embedded in words. For example, you might find
"the" in the words theatre, breathe, or theme .
The diamond indicating the end of a document .
To replace a glossary name with the full glossary entry text by pressing
Command-Backspace .

To lengthen a text selection, using the Shift key and the mouse .
For form documents, a piece of information that is merged into the main
document from the merge document. In the main document, the field
name is surrounded by special characters <<>> . In the merge document,
fields are separated by commas or tabs . When you print, the field name is
replaced with the field from the merge document .



Terms

Field name

	

For form documents, the name of a general category of information . Type
the field name, surrounded by special characters <<+ >>, in the main docu-
ment at the location( s) where you want information added from the
merge document. The field names should match the header record,
although they need not appear in the same order .

Find

	

To look for a specific occurrence of text in a document using the Find
command.

Flush

	

Aligned on either the left edge (flush left) or the right edge (flush right)
of the line or column .

Font

	

The design of the alphabet in which text is displayed or printed, such as
New York (a textbook font) or Geneva (sans-serif font). The system on
the Word master disk may include the following fonts :

Chicago
New York
Geneva
Monaco
Dover 8
Dover 10
Dover 12
Dover PS

Footers

	

See Running head .

Footnote reference

	

The mark that appears in the text of a document to direct you to a foot-
mark

	

note. You can specify a reference mark up to ten characters long, or you
can specify that Word number them automatically . See Autonumbered
footnote.

Form document

	

A printed document created by merging two special documents : the main
document and the merge document. Standard text from the main docu-
ment is combined with data or other information from the merge docu-
ment. The result is the customized form document . See Main document,
Merge document .

Format

	

The way text looks on the page . With Word, you can format a document
on three levels . You can format the position and appearance of charac-
ters, the alignment and spacing of lines and paragraphs, and the overall
design of an entire document .

Global search

	

See Find.

Glossary

	

A special window where text can be stored and later retrieved by name .
To expand the glossary entry in a document, type the glossary name and
hold down the Command key while pressing the Backspace key .

Glossary entry

	

The repetitive text that you store in the glossary window . Create an entry
by cutting or copying the text from a document, then pasting it into the
glossary window. You name the glossary when you create it .

269
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Glossary name

	

The name you assign to a glossary entry when you create it .

Utter margin

	

The inner margins of facing pages of a document ; that is, the left side of
odd pages and the right side of even pages. These margins can be wider
than the outside margins to allow extra space for binding . Use the Page
Setup command on the File menu to specify a gutter margin .

Hanging indent

	

An indent of the first line that is less than the indent of subsequent lines,
so that the first line of a paragraph is wider than the rest of the lines .

Header

	

See Running head .

Header record

	

The first data record in a merge document . This record is special because
it contains the identifying words that match the field names in the main
document to the pieces of information contained in the merge document .
The subsequent data records in the merge document must be in the same
order as the header record.

Highlight

	

An area appearing in reverse video to indicate the selected text .

Hyphen

	

Word recognizes two types of hyphens : ordinary hyphens, and optional
hyphens. See Optional hyphen .

Indent

	

The distance between the beginning of a line and the left margin, or the
end of a line and the right page margin. Indents normally make text nar-
rower than the margins. A zero ( 0 ) indent measurement aligns the first
line on the margin . See also Hanging indent .

Insertion point

	

A blinking vertical bar indicating where text will be inserted into a docu-
ment as you type .

Justffied

	

Text whose right and left edges are flush with the right and left indents,
or if a zero indent is specified, flush with the right and left margins . If
you have a multi-column document, text will be flush left and right on the
columns. Spaces are enlarged between words to make the text fill the
whole line evenly . See also Ragged.

Keep

	

This is an instruction to "keep" all of the specified text (usually two para-
graphs) together on a page. Word prints the text on a new page rather
than splitting it between pages . See Chapter 7 on "Formatting Your Work"
for more information .



Leader character

	

A character that fills a tab, drawing the reader's eye across columns, as in
a table of contents . Use the Tabs command on the Paragraph menu to
select any of the following leader characters :

•

	

blank (no leader character)
•

	

period

•

	

hyphen	
∎ underscore	

See also Tab.

Line spacing

	

The amount of space between lines of text within paragraphs, and the
number of blank lines above and below the paragraph .

Main document

	

A document containing standard text that is the same for all copies of a
form letter or form document, plus special fields where Word inserts vari-
able information from another document (the merge document) . See also
Merge document .

Margin

	

The area from the edge of the page to the edge of the text. (This area
does not include indents .) Use the Page Setup command to set margins on
the left, right, top, and bottom of the page . You can also set a gutter mar-
gin. See also Gutter margin .

Master disk

	

The disk you receive in your Microsoft Word package. This disk contains
a special identification that Macintosh must read when you start the Word
program after turning on the Macintosh. You can make as many copies of
the master disk as you want . If Macintosh needs to read the identification
at any time, you will be prompted to insert the master disk .

Measure

	

The units in which distances and sizes are given in Word, including
inches, centimeters, picas, pitch, and points . Use the Preferences com-
mand on the Edit menu to indicate a unit of measure :

•

	

Inches (in ., " )
•

	

Centimeters (cm.)
•

	

10-pitch (p l 0 )
•

	

12-pitch (p12)
•

	

Points (pt)
•

	

Lines (li )

See also Picas, Pitch, and Points

Terms
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Merge document

	

A document that contains pieces of information to be merged into a main
document for form letters and other form documents .

Move

	

To move text to another place in the document or to another document.
In Word, you move text by cutting it to the Clipboard, then pasting it into
the desired location .

Nest To increase the indent of a paragraph from the preceding paragraph . Each
subsequent nested paragraph is indented another increment from the one
before it .

Non rea

	

g space

	

A space that you insert between two words so that they will not be
separated by a line break. Insert a nonbreaking space by pressing
Command-spacebar . This space is fixed and cannot be contracted or ex-
panded when you justify the line .

Normal

	

The preset format used by Word for paragraphs : single spaced, flush left,
and unjustified .

Open spacing

	

An extra line space added above a paragraph .

Optional hyphen

	

A hyphen that separates parts of a word, but is invisible until needed . To
insert an optional hyphen, press the Command-hyphen keys .

Orphan

	

The first line of a paragraph that appears alone at the bottom of a page or
column, while the rest of the paragraph appears on the next page or
column. Word automatically avoids page or column breaks that leave or-
phan lines .

Page break

	

The place where the page ends. Normally, Word breaks the page automat-
ically; however, you can specify page breaks by pressing the Shift-Enter
keys.

Pagination

	

To create page breaks and page numbers in documents . Use the Division
Layout command to choose any of these page numbering options :

•

	

Arabic 1, 2, 3, 4
•

	

Roman uppercase I, II, III, IV
•

	

Roman lowercase i, ii, iii, iv
•

	

Alphabetic uppercase A, B, C, D
•

	

Alphabetic lowercase a, b, c, d

Usually Word breaks pages automatically . If you wish to insert a page
break at a particular place, do so by pressing the Shift-Enter keys .

Paragraph

	

The text between two paragraph marks, including the trailing paragraph
mark. Paragraph formats control alignment, line spacing, and indentation .
See also Paragraph mark .



Paragraph mark

Paste

Pica

Pitch

Point

Point size
Preset option

Ragged

Reference mark

Return key

Roman
Roman numerals
Ruler

Running head

Save

Select

Selection

Terms

A character at the end of a paragraph . This character is normally invisible .
To insert a paragraph mark, press the Return key . Use the Show ¶ com-
mand to make paragraph marks visible .
To insert into a document whatever was last cut or copied to the Clip-
board .

A unit of measure . One pica equals 12 points and six picas equal one inch .
One point also equals one pixel on the Macintosh screen .

A measure of the number of characters per inch of paper, horizontally .
Typically, typewriters and printers use 10-pitch (10 characters per inch)
or 12-pitch (12 characters per inch) .
A measurement used by typesetters and printers . One point equals 1/72
of an inch, and 12 points equal one pica .

The height of a font measured in points .

Information already supplied by Word in a dialog box . You may replace a
preset option with your own response .

Text with an uneven left (ragged left) or right (ragged right) edge . See
also Justified .
Text in the document that refers to footnoted text. A reference mark can
be up to 10 characters long . You can specify your own reference mark ;
otherwise, Word uses automatically numbered footnote references .

The Return key inserts a paragraph mark in the document text, and causes
a paragraph break. You can see the paragraph marks when you choose
the Show (P) command. See also Paragraph mark.
The preset character font that Word uses-12 point New York .

I, II, III, IV, V, and so on .

The horizontal line that appears on the top edge of the window and
displays the positions of tabs and indents . To change these positions,
move the markers along the ruler with the mouse ; or use the Formats
command in the Paragraph menu.
Text that appears at the top (header) or bottom (footer) of printed pages .
Running heads may include page numbers, dates, titles, or other text .

To store a permanent copy of a document on disk with the Save com-
mand .
To choose the character, paragraph, or text to be affected by the next
command.
The highlighted character or group of characters that will be affected by
the next command you choose .
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Selection bar

Small caps

Split bar

Subscript
Superscript
Tab

Text
Text box

Typeface
Undo

Widow

Window split

Wordwrap

An area on the left side of the active window, used for selecting blocks of
text. It is invisible, but the mouse pointer shifts direction when you are
in the selection bar .
Capital letters that are smaller than the capital letters for the font size you
are using .

The bar at the top or to the right of a window that you can use to split or
close a window with the mouse . See also Window split .

Text that appears slightly lower on a line than the text around it .
Text that appears slightly higher on a line than the text around it .

A position for aligning text in columns by using tab characters . Use the
Tabs command on the Paragraph menu to set and clear tabs. The follow-
ing tabs are available :

Left

	

Text is aligned flush left on the tab

Center

	

Text is centered around the tab

Right

	

Text is aligned flush right on the tab

Decimal Decimal points are aligned on the tab

All characters that make up your document .
A place in a dialog box to type information or check an option . This tells
Word how to carry out a command . When Word displays a dialog box for
a command, it often supplies preset options in some text boxes ; you may
replace or edit a text box, or leave it as proposed . See also Preset op-
tions .

See Font.

To reverse the most recent editing command with the Undo command.
Undo can itself be undone .
The final line of a paragraph when it appears alone at the top of a new
page or column, while the rest of the paragraph is on the preceding page
or column. Word avoids page or column breaks that would leave widows .
A horizontal split in the active window, created by dragging the split bar
from the top of the right scroll bar to the spot where you want the split .

Automatic shifting of a word to the next line . When you are typing text
and you reach the right margin, Word checks to see if the word you type
fits completely on the line . If not, Word automatically places the whole
word on the next line .



About Microsoft Word command
description, 204
getting help, 26
how to use, 26

Again key sequence, 62, 250
Alignment of text, 32, 237

key sequences, 252
preset options, 253
See also Tabs; Margins

Apple menu, 202
commands, 204

ASCII documents, 206, 259, 261
ASK instructions, 180
form documents

examples, 180
Print Merge command, 213

Backspace key
deleting text, 18, 22, 67

Backup copies, 193
Bold command

description, 234
how to use, 49, 101-02
key sequence, 251

Breaks
column, 146-48
line, 62
options, 148
page, 63, 149

key sequence, 250
preset option, 253

paragraph, 62
preventing, 62
word, 62-63

Buttons
Cancel, 203-04, 207
Drive, 206
Eject, 206
Help, 204
OK, 203
Open, 206

Cancel button, 203-04, 207

Canceling
commands, 218
formats, 193
printing, 169
searches, 80

Capacity, Word disk, 255-58
Caps, small,

See Small Caps command
Centered command

description, 237
how to use, 43, 113-15
key sequences, 252

Centering text, 43, 113-15
Change command

description, 231
how to use, 80
key sequence, 249
See also Finding and changing

text
Changing document appearance

See Formatting characters;
Formatting paragraphs ;
Tabs

Changing font, 103-04
Changing font size, 104-05

See also Font size
Changing formats

character, 100-10, 235
indents, 123
key sequences, 252
paragraph, 111-26, 237

Changing preset measures, 127
Changing search text, 79
Changing text

See Change command ;
Finding and changing text

Changing units of measure, 128
Character formats, 100-10

erasing, 101
key sequence, 251

preset options, 254

Index

Character formats (continued)
See also Formatting characters ;

Fonts
Character menu, 100-02, 202
commands, 234-36

Characters, invisible, displaying,
226

Characters, number of, 28,
208-09

Chart, Microsoft
using with Word, 261

Checkmarked commands, 199,
203

Clear command
description, 221
how to use, 67
key sequence, 249

Clipboard
closing window, 222
displaying, 89
glossary entries, 93-96,

222-23
inserting text from, 66-70
moving text, 33-34
opening window, 90

Close box, 268
Close command

closing windows, 40, 90
description, 207
how to use, 190
key sequence, 249
See also Close box

Closing documents, 207
Closing windows, 29, 40

Clipboard, 222
document, 190
footnote, 154
split, 89

Colon ( :) in document name,
193



Index

Columns Commands (continued) Copying formats
breaks, 146-47 Print Merge (continued) character, 108
preset options, 146-47, 254 ASK instruction, 214 mouse and key combination,
setting up, 146-47 DATA instruction, 214 252
spacing, 147 IF. . . ELSE. . .ENDIF instruction, paragraph, 121

Command key sequences, 249 214 See also Formatting characters ;
Commands IF. . .ENDIF instruction, 214 Formatting paragraphs

About Microsoft Word, 5, 204 INCLUDE instruction, 214-15 Copying text, 68-74
Bold, 234 Main document, 213 between applications, 74
canceling, 218 Merge document, 213 between documents, 72-73
Centered, 43, 237 NEXT instruction, 215 Copy command, 35, 219
Change, 37, 231 SET instruction, 215 mouse and key combinations,
checkmarked, 199 Printer Setup, 216, 264 71, 252
Clear, 221 Quit, 217 Paste command, 220
Close, 207, 222 Redo, 218 Copying Word master disk, 257
Copy, 35-36, 218 Repaginate, 247 Copying Word to a hard disk, 257
Cut, 33-34, 218 reversing, 75, 218 Correcting mistakes
definitions, 199 Right, 237 See Deleting text ;
dimmed, 199 Running Head, 158-65, 245 Mistakes, correcting ;
Division Layout, 141-49, Save, 27-28, 208-09 Undo command

242-43 Save As, 27, 208-09 Creating divisions, 142
Double Space, 116, 237 Shadow, 234 Creating footnotes, 150-52, 244
Find, 37, 231 Show Clipboard, 222 Creating form documents,
Footnote, 150-57, 244 Show Glossary, 223 174-86
Formats, 115-20, 234 Show (P), 237 Cut command

character, 235-36 Show Ruler, 225 deleting text, 23, 67
paragraph, 238-39 Single Space, 234 description, 219

Go To, 233 Small Caps, 234 how to use, 67
Italic, 234 Subscript, 234 key sequence, 249
Justified, 237 Superscript, 234 moving text, 33, 68
key sequences, 249-51 Tabs, 240-41 Daisywheel printers, 263-65
Left, 237 Underline, 234 DATA instruction, form
Merge Undo, 20, 218 documents,

See Print Merge Commas in fields, form examples, 181, 214
New, 189, 205 documents, 178 Data records
Normal, 237 Conditional instruction, form form documents, 177, 178
Open, 188-90, 206 documents, 183 Datafile, 260
Open Space, 116, 237 Copy command Deleting fonts, 107, 256
Outline, 234 copying text, 35, 68-74 Deleting footnotes, 156, 244
Page Setup, 170-72, 210 description, 219 Deleting formats
Paste, 33-34, 220 how to use, 68 character, 193
Plain Text, 234 key sequence, 249 paragraph, 193
Preferences, 128, 227 Copying documents to another Deleting glossary entries, 96, 224
Print, 212 disk, 5 Deleting running heads, 163
Print Merge, 174-86, 213 Copying fonts, 108-09 Deleting tabs, 135



Deleting text
Backspace key, 22, 67
Clear command, 67, 221
Clipboard, 23, 67
Cut command, 23, 67, 219
entire document, 67
footnotes, 244
glossary entry, 224
one or more characters, 67
overtyping, 67
running heads, 163
search text, 231
summary of methods, 67

Dialog boxes
filling in, 27, 203
list boxes, 203
text boxes, 203

Dimmed commands, 199
Discarding the Finder, 258
Discarding formatting, 193
Disk

ejecting, 206
hard, 257
identification prompt for

master, 257
Disk drives

external, 255
one-disk, 256
two-disk, 190

Disk full message, 255-57
Disk space, 255-58

for Print Merge, 258
freeing, 256
running out of, 256

Display
as printed, 228
preset options, 254
quality, adjusting, 227

Displaying a glossary, 95
Displaying ruler, 129
Division Layout command

description, 243
how to use, 142
key sequence, 241

Divisions
creating, 142
key sequence, 250
mark, inserting, 243
preset options, 254

Documents
ASCII (unformatted), 206, 259,

261
closing, 207
closing windows, 190
complex, 137
editing, 61-97
finding, 31, 87
form, 174-86
formatting

(see Formats)
list of, 31, 206
main (form), 174-76
menu commands, 202
merge, creating, 177-79
name

colon in, 193, 208
valid character in, 208

number of characters in, 28
192, 208-09

opening, 31, 206
existing, 188
on different disk, 190
windows, 87, 188

preset options, 254
printing, 167-86

Print command, 212
saving

backups, 193
new, 192
options, 192
to different disk, 193
without formatting, 193

storing on disk, 255
viewing several parts, 88
See also Form documents

Document menu, 202
commands, 243-47

Double Space command
description of, 237

Index

Double Space command
(continued)

how to use, 116
Drive

See Disk drives
Drive button, 206
Edit menu, 202
commands, 218-28

Editing
documents, 61-97
footnotes, 150
glossary text, 96
keys, 250
running heads, 162
text, 61-97

key sequences, 250
during search, 79

Eject button, 206
Ending a line, 62
Ending a page, 172
Ending a paragraph, 62
Entering text, 62

wordwrap, 62
Erase

See Deleting text
Expanding glossary name, 223

key sequence, 250
Extending a selection, 22
External drive, using, 255
Fields, form documents, 176
File menu, 202
commands, 204-17

File, Microsoft
using with Word, 259

Find and Change, preset options,
254

Find command
description, 76, 229
how to use, 77-79
key sequence, 249

Finder
discarding, 258
moving documents, 256

Finding and changing text
37-40, 76-83
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Finding and changing text
(continued)

automatically, 80, 82
canceling search, 80
editing while searching, 79-83
options, 77, 81-82, 254
Search menu, 76
wild card characters, 76

Finding a document, 31, 86
Finding page numbers, 84, 233
Go To command, 233

Finding text
See Finding and changing

text
First line, indenting, 118, 252
Fixed spaces

displaying, 226
key sequence, 250
uses for, 62

Font size, 104
copying, 108-09
decreasing, 104

key sequence, 251
increasing, 104

key sequence, 251
Fonts

changing, 251
copying, 108-09
list of, 236, 251, 265
moving, 256
names and numbers of, 251
preset, 254

Footers
See Running heads

Footnote command
description, 244
how to use, 150-52
key sequence, 249

Footnotes
closing window, 154
creating, 150-52, 244
deleting, 156, 244
editing, 150
expanding window, 155
inserting glossary, 157

Footnotes (continued)
numbering, 151

in glossary, 92
opening window, 153, 244
positioning, 155-56
preset options, 254

Form documents, 174-86
ASK instruction, 180

example, 180, 214
commas in fields, 178
conditional instruction, 183
creating, 174-86
DATA instruction, 180

examples, 180, 214
data record, 178
disk space for, 258
fields, 179
header records, 178
IF . . .ELSE . . .ENDIF instruction,

214
examples, 184, 214

IF. . .ENDIF instruction, 214
examples, 183, 214

INCLUDE instruction, 214
instructions in, 179

summary of, 180
main document, 174-76
merge document, 177-79, 186
NEXT instruction, 215

example, 181, 215
printing, 174-86
prompts in, 180
quotes in fields, 178
SET instruction, 182, 183, 215

Form letter
See Form documents

Formats
commands

character, 100-01, 235
paragraph, 113, 237-42

erasing, 193
Formatting characters
Bold command, 234
boldface, 101-02
canceling formats, 101

Formatting characters
(continued)

commands, 234
copying formats, 108-09
mouse and key combination,

108
deleting formats, 101
examples of, 102
font, 103-04, 110
font size, 104
Formats commands, 234
Italic command, 234
Italics, 101-02
key sequences, 109-10, 251
menu, 101
preset formats, 254
Shadow command, 234
small caps, 101-02
Small caps command, 234
subscript, 103
Subscript command, 234
superscript, 103
Superscript command, 234
Underline command, 234
underlining, 101-02

Formatting pages
page setup, 170-71, 210-11

Formatting paragraphs, 111-26
alignment, 115
breaking, 112
canceling format, 121
centering, 115
commands, 113, 237-42
copying format, 121

mouse and key combination,
121

Formats command, 238
hanging indent, 126
indenting, 117-19, 123-24

displaying ruler, 122
joining, 112
key sequences, 124, 252
line spacing, 116, 120
nesting, 125
Normal command, 121



Formatting paragraphs
(continued)

preset format, 253
removing formats, 121
ruler, 122-24
saving formatting, 113
space above paragraphs, 116
tabs, 129-35

See also Tabs
Freeing disk space, 256
Getting a document

See Opening
Global search and/or change

See Finding and changing text
Glossary

creating entries, 93
deleting entries, 96
displaying entries, 95
editing, 96
expanding name, 223
footnote, 92
footnote numbering, 92, 223
formatting in, 95, 223
inserting graphics, 224
moving entries, 97
opening window, 92, 223
page, 223
page numbering, 223
removing entries, 224
replacing entries 96
reserved

footnote, 92
page, 92

saving, 96-97, 224
Standard Glossary file, 97
using entries, 94

Go To command
description, 233
finding a page number, 84
how to use, 84
key sequence, 249

Gutter margin, 140, 211
Hanging indents, 126

key sequence, 252

Hard disk
copying to, 257
using, 257

Header
See Running heads

Header records, form documents,
177

Help, 24-26
About Microsoft Word

command, 26, 204
Command-?, 204
resuming work, 204

Help button, 204
Help topics, 204
Hide Ruler, 48, 225
Hyphens

optional, 62-63
key sequence, 250

IF. . .ELSE . . .ENDIF instruction, form
documents, 214

examples, 184, 214
IF. . .ENDIF instruction, form

documents, 214
examples, 183, 214

Imagewriter, 263-264
INCLUDE instruction, form

documents, 214-15
limitation, 258
Print Merge command, 214

Increasing font size
how to, 104-05, 236
key sequences, 110, 251

Indents, 117-26
first line, 118, 252
Formats command, paragraph,

237-42
hanging, 126
key sequences, 252
markers, displaying, 122
preset options, 253
running heads, 164
setting, 123
using the ruler, 122
viewing in ruler, 129

Index

Insert leading merge
print quote, 213, 250

Insert trailing merge
print quote, 213, 250

Inserting page numbers in
running heads, 163-64

Inserting tabs with ruler,
130-31

Inserting text
from Clipboard, 66
from glossary, 94
new, 19
positioning, 19

Insertion point, 19, 66
Instructions for merging,

180-83
Invisible characters

See Characters, invisible,
displaying

Italic command
description, 234
how to use, 102
key sequence, 251

Justified, 114-15
key sequence, 124, 252

Keeping lines together, 238
Keeping paragraphs together, 238
Keeping words together, 62
Key sequences, 249-52

cancel search, 232
commands, 249
editing, 250
formatting characters, 251
formatting paragraphs, 252
mouse and key combinations,

252
Leader lines with tabs

changing, 130
selecting, 130

Left command
alignment, key sequence, 252
descriptor, 237
how to use, 114-15

Line spacing
commands, 237
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Index

Lines
breaks in, previewing, 228
creating new, 62
ending, 62
keeping together on page, 172

List box, 31
Macintosh, other programs

using with Word
MacPaint, 262
MacWrite, 262
Microsoft Chart, 261
Microsoft File, 259
Microsoft Multiplan, 261

Main document, 174-76
creating, 176

Margins, 140
gutter, 140
minimum, 210
preset options, 253
specifying, 171

Master disk copying, 257
Measurements

abbreviations for, 271
changing preset, 128
changing units of, 128
explanation, 127
preset options, 254
specifying, 128

Memory
available, 204
disk space, 255-58
freeing, 256

Menus: Apple, Character,
Document, Edit, File,
Paragraph, Search, 202

Merge document,
creating, 177-79
order of records in, 178
Print Merge command, 213
reprinting part of, 186

Merge instructions, 180-83
Merge print quotes, key

sequence, 250
Merging documents, 184

See also Form documents

Microsoft Chart, File, Multiplan
See Macintosh, other programs

Mistakes, correcting
overtyping, 21
typing errors, 18-22
Undo command, 20, 218
with backspace key, 18, 22
See also Deleting text ; Undo

command
Mouse and key combinations, 252
Moving data or pictures from

other Macintosh applications,
74, 259-61

Moving tabs, 133
Moving text, 68-74

between documents, 72-73
other Macintosh applications,

74, 259-61
using Edit commands, 68
using mouse, 71, 252
with Cut and Paste, 69
within a document, 68-71

Moving windows, 85
Multiplan, Microsoft

See Macintosh, other programs
Names and numbers of fonts, 251
Naming documents, 193, 208
Nesting paragraphs, 125

key sequence, 252
New command

description, 205
key sequence, 249
opening blank window, 87, 190

New line character
displaying, 226
key sequence, 250

New page, 53
key sequence, 250

New window, 190
NEXT instruction, form

documents, 215
examples, 181
Print Merge command, 215

Nonbreaking fixed spaces,
key sequence, 250

Nonbreaking fixed spaces,
(continued)

uses for, 62
Normal alignment, 253
Normal command

description, 237
how to use, 121
key sequence, 252

Normal paragraph, 121
Numbering footnotes, using

glossaries, 92
Numbering pages, 143-45

See also Page numbers
Open button, 206
Open command

description, 206
how to use, 31
key sequence, 249

Open dialog box, 31
Open Space command

description, 237
how to use, 44-46
key sequence, 254

Opening
documents, 31, 188-189, 206

on different disk, 190
new documents, 87, 190
new windows, 190

Opening windows
Clipboard, 90
footnote, 153
glossary, 92
new, 190

Optional hyphen
key sequence, 250
uses for, 62

Options, preset
See Preset options

Outline command
description, 234
how to use, 102
key sequence, 251

Page
creating new, 172
ending, 172



Page (continued)
finding, 84, 233
glossary name, 223

Page breaks, 172
keeping lines or

paragraphs together, 172
key sequence, 250
previewing, 173, 248
specifying, 172
See also Repaginate ; Division

layout command
Page numbers

automatic, 143
changing sequence, 145-46
finding, 84, 233
formatting, 144
in glossary, 163, 223
in running heads, 163-64
positioning, 145
preset options, 254
repagination, 173
sequence, 145-46
See also Division layout

command; Divisions
Page Setup command

description, 210
how to use, 170-71, 210

Paper
orientation (width, length),

253
size options, 253

Paragraph
alignment, 115
changing format, 111-26
commands, 237
copying format, 121
definition, 41
ending, 62
erasing format, 121
formatting, 111-26

key sequences, 252
indentation, 117-19, 123-24
joining, 112
justifying, 114-15
keeping together on page, 172

Paragraph (continued)
line spacing, 116, 120
mark, displaying, 41-42
menu, 202
commands 237-42

nesting, 252
normal, 121
preset options, 253
removing formats, 121
saving formats, 113
space above, 44
spacing, 116
splitting, 112
unnesting, 252
See also Formatting, paragraphs

Paste command
copying text, 220
description, 220
how to use, 66
key sequence, 249
moving text, 68-69

Picture, resizing
key sequence, 252

Pitch, changing, 128
Plain Text, 101-02, 234
Point, measurement, 127
Preferences command, 128, 227
Preset options, 253-54

alignment, 253
character format, 254
columns, 254
display, 254
division, 254
document, 254
Find and Change, 254
font, 254
footnotes, 254
indents, 253
margins, 253
measures, 254
page formats, 253
page numbers, 254
page setup, 253
paper feed, 253
paper size, 253

Index

Preset options (continued)
printing, 253
running heads, 254
Save, 254
spacing, 253
tabs, 253

Print command
description, 212
how to use, 168
key sequence, 249

Print Merge command
description, 213
disk space for, 258
how to use, 185
inserting quotes, 213, 250
saving Microsoft File

documents, 260
See also Form documents

Printer drivers, 216
Printer setup command, 216, 264
Printers, daisywheel, 263-66
Printing

canceling, 169
columns, 146-47
form documents, 174-86
interrupting, 169
one or more copies, 168
options, 168
page range, setting, 168
preset options, 253
Print command, 53, 168
quality setting, 168
resolution, 168
running head cut short, 162
single sheets, 168
specifications, 168
specifying margins, 171
speed setting, 168, 169

Printing merge documents,
174-86

Prompts
form documents, 180
identification of disk, 8

Quit command, 5 5
description, 217
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Quit command (continued)
how to use, 55, 194
key sequence, 249

Quotes
in Print Merge fields, 178, 213
special merge characters, 213

key sequences, 250
Redo, 75

See also Undo command
Removing formats

character, 235
paragraph, 237
See also Formats, erasing

Repaginate command, 173
description, 248
key sequence, 249

Repeating last action, 62
Again key sequence, 62, 250

Replacing text
Change command, 37-40
erasing and retyping, 18
typing over, 21-23

Report, saving as Text Output,
260

Reprinting documents, 169
Reprinting part of merge

document, 186
Reserved glossaries, 92
Return key

ending paragraphs, 62
ending running heads, 159
in merge documents, 177

Reversing commands, 20, 75
See also Undo command

Revising
See Editing

Right command
description, 237
how to use, 115
key sequence, 252

Ruler
displaying, 129
Hide ruler, 48, 225
indent symbols, 47, 122, 129
setting indents, 122-23

Ruler (continued)
setting tabs, 129-35
Show Ruler command, 225
showing indents and tabs, 129

Running head command
description, 245
how to use, 160

Running heads, 158-65, 246
alternating positions, 165
changing text to, 247
changing to text, 163, 247
creating, 159-61, 246
deleting, 163
indenting, 164-65
editing, 163
embedding page numbers in,

163-64
preset options, 246, 254
specifying positions, 162, 165,

247
Save/ Save As commands

description, 208-09
how to use, 191-94
key sequence, 249
preset options, 254

Saving changes, 191
quitting Word, 194

Saving documents, 191-94,
208-09

backups, 193, 209
how to, 27
more than one version, 193,

209
new, 192
options, 192
Save As command, 208-09
text only, 193
to different disk, 194, 255
to external drive, 194, 255
to hard disk, 257
with one disk, 256
without formatting, 193

Saving formats
character, 234

Saving and reusing text
See Glossary

Saving glossary, 96
Screen draft, 107, 227
Search

canceling, 232
editing during, 79
menu, 76, 202
commands, 229-33

text
deleting, 231

Searching for special characters,
230

Searching for text, 76-78
See also Find command

Selecting text, 64
character, 21, 64
entire document, 64
line, 23, 64
paragraph, 64
sentence, 22, 64
summary of actions, 64

SET instruction, form document
examples, 182
Print Merge command, 215
See also Form documents

Setting indents, 123
See also Indents

Setting margins, 171
See also Margins

Setting tabs, 129-35
See also Tabs

Shadow command
description, 234
how to use, 102
key sequence, 251

Show Clipboard command, 222
Show command

description, 226
how to use, 41-42
key sequence, 249

Show Glossary command, 223
See also Glossary

Show Ruler command
description, 225



Show Ruler command
(continued)

how to use, 131
key sequence, 249
viewing indent symbols, 129

Single Space command
description, 234
how to use, 114

Size of characters
See Font size

Small Caps command
description, 234
how to use, 101, 102
key sequence, 251

Spacing
changing, 116, 120
key sequence, 252
line, 116
nonbreaking fixed, 62
paragraph, 116
preset options, 253

Specifying measurements, 128
Speeding up program, 107-08
Split windows

closing, 89
how to, 86, 88

Starting Word, 15
Startup disk, 257
Stopping printing, 169
Storing documents

See Saving documents
Subscript command

description, 234
how to use, 103
key sequence, 251

Superscript command
description, 234
how to use, 103
key sequence, 251

Tabs
deleting, 135
inserting, 130-31
key sequence, 249
moving, 133
multiple, 132

Tabs (continued)
preset options, 253
realigning text with, 132
setting, 129-35
tables, 134
viewing in ruler, 129

Tabs command
descriptions, 240
how to use, 130

Text Output option, 260
Type styles and sizes

See Fonts
Typing mistakes

backspace key, 18
correcting, 21-23
typing over, 21

Underline command
description, 234
how to use, 100-01
key sequence, 251

Undo command
correcting mistakes, 20
description, 218
how to use, 20, 75
key sequence, 249

Units of measure, changing, 128
Unnesting paragraphs, key

sequence, 252
Wild card characters, 76
Windows

changing, 87
changing size of, 85
Clipboard, 90
closing, 29, 90, 190
closing split, 89
copying text between, 68-70
footnote, 150, 153-55
glossary, 92-95, 223
list of special, 85
moving, 85
moving text between, 68-70
new, 87, 190
opening

blank, 87, 190
Clipboard, 90

Index

Windows (continued)
opening (continued)

existing document, 86
glossary, 92
new, 190

reasons to use, 85
splitting, 86, 88

Word breaks, 62
Word

capacity of disk, 255-58
documents on disk, 255
speeding up, 107-08
starting, 15
using with other applications,

259-62
Word Rescue, 209
Words, keeping together, 62
Wordwrap, 18, 20, 62
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Problem Description

Describe the problem . (Also describe how to reproduce it, and your diagnosis and suggested
correction .) Attach a listing if available .

Microsoft Use Only
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of this product to the place of purchase and your flume' will he refunded . No refunds will be given tier products which have
opened disk packages or missing components .

I . Ll(ENSF : You have the non-exclusive right to use the enclosed program . This program can onh he used on a
single computer. YIIU may physically transfer the program from one computer to another provided that the program is used on
onh one computer at a time . loo may not electronically transfer the program from one computer to another over a network .
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Microsoft . If you transfer the program you must at the same time transfer the documentation and hack-up cope or transfer the
documentatiom and destroy the hack-up copy .

3. ( ;OPV'RIGIFl : The program and its related documentation are copyrighted . You may' not copy the program or its
documentation except as for hack-up purposes and to load the program into the computer as part of executing the program .
All other copies of the program and its documentation are in violation of this Agreement .

4 . TERM : This license is effective until terminated . Vou may terminate it by destroying the program and documenta-
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V()u agree upon such termination to destroy all copies of the program and documentation .
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Microsoft does warrant to the original licensee that the disk( s) on which the program is recorded he free from
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as evidenced by a copy of your receipt . Microsoft warrants to the original licensee that the hardware components included in
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I PI)AI'F POLICY: In order to he able to obtain updates of the program, the licensee and persons to ~e horn
the program is transferred in accordance with this Agreement must complete and return the attached Registration Card to
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8 . MISC . : 'This license agreement shall he governed by the laws of the State of 1V'ashington and shall inure to the
benefit of Microsoft Corps±canon, its successors, administrators, heirs and assigns .
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PLL°11: AN!) 1?XCI.I SIV'I S!A'I'FMI N'1 OF A(JREFMFN'I' BE'I 'II ''N 'THE PARTIES ANI) St' PE RCEDE5 ALL PROPOSALS OR
PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER (OMML'NECATIONS BETWEEN THE PARTIES RELATING
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